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Getting Started with Microsoft BizTalk Server 2000

A member of the Microsoft .NET Enterprise Server family of products, Microsoft BizTalk Server 2000 unites, in a single product,
enterprise application integration (EAI) and business-to-business (B2B) integration. BizTalk Server 2000 enables developers, IT
professionals, and business analysts to easily build dynamic business processes that span applications, platforms, and businesses
over the Internet.

In addition to BizTalk Server 2000, Microsoft, with industry partners, has led innovation on enabling technologies that are
necessary for Internet-based business solutions, including BizTalk Framework 2.0, which is a platform-independent, Extensible
Markup Language (XML) framework for application integration and electronic commerce. BizTalk Framework 2.0 is not a
standard, but it builds upon existing standards, such as the Simple Object Access Protocol (SOAP). SOAP is also a key technology
in other members of the .NET product line, such as Microsoft Visual Studio .NET. BizTalk Framework 2.0 provides the basis for
interoperable reliable messaging for BizTalk Server 2000.

For more information about BizTalk Framework 2.0, as well as information about BizTalk Server 2000 product resources such as
community services, a large library of schemas, and white papers, go to the Microsoft BizTalk Server 2000 Web site
(http://www.microsoft.com/biztalk).

This section introduces the features, services, application model, and administration model of BizTalk Server 2000. You can also
find topics about using online Help and Microsoft Accessibility options. Additionally, the BizTalk Server 2000 Glossary is included.
The following topics are covered in this section:

® Introducing Microsoft BizTalk Server 2000

BizTalk Server Glossary

Differentiating BizTalk Server 2000 Standard and Enterprise Edition Features

How to Use Help

Accessibility for People with Disabilities

Contacting Microsoft Product Support Services
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Introducing Microsoft BizTalk Server 2000

Microsoft BizTalk Server 2000 provides a powerful Web-based development and execution environment that integrates loosely
coupled, long-running business processes, both within and between businesses. BizTalk Server can handle transactions that run
as long as weeks or months, not just minutes or hours.

BizTalk Server 2000 features include the ability to design and use XLANG schedules; integrate existing applications; define
document specifications and specification transformations; and monitor and log run-time activity.

The server provides a standard gateway for sending and receiving documents across the Internet, as well as providing a range of
services that ensure data integrity, delivery, security, and support for the BizTalk Framework and other key document formats.

The following topics are covered in this section:

e BizTalk Server Features

BizTalk Services

BizTalk Server Application Model

BizTalk Server Administration Model

BizTalk Server Glossary



BizTalk Server Features

The following table provides information about BizTalk Server features and how to use them.

Feature

Function

Administration

e Server Administration

® Programmatic Administration

e Create and manage servers and server groups.

Configure global server group properties, such as the lo
cation for the Shared Queue database and the
Tracking database.

Configure server settings.
Configure and manage receive functions.
View and manage document queues.

Programmatically access the XLANG Scheduler System
Manager, group managers, XLANG schedule instances,
and XLANG ports.

Document Tracking

e Tracking Documents

Track the progress of documents processed by Microsof
t BizTalk Server 2000.

Search for, display, view, and save complete copies of a
ny interchange or document processed by BizTalk Serve
r 2000.

Create queries to extract essential information from the
Tracking database in an easy-to-view format.

Extract, store, and analyze important user-defined data f
rom within documents.

Orchestration Design

e Designing BizTalk Orchestrations

Create drawings that describe business processes, and
programmatically implement these drawings within an i
ntegrated design environment.

Compile XLANG schedule drawings into
XLANG schedules.

Define the flow of data between messages within busin
ess processes.

Messaging

e Using BizTalk Messaging Manager

e Accessing the BizTalk Messaging Configuration Object Model

Manage the exchange of data locally or remotely using
BizTalk Messaging Manager.

Manage the exchange of data programmatically using t
he BizTalk Messaging Configuration object model.

Create and manage channels, messaging ports,
document definitions, envelopes, organizations, and
distribution lists.




XML Tools

e Creating Specifications

® Mapping Data

Create and manage specifications.
Create records and fields, and set their properties.

Map records and fields from a source specification to re
cords and fields of a destination specification.

Use functoids to implement powerful data-transformati
on functionality.




BizTalk Services

Microsoft BizTalk Server 2000 provides a complete set of messaging and orchestration services that you can use to automate
your business and data-exchange processes.

BizTalk Messaging Services

BizTalk Messaging Services include receiving incoming documents, parsing the documents to determine their specific format,
extracting key identifiers and identifying specific processing rules, delivering documents to their respective destinations, and
tracking documents. Also included are services for data mapping, receipt generation and correlation, and services to ensure data
integrity and security.

Receive functions

BizTalk Server 2000 provides receive functions that enable the server to monitor documents posted at specified locations. BizTalk
Server 2000 supports the following receive functions, which are configured by using BizTalk Server Administration:

e File

® Message Queuing

BizTalk Server 2000 also supports the following protocols, which are configured by using ASP pages or a Microsoft Exchange
script:

e HTTP (by using an .asp page)
e HTTPS (by using an .asp page)
e SMTP (by using a Microsoft Exchange script)

Transport services

BizTalk Server 2000 provides transport services that enable the transmission of documents to their destinations. BizTalk
Server 2000 supports the following transport services:

e HTTP

e HTTPS

SMTP

e File

Message Queuing

Application integration components

e Loopback

Data parsers

BizTalk Server 2000 supports data parsers for a variety of industry document standards, such as ANSI X12, UN/EDIFACT, and
valid, well-formed Extensible Markup Language (XML). BizTalk Server 2000 also supports BizTalk Framework 2.0. For more
information about BizTalk Framework 2.0, go to the Microsoft BizTalk Server 2000 Web site (www.microsoft.com/biztalk/). Parser
support for flat files is also available. You can also register and use your own custom parser components.

Data validation

BizTalk Server 2000 provides data validation by verifying each instance of a document against a specification. If the document
does not adhere to the specification rules, the document is placed into a suspended queue for further analysis.
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Reliable document delivery

BizTalk Server 2000 provides reliable document delivery by using configurable BizTalk Messaging Services properties. These
properties include setting service windows for sending documents, sending or receiving receipts, setting the number of retries,
and setting the time between retries. BizTalk Server 2000 supports the use of BizTalk Framework-compliant envelopes, which
provide reliable messaging features. For more information about BizTalk Framework 2.0, go to the Microsoft BizTalk Server 2000
Web site (www.microsoft.com/biztalk/). BizTalk Server 2000 also queues documents to a central location. In the event of a server
failure, rollover mechanisms enable new servers to take control of documents and process them.

Security

BizTalk Server 2000 supports encryption and digital signatures. Public-key encryption technology is supported for all documents
that are transmitted by using BizTalk Server 2000 transport services. BizTalk Server 2000 also supports decryption and signature
verification for the documents that it receives.

BizTalk Orchestration Services

BizTalk Orchestration Services include the integration of long-running business processes with the applications that run those
business processes. This integration is provided by an executable business-process file called an XLANG schedule. Additional
services provide control for running XLANG schedule instances.

A key feature of BizTalk Orchestration Services is the ability to handle complex transactions that run as long as weeks or months,
not just minutes or hours. Another important feature is the ability to implement concurrent actions within a single XLANG
schedule.

XLANG schedules

An XLANG schedule is a business process implemented by connecting each step in the process to a technology component or
service that executes the step. An XLANG schedule is then run by a service called the XLANG Scheduler Engine. The engine
controls the instantiation, execution, dehydration, and rehydration of an XLANG schedule, or multiple instances of one or more
schedules.

Implementation Technologies

Implementation technologies that are supported by BizTalk Orchestration Services include BizTalk Messaging Services, COM
components, Message Queuing Services, and Windows Script Components.

XLANG language

XLANG is a language that describes the logical sequencing of business processes, as well as the implementation of the business
process by using various technology components or services. The XLANG language is expressed in Extensible Markup Language
(XML).
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BizTalk Server Application Model

Microsoft BizTalk Server 2000 provides tools and services that enable you to create executable applications for controlling your

business processes and the exchange of data between trading partners and applications within your business. For a list of the
services provided by BizTalk Server 2000, see BizTalk Services.

Integrating BizTalk Orchestration Services and BizTalk Messaging Services enables you to control the exchange of documents and

messages between your trading partners and internal applications by using multiple transport services. It also provides:

Control over complex, long-running transactions and business processes.
Reliable delivery of documents and messages.

Data validation by verifying each document instance against a specification.
Data mapping by using maps to transform document structure and format.
Data security and integrity by using encryption and digital signature certificates.

Receipt generation and correlation support.

For more information about configuring BizTalk Server 2000 to send or receive receipts, see Understanding Receipts.

For more detailed information about how you can integrate BizTalk Orchestration Services and BizTalk Messaging Services,
see Integrating BizTalk Services.



BizTalk Server Administration Model

The following table describes the four main areas of administration in Microsoft BizTalk Server 2000 and relevant administrative

functions of each area.

Area of administration

Administrative function overview

Server administration

e Configure and manage server groups and servers.

e Configure and manage receive functions.

e Manage queues.

Application administration

e Configure and manage the COM+ applications that host XLANG schedules.

e Configure and manage the default XLANG Scheduler application.

Programmatic administrat
ion

e Configure XLANG system managers, XLANG group managers, XLANG schedule instances, and X

LANG ports.

Database administration

e Configure, manage, and maintain the following databases:

e BizTalk Messaging Management

o Orchestration Persistence

e Tracking

e Shared Queue

Server administration

In BizTalk Server 2000, server administration includes tasks such as managing and configuring server groups, adding, deleting
and configuring servers, adding and configuring receive functions, managing the Shared Queue for each server group, and so on.
The following table describes the general server administrative tasks, their description, and where to find more information.

Administrative task

Description

Where to find more information

Configure servers ands| e Configure the connections for the Trackingan| e Add, Delete, and Configure a Server Group
erver groups d Shared Queue databases.
e Add, Delete, and Configure Servers in a Group
Configure transport services and parser order.
Configure server settings.
Manage queues Delete and resubmit interchanges and docum | e Manage Queues
ents.
View data and error messages.
Manage receive functio Configure receive functions. e Manage Receive Functions for a Server Group
ns
Troubleshooting Troubleshoot server and document processin e Manage Event Viewer
g problems.
e Troubleshooting BizTalk Server Administration

Application administration

Application administration includes configuring and managing the COM+ applications that host XLANG schedules, the default




XLANG Scheduler application, and the Orchestration Persistence database that is created when you install BizTalk Server 2000.
The following table describes the general application administrative tasks, their description, and where to find more information.

Administrative task |Description

Where to find more information

tion ication.

Manage the default XL | e Change the default settings f| e Manage the Default XLANG Scheduler Application and Database
ANG scheduler applica or the XLANG Scheduler appl

S.

Manage COM+ applica) e Create COM+ applicationsto| e Manage Other COM+ Applications That Host XLANG Schedules
tions run specific XLANG schedule

Programmatic administration

The management and administration of servers and applications can be done programmatically. The following table describes the
general programmatic administrative tasks, their description, and where to find more information.

Manage Queues

Administrative task Description Where to find more information
e View interchange and e For more information about using Windows Management |
document data. nstrumentation (WMI) and WMI Application programming,
go to the MSDN Online Library
e Change the BizTalk Me (msdn.microsoft.com/library/default.asp) and search for "W
ssaging Management MI Application Programming".
database.

e WMI Overview

e Read from the Shared
Queue database. e Accessing the Suspended queue

Configure and manage the XLAN
G Scheduler System Manager, gr
oup managers, XLANG schedule i
nstances, and XLANG ports

e Start, stop, and retrieve| e Administering XLANG Schedules
information about the
XLANG Scheduler Syst
em Manager and grou
p managers.

e Stop, suspend, resume,
and retrieve informatio
n about all the schedul
es associated with a gr
oup.

Database management

In addition to regular database maintenance and administration, such as compressing data files and backing up the database and
transaction file logs, you must perform other database-related tasks, such as maintaining connectivity between BizTalk Server and
Microsoft SQL Server, adding, deleting, and restoring databases, configuring new databases, and so on. The following table
describes general database administrative tasks, their description, and where to find more information.

Administrati Description
ve task

Where to find more information
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Manage data
bases

Configure and/or change the Bi
zTalk Messaging Management d
atabase.

Create and configure new persis
tence databases.

Restore and/or manually remov
e the Tracking and Shared Queu
e databases.

Configure the BizTalk Messaging Management database

Change the BizTalk Messaging Management database for a server

Change the settings for the default Orchestration Persistence database

Manage Databases for a Server Group

Monitor traffi
c to the datab
ases

Configure server settings.

Understanding server properties

Optimizing Server Properties




abort

ABCDEFGHIJKLMNOPQRSTUVWXYZ
A

To cancel a transaction that is in progress, and to run an alternate business process instead.
action

To send or receive a message. Send or receive actions can be synchronous or asynchronous, depending upon which application
services are implemented in an XLANG schedule.

ANSI X12
EDI standards set by Accredited Standards Committee X12, whose work is approved by the American National Standards Institute.
asynchronous communication

A single message that is either sent or received within the context of a single communication action.
See also: synchronous communication

B

binding

A process by which the technology used to implement a port is specified.
See also: port

BizTalk Document Tracking

A Web-based user interface (Ul) that is used to access all BizTalk Messaging Services tracking information. It can also track XLANG
schedule status for BizTalk Orchestration Services.

BizTalk Editor

A tool with which you can create, edit, and manage specifications. With BizTalk Editor you can create a specification based on a
specification template, an existing schema, certain types of document instances, or a blank specification.

BizTalk Framework

A platform-neutral e-commerce framework that is based on Extensible Markup Language (XML) schemas and industry standards.
The framework enables integration across industries and between business systems, regardless of platform, operating system, or
underlying technology. Specifically, it is composed of three things: schema, products, and services. For more information about
the BizTalk Framework, go to the BizTalk Web site (www.microsoft/biztalk/).

BizTalk Mapper

A tool with which you can create maps that define the correspondence between the records and fields in one specification and the
records and fields in another specification. A map contains an Extensible Stylesheet Language (XSL) style sheet that is used by
BizTalk Server to perform the transformation described in the map.

BizTalk Messaging Management database

A Microsoft SQL Server database that stores the information related to all server configurations, including group and server
settings, receive functions, and all messaging configuration information for the objects that are created by using BizTalk
Messaging Manager, or by accessing the BizTalk Messaging Configuration object model.

BizTalk Messaging Manager

A graphical user interface (Ul) that can be used to configure BizTalk Messaging Services to exchange documents between trading
partners and applications of the home organization.

See also: BizTalk Messaging Services



BizTalk Messaging Services

Services that include sending, receiving, parsing, and tracking documents; receipt generation and correlation; and data mapping,
integrity, and security.

See also: BizTalk Messaging Manager
BizTalk Orchestration Designer

A design tool used to create drawings that describe long-running, loosely coupled, executable business processes. The XLANG
schedule drawing is compiled into an XLANG schedule that is used to execute the automated business process.

BizTalk Orchestration Services

Services that include designing, compiling, and running XLANG schedules. Additional services include the ability to create custom
COM+ applications to host dedicated XLANG schedule instances, and the persistence of XLANG schedules.

BizTalk Server 2000

A new Microsoft product for business-process automation and application-integration both within and between businesses.
BizTalk Server 2000 provides a powerful Web-based development and execution environment that integrates loosely coupled,
long-running business processes, both within and between companies.

BizTalk Server 2000 features include the composition of new and existing XLANG schedules; integration among existing
applications; the definition of document specifications and specification transformations; and the monitoring and logging of run-
time activity.

The server provides a standard gateway for sending and receiving documents across the Internet, as well as providing a range of
services that ensure data integrity, delivery, security, and support for the BizTalk Framework and other key document formats.

BizTalk Server Administration

A Microsoft Management Console (MMC) interface that is used to administer the BizTalk Server 2000 group of servers and their
properties, to monitor receive functions, and to monitor work items in the Microsoft SQL Server queues that are used by the
server group.

C
channel

A set of properties that designates the source of documents and defines specific processing steps that are performed by BizTalk
Messaging Services before a document is delivered to the destination designated by the messaging port or distribution list with
which the channel is associated.

See also: open channel, open messaging port, receipt channel, source application, trading partner, pass-through submission,
source organization

channel filtering

To compare the value of fields within a document instance to values in expressions designated within a channel. This comparison
filters the selection of which channel or channels the server invokes to process a document.

checkpoint

A storage location in the Shared Queue database in which the current state of a work item is stored. In case of a server failure,
documents that were queued to the failed server can be retrieved from the Shared Queue database and redistributed to other
servers within the server group, based on the information provided by the checkpoint.

code list

A list of code values used as abbreviations for a variety of textual information. For example, ST is the code list value for Ship To
and is most commonly used to qualify an address.

commit

To implement all changes requested by a pending transaction. This action occurs when all actions within a transaction are



successfully completed.
Communication shapes

Shapes that are used to identify the exact content of a message and type of application service that is implemented within an
XLANG schedule drawing. This category of shapes includes Constants, Message, Port, and Port References.

See also: Flowchart shapes, Implementation shapes, XLANG schedule drawing
compensation

A process by which reparation is made for a completed transaction. For example, if payment has been made for an order that then
cannot be fulfilled, the payment is returned to the purchaser.

compile

In BizTalk Mapper, to create an Extensible Stylesheet Language Transformations (XSLT) version of a map that can be used by
BizTalk Server. The map is stored in the WebDAV repository and used by BizTalk Server to translate one document format into
another document format.

See also: data mapping, data translation, Extensible Markup Language (XML), map
concurrency

Two or more actions that are carried out at the same time.

D

data mapping

In BizTalk Mapper, to create a correspondence between the records and fields of a source specification and the records and fields
of a destination specification.

See also: compile, data translation

data translation

A process that converts data from one format to another format. Data translation occurs within BizTalk Server at run time. The
rules that are specified in a map are used to convert data from a source specification format to a destination specification format,
as well as to perform any operations or calculations that are required on the data.

See also: compile, data mapping, Extensible Markup Language (XML), map

decision

A process that evaluates one or more rules sequentially. In BizTalk Orchestration Designer, a decision is represented by the
Decision shape. Rules are Microsoft Visual Basic Scripting Edition (VBScript) expressions that are used by Decision and While
shapes.

dehydrate

To store all state information for an XLANG schedule instance in a SQL Server database while the XLANG Scheduler Engine is
waiting to receive a message before executing the next action in the business process.

See also: XLANG Scheduler Engine

dehydrated schedule

A schedule that is stored in a database temporarily while waiting for receipt of a message before continuing to the next action in
the sequence. All state information about the schedule is stored in the database until the message is received. Dehydrating
schedules reduces the load on the computer that is hosting the schedule.

delimited flat file

A file that contains one or more records that are represented as a group of fields separated by a delimiter character. The records
themselves are also separated by delimiter characters.



destination application

A home-organization application that has been designated in a messaging port as the destination for documents.

See also: home organization

destination organization

A trading partner organization that has been designated in a messaging port as the destination for documents.

See also: openness, source organization, organization
destination specification

The specification in a map that represents the outgoing document. BizTalk Mapper maps from a source specification to a
destination specification.

See also: source specification
dictionary

A collection of properties associated with each item of work processed by BizTalk Server. These properties are exposed in BizTalk
Editor so that users can tell BizTalk Server how to find values within document instances for properties that are used to locate a
messaging port.

distribution list

A group of messaging ports that can be used to send the same document to several different trading partner organizations or
applications of the home organization. In the BizTalk Messaging Configuration object model, this is referred to as a port group.

See also: home organization, messaging port, trading partner
document definition

A set of properties that represents a specific document. Document definition properties include a pointer to a document
specification and can include global tracking fields and selection criteria.

See also: global tracking fields, selection criteria
document instance

A representation of the actual data that is sent to BizTalk Server. A document instance differs from a specification in that the
specification defines the structure of the data, while a document instance is a representation of the specific data contained in a
structure.

See also: global tracking fields, pass-through submission
document standard

The structure that defines a transaction set, such as an X12 850 standard. An implementation guideline can be created from a
document standard.

document type

A designation for the type of document on which a specification is based. For example, if a specification is based on
850Schema.xml from the X12 standard, when that specification is opened in BizTalk Editor, 850 appears in the document type
field on the Reference tab for the root node.

document type definition (DTD)

A standard definition that specifies which elements and attributes might be present in other elements and attributes and that
specifies any constraints on their ordering, frequency, and content.

dynamic port

A port that requires that specific location information be provided for an XLANG schedule at run time. The location for a dynamic



port is provided by a message that passes the location information to the reference for the port at run time.

See also: port, static port
dynamic queue

A queue that has an unknown address. Ports that use a Message Queuing implementation can use a dynamic queue when the
location of the queue is not known. The address of this queue must be provided by a message that passes the queue address to
the reference for the port at run time.

See also: static queue, per-instance queue

E

electronic data interchange (EDI)

A set of standards used to control the transfer of documents, such as purchase orders and invoices, between computers.
See also: selection criteria

envelope

1. A set of properties that defines an envelope. Envelope properties include an envelope format and can include a pointer to an
envelope specification.

2. Header and footer information, or header information only, that encapsulates or precedes document data for transport.
envelope format

The format of documents that an envelope can contain; for example, XML or X12.

Extensible Markup Language (XML)

A specification developed by the World Wide Web Consortium (W3C) that enables designers to create customized tags beyond
the capabilities of standard HTML. While HTML uses only predefined tags to describe elements within the page, XML enables tags
to be defined by the developer of the page. Tags for virtually any data item, such as a product or an amount due, can be used for
specific applications. This enables Web pages to function as database records.

See also: compile, map, data translation, XML-Data Reduced (XDR), XPath

Extensible Stylesheet Language (XSL)

A style sheet format for Extensible Markup Language (XML) documents. XSL is used to define the display of XML in the same way
that cascading style sheets (CSS) are used to define the display of Hypertext Markup Language (HTML). BizTalk Server uses XSL as
the translation language between two specifications.

F
Flowchart shapes

Shapes that represent the routing logic in an XLANG schedule drawing. This category of shapes includes Abort, Action, Begin,
Decision, End, Fork, Join, Transaction, and While.

See also: Communication shapes, Implementation shapes, Flowchart stencil, XLANG schedule drawing
Flowchart stencil

A drawing stencil provided by BizTalk Orchestration Designer. The Flowchart stencil provides all the shapes that can be used to
design the process flow of a business process that can be executed by a running XLANG schedule.

See also: Flowchart shapes, Implementation stencil
functoid

Built-in reusable function that enables complex structural manipulation operations between source specification elements,
destination specification elements, and other functoids.

See also: link



Functoid Palette

A toolbox that contains all functoids that can be used to create relationships between source specification elements and
destination specification elements.

G

global tracking fields

Document specification fields, designated in a document definition, that are logged to a tracking database for each instance of an
actual document processed by BizTalk Messaging Services.

See also: document instance, document definition

H

home organization

An object that represents your business in BizTalk Messaging Manager. The home organization is created for you when BizTalk
Server 2000 is installed. Only the home organization can have applications.

See also: destination application, distribution list, organization, source application, trading partner

|
Implementation shapes

Shapes that represent the technologies that the XLANG Scheduler Engine supports. This category of shapes includes BizTalk
Messaging, COM Component, Message Queuing, and Script Component.

See also: Communication shapes, Flowchart shapes, Implementation stencil

Implementation stencil

A drawing stencil provided by BizTalk Orchestration Designer. The Implementation stencil provides all the shapes that can be
used to bind a port to an implementation technology.

See also: Flowchart stencil, Implementation shapes

implementation technologies

Technologies used to implement a port in an XLANG schedule. The technologies supported by the XLANG Scheduler Engine
include COM components, Windows Script Components, Message Queuing Services, and BizTalk Messaging Services.

industry standard

A defined standard that is used for the exchange of information. Standards are extensible, and they follow a well-defined set of
rules, or syntax.

inner transaction

A transaction that is contained within the process flow of another transaction.

See also: long-running transaction, nested transaction, transaction, outer transaction

interchange

A collection of one or more document instances that comprises a single transmission and is exchanged from application to
application within an organization or from one trading partner to another.

line-of-business (LOB) application

An organization's primary business application. BizTalk Server 2000 supports numerous communication protocols that enable



line-of-business applications to reliably send and receive information.
link

In Microsoft BizTalk Mapper, a simple value-copy (or name-copy) operation from a field in the source specification to a field in the
destination specification, or to a functoid.

See also: functoid
long-running transaction

A collection of actions that send and receive messages over an indefinite period of time. Typically, long-running transactions
contain several nested short-lived transactions.

See also: short-lived transaction, inner transaction, nested transaction, outer transaction, transaction
Loopback

A specific type of transport service that enables the return of current state data to the application from which the state data
originated. Loopback uses the SubmitSync method call to restore the state data to the original application.

See also: transport services

M
map

An XML file that defines the correspondence between the records and fields in one specification and the records and fields in
another specification. A map contains an Extensible Stylesheet Language (XSL) style sheet that is used by BizTalk Server to
perform the transformation described in the map. Maps are created in BizTalk Mapper.

See also: compile, Extensible Markup Language (XML), data translation

mapping

The process of specifying the way in which data in one structure is transformed into another structure.
message

1. A packet of data that is sent or received by an XLANG schedule.

2.In BizTalk Orchestration Designer, a shape on the Data page that corresponds to the messages in an XLANG schedule.
Message shapes are composed of uniquely named fields, each containing a single data item of a specified data type.

messaging port

A set of properties that directs how documents are enveloped, secured, and transported to a designated destination organization
or application.

See also: distribution list
moniker

A name that represents an object and may include the complete path or address that identifies the location of the object.
See also: port

N
nested transaction

One or more transactions that are contained within the process flow of a larger transaction.

See also: inner transaction, long-running transaction, transaction, outer transaction
node path

An expression used to obtain XML element and attribute information, select data that matches specific criteria, and perform



comparisons on the data retrieved. More formally known as XPath.

See also: XPath

non-self-routing document

A document that is missing one or more of the following pieces of routing information: source organization identifier, destination
organization identifier, or document definition.

)

open channel

A channel that is explicitly declared as open to any source organization. The source data for an open channel is passed to BizTalk
Messaging Services either within the document or in a parameter submitted with the document.

See also: channel, openness, source organization

open messaging port

A messaging port that is explicitly declared as open to any destination organization. The destination data for an open messaging
port is passed to BizTalk Messaging Services either within the document or in a parameter submitted with the document.

See also: channel, openness, source organization

openness

A lack of explicit information about a source in a channel or destination in a messaging port. Channels contain information that
identifies the source. Messaging ports contain information that identifies the destination. If a channel is designated as an open
source, the source information is not explicitly declared in the channel and is provided by other means. Usually this information is
contained in the instance of the document that is sent, or it is set as parameters in a Submit method call. Similarly, if a messaging
port is designated as an open destination, the destination information is not explicitly declared in the messaging port and is
instead provided in the document instance or in the parameters of a Submit method call.

See also: destination organization, open channel, open messaging port, source organization
organization

A trading partner or a business unit within a trading partner, or, in the case of the home organization, your own business.

See also: source organization, destination organization, home organization, organization identifier, trading partner

organization identifier

A set of properties that uniquely identifies an organization. An organization can have multiple organization identifiers.
Organization identifiers consist of the following properties: a name, a qualifier, and a value.

See also: organization
outer transaction

A transaction that contains one or more transactions within its process flow.
See also: inner transaction, long-running transaction, nested transaction, transaction

P
parser

A component of BizTalk Server that translates non-XML files (for example, X12, EDIFACT, and flat file) into XML files.
pass-through submission

A submission that bypasses the parsing, decoding, decryption, transformation, and signature verification stages of processing. The
document instance is passed directly to the channel that is specified in the submission parameters. This type of submission can be
used to transmit binary files without data corruption, or to use only the server transport and global tracking features.

See also: channel, document instance



per-instance queue

A queue that is created for use with each new instance of an XLANG schedule.

See also: dynamic queue, static queue

persistence database

A database that is used to store XLANG schedule state when an XLANG schedule is dehydrated. A default database called the
Orchestration Persistence database is provided during installation when you install BizTalk Server 2000.

pipeline component

A component created to integrate applications with BizTalk Server 2000. Developers can use either the IPipelineComponent or
the IPipelineComponentAdmin interface, or the lighter-weight IBTSApplntegration interface, to develop these components.

port

A named location that uses a specific implementation. In BizTalk Orchestration Designer, a port is defined by the location to which
messages are sent or from which messages are received, and the technology that is used to implement the communication action.
The location is uniquely identified by the name of the port.

See also: dynamic port, moniker, port location, port reference, port implementation, port name, binding, static port
port group

A group of messaging ports that can be used to send the same document to several different trading partner organizations or
applications. In BizTalk Messaging Manager, this is referred to as a distribution list.

port implementation

A specific technology used by a port to implement a communication action.

See also: port, port location, port reference, port name

port location

The location associated with a specific port. The location is also dependent on the port implementation that is used. Each
implementation provides a different type of location for the port.

See also: port, port implementation, port name, port reference

port name

A unique identification for a port. This identification is used to correlate the port location with a specific port.

See also: port, port implementation, port location, port reference
port reference

A unique message that contains the port location for every port in an XLANG schedule. The Port References shape is located on
the Data page. Any data flow into or out of this message contains the port location for a port.

See also: port location, port, port implementation, port name
positional flat file

A file that contains fields that are the same fixed length, and contains records that have a common end-of-record terminator.

Q
quiescent state

A state that represents processing activity that is inactive or at rest, or when a process is in standby mode.

R



receipt channel

A channel that contains the information necessary to process a receipt that can be returned to the sender of a document.

See also: channel
receive functions

Functionality that enables any BizTalk server(s) to monitor directories and submit documents to BizTalk Server for processing.
BizTalk Server 2000 supports File and Message Queuing receive functions.

rehydrate

To retrieve all state information for an XLANG schedule instance from a SQL Server database after a message is received by the
XLANG Scheduler Engine.

See also: XLANG Scheduler Engine
reliable messaging

A feature of BizTalk Framework 2.0 protocol that supports guaranteed, once-only delivery of documents in heterogeneous
environments across the Internet.

resubmit

A procedure that submits interchanges or documents to BizTalk Server from the Suspended queue. The document is processed
from the point of failure.

Retry queue

A table within the Shared Queue database in Microsoft SQL Server. The Retry queue is associated with a server group that
contains items of work scheduled for transmission after an initial transmission has been attempted.

See also: Shared Queue database, transport services, Scheduled queue, Suspended queue, Work queue
routing logic

The set of rules that determines the sequence of execution within an XLANG schedule. Routing logic is implemented by the
Decision shape in BizTalk Application Designer.

S

Scheduled queue

A table within the Shared Queue database in Microsoft SQL Server. The Scheduled queue is associated with a server group that
contains interchanges that have been received but not yet processed by BizTalk Server.

See also: Retry queue, Shared Queue database, Suspended queue, Work queue

schema

The definition of the structure of an XML file. A schema contains property information as it pertains to the records and fields
within the structure.

selection criteria

A name-value pair designated in a document definition. The name-value pairs are used to uniquely identify a document definition
for inbound EDI interchanges, based on values found in the functional group header, and to insert values in the functional group
header for outbound EDI interchanges.

See also: document definition, electronic data interchange (EDI)

self-routing document

A document that contains all the necessary routing information, such as source and destination organization identifiers and a
document definition, in the routing tags or within the document.



serializer

A component of BizTalk Server that translates XML files into non-XML files (for example, X12, EDIFACT, and flat files).
server group

A collection of individual servers that is centrally managed, configured, and monitored.

Shared Queue database

A Microsoft SQL Server database that is shared by all servers within a server group. The Shared Queue database stores all
checkpoint information related to documents processed by BizTalk Server. If a server fails, other computers that use the same
Shared Queue database can continue to retrieve messages from and post messages to the Work queue. This provides redundancy
and process load balancing. The Shared Queue database is graphically presented in BizTalk Server Administration as a series of
distinct queues.

See also: Retry queue, Scheduled queue, Suspended queue, Work queue
short-lived transaction

A collection of grouped actions that are performed as a single logical unit of work.

See also: long-running transaction, transaction

source application

A home-organization application that has been designated in a channel as the source of documents.

See also: channel, home organization
source organization

A trading partner organization that has been designated in a channel as the source of documents.

See also: channel, destination organization, open channel, open messaging port, organization, trading partner, openness

source specification

The specification in a map that represents the incoming document. BizTalk Mapper maps from a source specification to a
destination specification.

See also: destination specification
specification

A BizTalk Server-specific XML schema. Specifications are created in BizTalk Editor and can be based on industry standards (such as
EDIFACT, X12, and XML) or on flat files (delimited, positional, or delimited and positional). BizTalk Mapper uses specifications,
opened as source specifications and destination specifications, to create maps.

state

The condition at a particular time of any of numerous elements of computing.
See also: XLANG schedule state

static port

A port that requires that all necessary information be provided for an XLANG schedule at design time. The designer who creates
the XLANG schedule must know the location to which messages are sent or from which messages are received, as well as the
technology chosen to implement the communication action.

See also: dynamic port, port
static queue

A queue that has a well-known address. Ports that use a Message Queuing implementation can use a static queue when the
location of the queue is known and does not change.



See also: dynamic queue, per-instance queue

Suspended queue

A table within the Shared Queue database in Microsoft SQL Server. The Suspended queue is associated with a server group. The
gueue contains work items for which any error or failure was encountered during processing. The queue stores the documents
until they can be corrected and reprocessed, or simply deleted.

See also: Retry queue, Scheduled queue, Shared Queue database, Work queue

synchronous communication

Messages that are sent or received in pairs and that occur within the context of a single communication action.
See also: asynchronous communication

T

Tracking database

A Microsoft SQL Server database associated with a server group that enables the tracking of documents that are processed by the
server either individually or in batches. You can also track XLANG schedule status.

trading partner

An external organization with which your home organization exchanges electronic data. The messaging ports, distribution lists,
channels, and XLANG schedules that you create govern the exchange of documents among trading partners.

See also: channel, source organization, distribution list, home organization, organization
transaction

A discrete activity within a computer system, such as an entry of a customer order or an update of an inventory item. Transactions
are usually associated with database management, order-entry, and other online systems. In BizTalk Orchestration Designer,
transactions are represented as a collection of actions that are grouped within a Transaction shape.

See also: inner transaction, long-running transaction, nested transaction, outer transaction, short-lived transaction

transaction set

A collection of segments in an EDI schema that has a specific order and a particular meaning for a particular business transaction.
transport services

A set of services that includes network protocols and application integration components (AICs). BizTalk Server 2000 supports a
core set of transport services. This enables the server to send documents to organizations or applications whether or not the
applications are capable of communicating directly with the server by using a COM interface. BizTalk Server 2000 supports the
File, HTTP, HTTPS, and SMTP network protocols and Message Queuing. Transport services are also referred to as transport
components.

See also: Retry queue, Loopback

u
UN/EDIFACT

The international EDI standard as developed through the United Nations. This standard is commonly used in Europe, as well as
Japan and other Asian countries and regions. Also known as United Nations/Electronic Data Interchange For Administration,
Commerce, and Transport.

\Y
version

In BizTalk Server 2000, either a specific release number for a specification or the industry-standard version number from which a
specification is created.



W
Web Distributed Authoring and Versioning (WebDAV)

An extension to the HTTP 1.1 standard that exposes a hierarchical file storage media, such as a file system, over an HTTP
connection. WebDAV locks documents to prevent users from accidentally overwriting each other's changes. It also enables users
to share and work with server-based documents, regardless of their authoring tools, platforms, or the type of Web servers on
which the files are stored.

well-formed XML
A standard that dictates that an XML document that has a single root and elements must nest completely or not at all.

Work queue

A table within the Shared Queue database in Microsoft SQL Server. The Work queue is associated with a server group. It contains
interchanges that are currently being processed by BizTalk Server 2000.

See also: Retry queue, Scheduled queue, Shared Queue database, Suspended queue

X
XLANG identity

A globally unique ID that is used to distinguish version instances of an XLANG schedule drawing. This property is read-only and
cannot be changed. Every time an XLANG schedule drawing is updated, this identity is also updated. The XLANG identity can be
used to correlate an XLANG schedule with the specific version of an XLANG schedule drawing from which the schedule was
compiled.

XLANG language

A language that describes the logical sequencing of business processes, as well as the implementation of the business process by
using various application services. The XLANG language is expressed in XML.

XLANG schedule

Specific business processes expressed in the XLANG language. An XLANG schedule is saved with the file extension .skx.

See also: XLANG schedule drawing, XLANG schedule instance, XLANG Scheduler Engine
XLANG schedule drawing

A drawing that represents a business process. In BizTalk Orchestration Designer, once a drawing is complete, it can be compiled
and run as an XLANG schedule. An XLANG schedule drawing is saved with the file extension .skv.

See also: Communication shapes, Flowchart shapes, XLANG schedule, XLANG Scheduler Engine

XLANG schedule instance

An evocation of a schedule. An XLANG schedule represents only the business process and implementation services. A single
instance, or multiple instances, of an XLANG schedule can be run by the XLANG Scheduler Engine. Different instances of the same
XLANG schedule contain different messages, but all instances follow the same business-process rules.

See also: XLANG schedule, XLANG Scheduler Engine
XLANG schedule state

The information contained in an XLANG schedule instance. This information includes messages that have been sent or received by
that instance, any COM objects used by that instance, and the progress of that instance toward the completion of the business
process.

See also: state

XLANG Scheduler

The default COM+ application that is installed when you install BizTalk Server 2000. This application is used to host running



instances of XLANG schedules.
XLANG Scheduler Engine

A service that runs XLANG schedule instances and controls the activation, execution, dehydration, and rehydration of an XLANG
schedule.

See also: dehydrate, rehydrate, XLANG schedule drawing, XLANG schedule instance, XLANG schedule
XML-Data Reduced (XDR)

An XML Schema dialect proposed by Microsoft and submitted to the World Wide Web Consortium (W3C) in 1998. Like XML-Data,
XDR is a syntax for Extensible Markup Language (XML) schemas that define the characteristics of an XML document. XDR is a
subset of XML-Data.

See also: Extensible Markup Language (XML)
XPath

A comprehensive language used for navigating through the hierarchy of an XML document. XPath expressions can obtain XML
element and attribute information, select data that matches specific criteria, and perform comparisons on the data retrieved. Also
called a node path.

See also: Extensible Markup Language (XML), node path



Differentiating BizTalk Server 2000 Standard and Enterprise
Edition Features

There are several differences between the standard and enterprise editions of Microsoft BizTalk Server 2000. The information that
follows explains these differences and the benefits that you can expect if your organization decides to upgrade to the enterprise
edition.

In BizTalk Server 2000 Standard Edition documentation, all BizTalk Server features except for the following enterprise edition
extensibility features are documented:

e Creating custom parsers

Creating custom serializers

Creating custom correlators

Creating custom functoids

Creating custom import modules

e Creating application integration components (AICs)

Also, BizTalk Server 2000 Standard Edition does not contain any samples that relate to the features in the previous list.

The following topics provide more detailed information about the differences between the standard and enterprise editions, as
well as a list of Help topics that apply only to the enterprise edition:

® BizTalk Server Scalability

BizTalk Server Group Support

BizTalk Orchestration Services Support

BizTalk Messaging Services Support

Extensibility Support



BizTalk Server Scalability

BizTalk Server 2000 Enterprise Edition fully utilizes all the processors on any computer on which the server runs. Using all
processors enables the server to achieve high scalability and performance by using the complete hardware configuration of the

computer.

BizTalk Server 2000 Standard Edition uses only a single processor, irrespective of the hardware on which the server is run. The
processor that is used is always the processor that is referenced by a processor affinity mask of 1.

Most aspects of BizTalk Server scaling are unavailable in the standard edition. The documentation on BizTalk Server performance
and scalability applies primarily to the enterprise edition. You can use the information in this documentation to learn about the
benefits of upgrading to the enterprise edition.

For more information about BizTalk Server performance and scalability, see Enhancing Performance and Scalability.



BizTalk Server Group Support

BizTalk Server 2000 Enterprise Edition supports groups that enable the server to scale out to handle heavier loads. You can add
one or more servers within a single group that share the same BizTalk Server configuration information, or you can create
multiple groups.

BizTalk Server 2000 Standard Edition is designed to handle smaller loads than the enterprise edition. If you configure BizTalk
Server for more than one server or group, the BizTalk Messaging Service does not start and does not process documents; you will
receive an error message. You must change the BizTalk Server configuration to work with only one server and one group before
the BizTalk Messaging Service will start.

The topics listed in the following table are the primary Help topics that apply only to the enterprise edition of BizTalk Server 2000.
This list is not intended to be an exhaustive list. You can use the information in these topics to learn about the benefits of
upgrading to the enterprise edition.

Description Topic title

Moving servers among different BizTalk Messaging |Moving servers between BizTalk Messaging Management databases
Management databases

Moving remote servers among different BizTalk Mes [Moving remote servers between BizTalk Messaging Management databases
saging Management databases

Changing the BizTalk Messaging Management datab|Changing the BizTalk Messaging Management database
ase that is used

Removing multiple servers from the BizTalk Messagi|Removing servers from the BizTalk Messaging Management database
ng Management database




BizTalk Orchestration Services Support

BizTalk Server 2000 Enterprise Edition supports COM+ applications that host groups of XLANG schedules. All XLANG schedules in
a group share the same configuration settings for various factors such as transaction support, synchronization, and security.
These settings are specified in the COM+ application that hosts the group of XLANG schedules. In the enterprise edition, this
design enables different groups of schedules to use configurations that address different application needs. This design facilitates
scaling up to a large number of organizations and applications while at the same time separating processes that might require
specific configuration settings such as security. To configure a COM+ application to host groups of XLANG schedules, an XLANG
tab with configuration options is provided for all newly created COM+ applications.

BizTalk Server 2000 Standard Edition does not support the ability to create multiple COM+ applications that can be dedicated to
hosting groups of XLANG schedules. A single COM+ application, the default XLANG Scheduler application, is created during
installation, and this application is used to host all XLANG schedules, regardless of any special configuration needs. In the
standard edition, the XLANG tab used to configure COM+ applications to host XLANG schedules is not available on any COM+
application except the default XLANG Scheduler application.

The topics listed in the following table are the primary Help topics that apply only to the enterprise edition of BizTalk Server 2000.
This list is not intended to be an exhaustive list. You can use the information in these topics to learn about the benefits of
upgrading to the enterprise edition.

Description Topic title

Creating and configuring XLANG schedule host applications |Create and Configure an XLANG Schedule Host Application
Creating a COM+ application to host an XLANG schedule Create a COM+ application to host XLANG schedules
Configuring a COM+ application that hosts XLANG schedules |Configure a COM+ application to host XLANG schedules
Managing COM+ applications that host XLANG schedules Manage Other COM+ Applications That Host XLANG Schedules
Changing application identities for COM+ applications Change the application identity for a COM+ application
Changing the DSN settings for COM+ applications Change the DSN settings for a COM+ application

Shutting down COM+ applications that host XLANG schedules|Shut down a COM+ application that hosts XLANG schedules




BizTalk Messaging Services Support

BizTalk Server 2000 Enterprise Edition is a complete business-to-business and enterprise-application integration solution that
scales up to a large number of trading partners and internal applications that interact with BizTalk Server.

BizTalk Server 2000 Standard Edition is optimized for a small business that interacts with a limited number of external trading
partners and applications. The standard edition supports the creation of five new organizations and five applications within an
organization.

In the standard edition, all BizTalk Server 2000 Help topics are relevant for creating and maintaining organizations and
applications. The only limitation is the number of organizations and applications that you can create.



Extensibility Support

BizTalk Server 2000 Enterprise Edition supports product extensibility that enables more complex document processing. The
extensions available in BizTalk Server Enterprise Edition are as follows:

e Custom parsers. To enable parsing of formats that are not supported in the native parsers provided by BizTalk Server
2000, the enterprise edition enables you to create custom parser components that conform to a well-defined parser
interface. You can configure these components in BizTalk Server to parse documents for the format(s) that they support.

e Custom serializers. To enable serializing of documents into proprietary or other formats that are not supported by
serializers provided by BizTalk Server 2000, the enterprise edition enables you to create custom serializer components that
conform to a well-defined serializer interface. You can configure these components in BizTalk Server to serialize documents
into the format(s) that they support.

e Custom receipt correlators. To enable the processing or generation of custom receipts when you exchange documents
with a trading partner, the enterprise edition enables you to create custom receipt correlator components by using and
implementing interfaces provided with BizTalk Server 2000. A custom parser is required to process a custom receipt and a
custom serializer is required to generate a custom receipt.

e Custom functoids. BizTalk Mapper provides functionality that enables you to specify transformations by using objects
called functoids. BizTalk Server 2000 provides a variety of functoids that perform many common operations such as string
manipulation, mathematical operations, logical operations, and so on. You might have other transformation-functionality
requirements that require custom functoids. The enterprise edition enables you to create your own custom functoids.

e Custom import modules. BizTalk Editor provides functionality that enables you to import files with an XML, DTD, or XDR
format. You might want to import other file formats. The enterprise edition enables you to create your own custom import
modules.

e Custom pipeline components. The enterprise edition enables you to create custom components that extend BizTalk
Server functionality when performing operations such as encryption, encoding, and signing.

BizTalk Server 2000 Standard Edition is designed for minimal configuration and customization needs. The standard edition does
not support the extensibility features listed previously for the enterprise edition. BizTalk Server 2000 Help for BizTalk Server 2000
Standard Edition does not contain any advanced Help topics related to custom components, and no samples that describe the use
of these components are provided.

For a complete list of BizTalk Messaging Services samples that are available in the standard edition,
see BizTalk Messaging Services Code Samples.



How to Use Help
This section includes information about the Microsoft BizTalk Server 2000 Help system. The following topics are covered:

e Help Overview

e Finding a Help Topic

e Bookmarking a Help Topic
e Copying a Help Topic

e Printing a Help Topic

e Changing the Font Size

e Using Language Filtering

e Help Viewer Shortcut Keys



Help Overview

The Microsoft BizTalk Server 2000 Help system uses HTML to format and display information. The Help Viewer provides an
integrated table of contents, an index, and a full-text search feature so that you can find information easily. Book icons open to
reveal sub-books and topics. To expand the table of contents and view topics within a book, click the expand indicator (+) next to a
book title. When you click the collapse indicator (-), the topics are hidden. The Help Viewer has the added benefit of enabling you
to see the table of contents, index, or search results at the same time you are viewing a Help topic.

The Help Viewer also includes the Favorites tab, which you can use to bookmark topics. This enables you to quickly display topics
that you refer to often.

To learn more about BizTalk Server 2000, you can use the table of contents to browse through the documentation. When you click
a topic in the table of contents, information is displayed in the content pane of the Help window.

The table of contents is organized in books according to the major features and functions that BizTalk Server 2000 provides.
Within each book, you can find chapters that contain the following information:

e How To
e Concepts
e Troubleshooting

® Resources

For procedural and task-based information, start with the How To chapters. For more general information about BizTalk Server
2000, its features, and other information, start with the Concepts and Resources chapters.

For programming information in the BizTalk Server 2000 Interface Reference, you can use a language-filtering tool to view
information specific to Microsoft Visual Basic, Visual C++, or both.

Related Topics

Bookmarking a Help Topic
Copying a Help Topic
Changing the Font Size
Finding a Help Topic

Help Viewer Shortcut Keys
Printing a Help Topic

Using Language Filtering



Finding a Help Topic
In the Help Viewer, the following browse and search options are available:
e Contents tab

1. To browse through the table of contents, click the Contents tab. Double-click the book icons to reveal topic entries
and sub-books.

2. Click a table-of-contents entry to display the corresponding topic.
o Index tab

1. To see a list of index entries, click the Index tab and then either type a word or scroll through the list. Topics are often
indexed under more than one entry.

2. Double-click an index entry to display the corresponding topic.
e Search tab

1. To locate every occurrence of a word or phrase, click the Search tab, type the word or phrase for which you want to
search, and then click List Topics.

To improve the search results, combine multiple words or phrases with AND, OR, NEAR, or NOT.

2. Double-click a search results entry to display the corresponding topic.
e Favorites tab

1. To bookmark a topic, use the Contents, Index, or Search tab to locate and then display a topic.
2. Click the Favorites tab and click Add to save the topic title to the Topics list.

3. Double-click a bookmark in the Topics list to quickly display the topic.

Related Topic

Help Viewer Shortcut Keys



Bookmarking a Help Topic

1. Use the Contents, Index, or Search tab to locate and then display the topic you want to bookmark.

2. Click the Favorites tab and click Add.

The Help Viewer adds the topic title to the Topics list. Later, you can return to this list and double-click the bookmark to quickly
display the topic.

[# Notes

® You can create a list of favorite/frequently visited Help topics.

e To remove a bookmark from the Topics list, click the bookmark and click Remove.

Related Topics

Finding a Help Topic

Help Viewer Shortcut Keys



Copying a Help Topic
1. In the topic pane of the Help Viewer, right-click inside the topic you want to copy and click Select All.
2. Inside the topic, right-click again and click Copy.

This copies the topic to the Clipboard.

3. Open the document to which you want to copy the topic.
4. Click the place in your document where you want the information to appear.

5. On the Edit menu, click Paste.
[# Notes

e |f you want to copy only part of a topic, select the part you want to copy, right-click the selection, and then click Copy.

e Step numbers are not copied to the Clipboard.

Related Topics
Finding a Help Topic

Printing a Help Topic



Printing a Help Topic
e Right-click the topic you want to print and click Print.
¢ Important

e To print a single topic, on the Contents tab, select a topic. On the Help toolbar, click Print, and then click Print the
selected topic. It is recommended that the page orientation be set to Landscape; however, printing code samples, large
illustrations, and significant text might result in incomplete printing.

e To print all topics within a book, on the Contents tab, select a book. On the Help toolbar, click Print, and then click Print
the selected heading and all subtopics. It is recommended that the page orientation be set to Landscape; however,
printing code samples, large illustrations, and significant text might result in incomplete printing.

Related Topics

Finding a Help Topic

Help Viewer Shortcut Keys



Changing the Font Size

You can increase the font size of text for easier viewing, or you can decrease the font size to see a representation of the layout of a
page.

e On the toolbar, click the Font (&%) button to increase or decrease the text size.



Using Language Filtering

To provide only the information that is relevant to your programming environment, BizTalk Server 2000 Help implements a

language-filtering tool. On the title bar of topics in BizTalk Server 2000 Interface Reference, you will find a filter (_I) button that
provides a language menu. This menu gives you the choice of viewing documentation tailored either to Visual C++ or to Visual
Basic. If you choose Show All, you will see information for both languages. Regardless of your language selection, you will always
see information (such as general concepts) that is relevant to both languages.

e To view the language-filtering options, click the filter (J) button on the title bar and click one of the following options:
o C++

e Visual Basic

e Show All

¥ Note

e When you select a language-filtering option, that selection remains in effect for all other pages that you view until you
change the option again.



Help Viewer Shortcut Keys

You can use shortcut keys to accomplish tasks in the BizTalk Server 2000 Help Viewer. The following table is a quick reference to
the shortcut keys available in Help Viewer.

¥ Note

e Functionality that is not included in this list can be obtained by using the numeric keypad to move the mouse pointer with
MouseKeys. For more information about MouseKeys in Windows 2000 Server Help, see "Using the keyboard to move the
mouse pointer”. In Windows 2000 Professional Help, see "To move the mouse pointer by using MouseKeys".

Help Viewer shortcut keys

Press To
ALT+SPACEBAR Display the system menu.
SHIFT+F10 Display the Help Viewer shortcut menu.
¥ Note

o Use this shortcut when the focus is in the topic pane.
ALT+TAB Switch between the Help Viewer and other open windows.
ALT+0O Display the Options menu.
ALT+0O, and then press T Hide or show the navigation pane.
CTRL+TAB Switch to the next tab in the navigation pane.
CTRL+SHIFT+TAB Switch to the previous tab in the navigation pane.
UP ARROW Move up one topic in the table of contents, index, or search results list.
DOWN ARROW Move down one topic in the table of contents, index, or search results list.
PAGE UP Move up one page in the table of contents, index, or search results list.
PAGE DOWN Move down one page in the table of contents, index, or search results list.
9 Switch focus between the navigation pane and the topic pane.
ALT+0O, and then press R Refresh the topic that appears in the topic pane.
UP ARROW or DOWN ARROW!|Scroll through a topic.
CTRL+HOME Move to the beginning of a topic.
CTRL+END Move to the end of a topic.
CTRL+A Highlight all text in the topic pane.
ALT+0O, and then press P Print a topic.
ALT+0O, and then press B Move back to the previously viewed topic.
ALT+0O, and then press F Move forward to the next (previously viewed) topic.
TAB Move between related topics.

¥ Note

e Use this shortcut when the focus is in the topic pane.

ALT+F4 Close the Help Viewer.

Contents tab shortcut keys

Press To

ALT+C Display the Contents tab.

RIGHT ARROW Open a book.

LEFT ARROW Close a book.

BACKSPACE Return to the previous open book.
UP ARROW or DOWN ARROW!|Select a topic.

ENTER Display the selected topic.

Index tab shortcut keys



Press To

ALT+N Display the Index tab.

UP ARROW or DOWN ARROW(|Select a keyword in the list.
ALT+D or ENTER Display the associated topic.

Search tab shortcut keys

Press To

ALT+S Display the Search tab.
ALT+L Start a search.

ALT+D or ENTER|Display the selected topic.

Favorites tab shortcut keys

Press |To

ALT+| |Display the Favorites tab.
ALT+A|Add a topic to the Topics list.
ALT+P Select a topic in the Topics list.

% Note

e Use this shortcut when the focus is in the topic pane and you want to move to the Topics list.

ALT+R[Remove a topic from the Topics list.

ALT+D|Display a topic from the Topics list.

Related Topic

Help Overview



Accessibility for People with Disabilities

Microsoft is committed to making its products easier for everyone to use. For information about features that make Microsoft
BizTalk Server 2000 more accessible, see the following:

e Help Viewer Shortcut Keys

e BizTalk Server Administration Shortcut Keys
e BizTalk Document Tracking Shortcut Keys

e BizTalk Orchestration Designer Shortcut Keys
e BizTalk Messaging Manager Shortcut Keys

e BizTalk Editor Shortcut Keys

e BizTalk Mapper Shortcut Keys
¥ Note

e For further information about accessibility options, in Windows 2000 Server Help, in the Getting Started with Windows
2000 book, see Accessibility for People with Disabilities. In Windows 2000 Professional Help, see the chapter Accessibility
for Special Needs.



Contacting Microsoft Product Support Services

Product name: Microsoft BizTalk Server 2000

Support options: To get the latest information on your support options, go to the Microsoft Product Support Services Web site
(support.microsoft.com/directory/productsupportoption.asp) and select BizTalk Server 2000 from the product list.

Worldwide: Support options, hours, and cost in your country/region may differ from the United States; check with your local
office for details.

Conditions: Microsoft product support services are subject to then-current prices, terms, and conditions, which are subject to
change without notice.


http://support.microsoft.com/directory/productsupportoption.asp

BizTalk Server 2000 Tutorial

Business-to-Business Automated Procurement

In this tutorial you will learn how to configure Microsoft BizTalk Server 2000 to establish and run a business-to-business
automated procurement process.

You will also learn how BizTalk Server components and services work together to integrate loosely coupled, long-running
business processes, both within and between businesses.

¥ Note

The BizTalk Server 2000 Tutorial is also provided in Microsoft Word format. To print the Tutorial, you must use this version. If you
do not have Word installed, you can view the file using Microsoft WordPad or Microsoft Word 97/2000 Viewer. The Tutorial.doc
file is located in \Program Files\Microsoft BizTalk Server\Documentation on the BizTalk Server installation drive.

Requirements

To successfully complete this tutorial, you must install BizTalk Server 2000 and all its dependencies. For a complete list of the
hardware and software requirements for BizTalk Server 2000, see Installing BizTalk Server 2000.

Scenario

This scenario provides a comprehensive overview of the key elements of BizTalk Server 2000. ProElectron, Inc. (the buyer
organization) uses BizTalk Server 2000 to implement a business-to-business automated procurement process with Bits, Bytes, &
Chips, Inc. (the seller organization).

ProElectron uses an XLANG schedule to control the flow of messages through the system. If a purchase order request is equal to
or less than $1000, a purchase order is generated and sent to Bits, Bytes, & Chips. Otherwise, the process terminates.

The buyer’s system uses BizTalk Messaging Services, which receives, routes, and transforms the purchase order to match the Bits,
Bytes, & Chips format, and then extracts the data.

Both systems also use a number of auxiliary components that work in conjunction with BizTalk Server 2000 to perform key data-
processing tasks.

The following illustration is an interaction diagram for the business-to-business automated procurement system implemented by
ProElectron and Bits, Bytes, & Chips. Arrows denote the flow of data among roles and entities.
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¢ Important

® For the purposes of this scenario, both the buyer and seller systems are configured on a single installation of BizTalk
Server 2000.

The following illustration shows the movement of the documents through the buyer and seller systems. It also shows the
interaction between the XLANG schedule, BizTalk Messaging Services, and the auxiliary components. This illustration is a useful
reference that you might want to print and have available as you work through the modules in this tutorial.
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BizTalk Orchestration

Contents

Module 1: Modeling Business Processes
In this module, you learn how to:
e Use BizTalk Orchestration Designer to create an XLANG schedule drawing that models the procurement processes for

ProElectron. For more information, see Designing BizTalk Orchestrations.

e Compile the XLANG schedule drawing into an XLANG schedule. For more information,
see Compile an XLANG schedule drawing into an XLANG schedule.

e Run the XLANG schedule to see how a message moves through the buyer system.
Module 2: Creating Specifications and Maps
In this module, you learn how to:

e Use BizTalk Editor to create document specifications. For more information, see Create and Validate Specifications.

e Use BizTalk Mapper to create maps. For more information, see Create new maps.

Module 3: Configuring BizTalk Messaging Services

In this module, you learn how to:

e Use BizTalk Messaging Manager to configure BizTalk Messaging Services for Bits, Bytes, and Chips. For more information,
see Using BizTalk Messaging Manager.

e Use BizTalk Server Administration to create a File receive function for Bits, Bytes, and Chips. For more information,
see Add a File receive function.

Module 4: Completing the XLANG Schedule

In this module, you learn how to:

e Implement a port in the XLANG schedule drawing that you started in Module 2 by using a BizTalk Messaging
implementation. For information about the differences between ports and messaging ports,
see Understanding Port Implementations and Understanding Messaging Ports.

e Complete the XLANG schedule drawing and compile it into an XLANG schedule.

e Run the schedule to understand the complete movement of messages between the buyer and seller systems.

# Shortcuts

Shortcuts enable you to save time and effort by using an existing XLANG schedule, document specification, a map, or a
configuration script. By using shortcuts, you can advance to subsequent sections of the tutorial.

To use shortcuts, the components must be installed on drive C.

Continue to Preliminary Setup.



Preliminary Setup

Before you begin the tutorial, you must create the following:

e One folder containing four subfolders.
e Two local Web site folders containing ASP files.

e Two message queues for the buyer system.

Continue to Create folders.



Create folders

In this procedure, you create one folder that contains four subfolders. You use two of the subfolders as locations for messages as
they move into and out of the buyer and seller systems, and two as content folders for the buyer and seller Web sites.

To create the folders:
1. In Windows Explorer, browse to the root directory of your C:\ drive.
¥ Caution
e You must create the following folders on your C\ drive.

2. Create a new folder on the root of the C:\ drive; name the folder TutorialFiles.

3. Click the new folder called TutorialFiles and create four subfolders with the following names:

e Buyer
e Seller
o SubmitPO

e InvoiceToQueue

Continue to Copy files.



Copy files

In this procedure, you copy files needed to complete the tutorial.

1. On the BizTalk Server installation drive, browse to \Program Files\Microsoft BizTalk
Server\Tutorial\DocSpecsandMaps and copy POReqtoPO.xml.

2. Paste the file to \Program Files\Microsoft BizTalk Server\BizTalkServerRepository\Maps\Microsoft.

3. Use the following table to copy and paste additional files to the TutorialFiles subfolders.

Copy from: Paste to:

\Program Files\Microsoft BizTalk Server\Tutoria\Components\SubmitPO\Solution\SubmitProEl |(C:\TutorialFiles\SubmitPO
ectronPO.asp

\Program Files\Microsoft BizTalk Server\Tutoria\NComponents\InvoicetoQueue\Solution\DroplIn|C:\TutorialFiles\InvoiceTo

voicetoMSMQ.asp Queue
\Program Files\Microsoft BizTalk Server\Tutorial\Components\InvoicetoQueue\Solution\Global.|C\TutorialFiles\InvoiceTo
asa Queue

Continue to Create local Web site folders.



Create local Web site folders

In this procedure, you create two virtual directories. The first directory simulates the buyer Web site that receives invoices. The
second directory simulates the seller Web site that receives purchase orders.

1. On the Start menu, point to Settings and click Control Panel.
2. Double-click Administrative Tools.

3. Double-click Computer Management.
The Computer Management console appears.

4. In the Computer Management console tree, expand Services and Applications, expand Internet Information Services,
and then click Default Web Site.

5. On the Action menu, point to New and click Virtual Directory.
The Virtual Directory Creation Wizard opens.

6. On the Welcome to the Virtual Directory Creation Wizard page, click Next.
7. On the Virtual Directory Alias page, in the Alias box, type SubmitPO and click Next.
8. On the Web Site Content Directory page, click Browse.
9. Browse to C:\TutorialFiles\SubmitPO, click OK, and then click Next.
10. On the Access Permissions page, click Next.
11. Click Finish to close the Virtual Directory Creation Wizard.
12. In the Computer Management console tree, click Default Web Site.

13. To create the folder that simulates the buyer Web site, repeat steps 5 through 11, with the following variations:

e Instep 7, in the Alias box, type InvoiceToQueue.

e Instep 9, browse to C:\TutorialFiles\InvoiceToQueue.

Your Computer Management console should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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1. Close the Computer Management console.

Continue to Create message queues.



Create message queues

In this procedure, you create two message queues to enable the buyer system to send and receive messages.

¥ Note

To complete this procedure, Message Queuing must be installed. For instructions about installing Message Queuing,
see Install Message Queuing

To create the message queues:

1.

On the Start menu, point to Settings and click Control Panel.

. Double-click Administrative Tools.

. Double-click Computer Management.

The Computer Management console appears.

In the Computer Management console, expand Services and Applications, expand Message Queuing, and then click
Private Queues.

. On the Action menu, point to New and click Private Queue.

The Queue Name dialog box appears.

. In the Name box, type ReceivePOReq.

Select the Transactional check box and click OK.

. To create the second message queue, repeat steps 5 through 7, with the following variation:

® Instep 6, in the Name box, type Receivelnvoice.

Your Computer Management console should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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1. Close the Computer Management console.

Continue to Install the auxiliary components.



Install the auxiliary components

In this procedure, you install the following auxiliary components:
e A Windows Script Component (WSC) on the buyer system that you use to implement a port to an XLANG schedule, and
which accepts the approval or denial status for a purchase order request from the XLANG schedule.
e An application integration component (AIC) on the seller system that you use to generate an invoice that is based on the

data in the purchase order from the buyer.

¥ Caution

e [f these components have been installed previously on your computer, you must first uninstall them. To uninstall the
components, go to Uninstall the auxiliary components.

To install the auxiliary components:

1. On the BizTalk Server installation drive, browse to \Program Files\Microsoft BizTalk Server\Tutorial\Setup.

2. Double-click Install_POtolnvoice.vbs.
A message box appears, indicating that the component was successfully installed.

3. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POReqApproval\Solution and click
PORequestApproval.wsc.

4. On the File menu, click Register.

A message box appears, indicating that the component was successfully registered.

Continue to Module 1: Modeling Business Processes.



Uninstall the auxiliary components

¥ Caution

Do not use this procedure unless you are removing a previous installation of the components.

1. For the POtolnvoice component, browse to \Program Files\Microsoft BizTalk Server\Tutorial\Setup on the BizTalk
Server installation drive.

2. Double-click Remove_POtolnvoice.vbs.
A message box appears, indicating that the component was successfully uninstalled.

3. For the Windows Script Component, browse to \Program Files\Microsoft BizTalk
Server\Tutorial\Components\POReqApproval\Solution and click PORequestApproval.wsc.

4. On the File menu, click Unregister.

A message box appears, indicating that the component was successfully unregistered.

To reinstall the components, go to Install the auxiliary components.



Module 1: Modeling Business Processes

In this module, you use BizTalk Orchestration Designer to create an XLANG schedule drawing that describes an automated
procurement process. You then compile the XLANG schedule drawing into an executable XLANG schedule, which controls the
flow of messages for the buyer system.

Objectives

e Create an XLANG schedule drawing that describes the automated procurement process. For more information,
see Creating XLANG Schedule Drawings.

e Connect the actions in a logical sequence that describes the business processes. For more information, see Connect Shapes.

e Implement the business processes by connecting actions to ports. For more information,
see Establish the communication flow between an action and a port.

e Add a rule to the business processes by writing a script expression. For more information, see Designing Rules.
o Define the data flow for messages. For more information, see Communication Shapes.

o Save the XLANG schedule drawing and compile the drawing into an XLANG schedule. For more information,
see Compiling XLANG Schedules.

e Run the XLANG schedule to process the message through BizTalk Server. For more information,
see Running XLANG Schedules.

Continue to Creating the XLANG Schedule for the Buyer.
Related Topic

Designing BizTalk Orchestrations



Creating the XLANG Schedule for the Buyer

In this procedure, you model the business processes for the buyer and create an XLANG schedule.
To create the XLANG schedule, continue to Create the buyer actions.
= Shortcut

To use the existing XLANG schedule, continue directly to Run the XLANG schedule.



Create the buyer actions

1.

10.

On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Orchestration
Designer.

On the Business Process page, drag the Action shape from the Flowchart stencil to the left of the Separator bar. Position
the shape directly below the Begin shape.

. Right-click the Action shape and click Properties.

The Action Properties dialog box appears.

. In the Name box, type Receive PO Request and click OK.

¥ Caution

e For this scenario to run correctly, you must type all names exactly as indicated. The tutorial components use these
names.

. On the Business Process page, drag the Decision shape from the Flowchart stencil to the left side of the Separator bar.

Position this shape below the Receive PO Request action.

Right-click the Decision shape and click Add Rule.
The Rule Properties dialog box appears.
In the Rule name box, type Denied and click OK.

Later in this module, you add a script expression that implements the decision rule, after you bind the Decision shape to
the Script Component, which provides the message and field names.

. Repeat steps 2 through 4, to create the following three actions:

e Position a second Action shape to the right of the Decision shape. Name this action Send Denial.
® Position a third Action shape below the Decision shape. Name this action Send Approval.

e Position a fourth Action shape below the Send Approval action. Name this action Write PO Request to File.

. On the Business Process page, drag the End shape from the Flowchart stencil to the left side of the Separator bar.

Position the shape below the Send Denial action.
If the purchase order request is not approved, the XLANG schedule displays a denial message and ends.

On the Business Process page, drag the End shape from the Flowchart stencil to the left side of the Separator bar.
Position the shape below the Write PO Request to File action.

If the purchase order request is approved, the XLANG schedule writes the purchase order request to a file directory, displays
an approval message, and then ends.

Continue to Connect the buyer actions in a sequence.



Connect the buyer actions in a sequence

1. Click the Begin shape to highlight the control handles.

%

Drag the bottom control handle to the top connection point of the Receive PO Request action.

The Receive PO Request action represents the start of the business process. When a purchase order request is received,
the XLANG schedule starts running.

[# Notes

e A green box on a highlighted shape indicates a control handle. You can drag control handles to connect to an action.
e A blue X on a shape indicates a connection point.

e Connection points on the side of an Action shape are used only to connect to ports, not to other Action shapes.
2. Repeat step 1 to create a connection for the following action:
e Connect the Receive PO Request action to the Decision shape.

3. Select the Denied rule in the Decision shape and drag the right control handle of the Denied rule to the top connection
point of the Send Denial action.

4. Select the Else rule in the Decision shape and drag the left control handle of the Else rule to the top connection point of the
Send Approval action.

¥ Note

® You can connect the rules in the Decision shape to the Send Approval and Send Denial actions from either the
right or left control handle.

5. Connect the Send Approval action to the Write PO Request to File action.
6. Connect the Write PO Request to File action to the End shape positioned below it.
7. Connect the Send Denial action to the End shape positioned below it.

8. On the File menu, click Save As.
The Save XLANG Schedule Drawing As dialog box appears.

9. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab on the BizTalk Server installation drive.

10. In the File name box, type Buyer1 and click Save.

The XLANG schedule drawing that you created and saved should appear similar to the following illustration.

Click the illustration to enlarge or reduce.



" g BizTalk Orchestration Designer - [Buyer1:Business Process]

J@ File Edit ‘iew Format Tools Window Help =181 x|
DEHE SA|LER o-> |[vFffA- QR ur -2
Use Flowchart Shapes to Draw a Use Implementation Shapes -l

Business Process

Receive PO FRequest &
Decizion <>

Send Dend

irte PO Request to Fie

(4] 4] [ M Business Process

Data _." Jll

to Implement Ports

Continue to Implement a port by using Message Queuing to receive a purchase order request.




Implement a port by using Message Queuing to receive a
purchase order request

The service is configured to monitor a message queue for a purchase order request. When this occurs, the XLANG schedule
begins processing. For information about the usage of ports and messaging ports in this tutorial, see Integrating BizTalk Services.

To implement the port:

1. On the Business Process page, drag the Message Queuing shape from the Implementation stencil to the right side of
the Separator bar. Position the Message Queuing shape so that it is horizontally aligned with the Receive PO Request
action.

The Message Queuing Binding Wizard opens.

2. On the Welcome to the Message Queuing Binding Wizard page, verify that Create a new port is selected.
3. In the Create a new port box, type ReceivePORequest and click Next.

4. On the Static or Dynamic Queue Information page, verify that Static queue is selected and click Next.

5. On the Queue Information page, click Use a known queue for all instances.

6. In the Enter the queue name box, type .\private$\ReceivePOReq and click Next.

7. On the Advanced Port Properties page, click Finish.

On the Business Process page, the ReceivePORequest port and the associated Message Queuing implementation appear.

Continue to Create the communication flow for the Receive PO Request action.



Create the communication flow for the Receive PO Request
action

1. Select the Receive PO Request action and drag the control handle on the right of the Receive PO Request action to the
left connection point of the ReceivePORequest port.

The XML Communication Wizard opens.

2. On the Welcome to the XML Communication Wizard page, click Receive and click Next.
3. On the Message Information page, verify that Create a new message is selected.
4. In the Message name box, type POReq and click Next.

5. On the XML Translation Information page, verify that Receive XML messages from the queue is selected and click
Next.

6. On the Message Type Information page, in the Message type box, type POReq and click Next.

7. On the Message Specification Information page, click Browse.
The Browse for Specification dialog box appears.

8. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\DocSpecsandMaps on the BizTalk Server installation
drive.

9. Click PoReq.xml and click Open.

10. Click Add.
The Field Selection dialog box appears.
11. In the Select node area, expand Total, click POTtl, and then click OK.
In the Message fields area, POTtl should appear in the list of message fields.

12. Click Finish.

After you implement the port and create the communication flow, the XLANG schedule drawing should appear similar to the
following illustration.

Click the illustration to enlarge or reduce.
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Continue to Implement a port by using a script component.



Implement a port by using a script component

The XLANG schedule passes the value in the total field of the purchase order request to the Decision shape. The scripting
expression in the decision rule forks the path of the schedule and sends the appropriate message to the port implementation that
uses a Windows Script Component, based on the total of the purchase order request.

To implement the port:

1. On the Implementation stencil, drag the Script Component shape to the right of the Separator bar that divides the two
sides of the drawing. Position the shape so that it is horizontally aligned with the Decision shape.

The Script Component Binding Wizard opens.

2. On the Welcome to the Script Component Binding Wizard page, in the Create a new port box, type
ApprovalComponent and click Next.

3. On the Static or Dynamic Communication page, verify that Static is selected and click Next.
4. On the Specify the Script File page, click Browse.

5. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POReqApproval\Solution on the BizTalk
Server installation drive.

6. Click PORequestApproval.wsc, click Open, and then click Next.

7. On the Component Instantiation Information page, verify that Use the Prog ID "BTSTutorial.PORequestApproval” is
selected and click Next.

8. On the Method Information page, click Check All and click Next.

9. On the Advanced Port Properties page, click Finish.

Continue to Define message properties for the script component.



Define message properties for the script component

1. Select the Send Denial action and drag the control handle on the right to the ApprovalComponent Windows Script
Component port.

The Method Communication Wizard opens.

2. On the Welcome to the Method Communication Wizard page, verify that Initiate a synchronous method call is
selected and click Next.

3. On the Message Information page, verify that Create a new message is selected and click Next.

4. On the Message Specification Information page, in the Methods list, click SendDenial and click Finish.

5. Select the Send Approval action and drag the control handle on the right of the Send Approval action to the
ApprovalComponent port.
The Method Communication Wizard opens.

6. On the Welcome to the Method Communication Wizard page, verify that Initiate a synchronous method call is
selected and click Next.

7. On the Message Information page, verify that Create a new message is selected and click Next.

8. On the Message Specification Information page, in the Methods list, click SendApproval and click Finish.

9. Select the Write PO Request to File action and drag the control handle on the right of the Write PO Request to File
action to the ApprovalComponent port.
The Method Communication Wizard opens.

10. On the Welcome to the Method Communication Wizard page, verify that Initiate a synchronous method call is

selected and click Next.

11. On the Message Information page, verify that Create a new message is selected and click Next.

12. On the Message Specification Information page, in the Methods list, verify that WriteToFile is selected and click Finish.

Continue to Write the script expression for the decision rule.



Write the script expression for the decision rule

The denial decision rule contains properties that define the shape's behavior. The scripting expression refers to data contained in
messages, and evaluates to either TRUE or FALSE. The scripting expression also defines the logic and variable names that are used
by the Decision shape.

If the total of the purchase order request exceeds $1000:

e The Decision shape sends a denial message to the port.
e A message box notifies the user of the denial.

e The XLANG schedule ends.
If the total of the purchase order requestis $1000 or less:

e The Decision shape sends an approval message to the script component.
e The script component displays a message box that notifies the user of the approval.
e The script component writes the purchase order request message to a local file directory.

® The XLANG schedule ends.
To write the script expression:
1. Click the Data tab at the bottom of the page.
The Data page appears.
2. View the POReq message to find the field name.

To write the script expression, both the message name and the field name are required. In this case, the message name is
POReq and the field name is POTtI.

3. Click the Business Process tab at the bottom of the page.
The Business Process page appears.
4. Right-click the Decision shape and click Properties.
The Decision Properties dialog box appears.
5. Verify that Denied is selected and click Edit.
The Rule Properties dialog box appears.
6. In the Script expression box, type POReq.POTtl > 1000.
This indicates that if the total field in the purchase order request is greater than $1000, the request is denied.
7. Click OK to close the Rule Properties dialog box, and click OK to close the Decision Properties dialog box.
The XLANG schedule drawing should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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Continue to Define the data flow.



Define the data flow

To define data flow within the business process, you create connections between fields in Message shapes on the Data page.

To define the data flow:

1. Click the Data tab at the bottom of the page.
The Data page appears.

2. In the POReq message, click the Document field and drag the control handle on the right to a connection point on the
Document field in the SendDenial_in message.

3. Repeat step 2 by clicking the Document field and dragging the highlighted control handle on the right from the POReq
box to a connection point on following fields:

e The Document field in the SendApproval_in box.

o The Document field in the WriteToFile_in box.
¥ Note
e (lick the Document field of the POReq message before trying to drag the control handle to the other fields.

The completed Data page should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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Continue to Save the XLANG schedule drawing.



Save the XLANG schedule drawing

e On the File menu, click Save Buyer1.skv.

Continue to Compile the XLANG schedule.



Compile the XLANG schedule

1. On the File menu, click Make XLANG Buyer1.skx.
The Save XLANG Schedule to dialog box appears.

2. Verify that the XLANG schedule will be saved to the \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab
folder on the BizTalk Server installation drive and click Save.

3. On the File menu, click Exit to close BizTalk Orchestration Designer.

Continue to Run the XLANG schedule.



Run the XLANG schedule

In this procedure, you run the XLANG schedule twice to view the approval and denial of purchase order requests.

To run the XLANG schedule:

1.

2.

3.

Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Solution on the BizTalk Server installation
drive.

Double-click ExecuteTutorial.exe. This application is used to activate the XLANG schedule by means of a moniker.
The ExecuteTutorial application opens.

Click Browse for Schedule.

= Shortcut

If you are using the existing XLANG schedule, browse to \Program Files\Microsoft BizTalk
Server\Tutorial\Schedule\Solution and continue to step 5.

1.

10.

11.

12.

If you created the Buyer1 XLANG schedule, browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab
on the BizTalk Server installation drive.

. Click the Buyer1.skx XLANG schedule file, and click Open.

Click Browse for Data File and browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\SampleData
on the BizTalk Server installation drive.

. Click POReqAccept.xml and click Open.

. Click Start XLANG Schedule.

Because its total is less than $1000, the purchase order request is approved. A message box appears notifying you that the
application passed data to the XLANG Scheduler Engine. At this point, the application is finished. A second message box
notifies you that the purchase order request has been approved. Click OK to close the dialog boxes.

. Click End to close the ExecuteTutorial application.

¢ Important

e |f you see an automation error when running this application, check to make sure that you have properly configured
the private queue and that its name is correct.

. Browse to C:\TutorialFiles\Buyer.

The file name is PORegXXXXX.xml, where XXXXX represents a unique set of numbers. Double-click the file to open it in
Microsoft Internet Explorer. This is a copy of the purchase order request file that the application posted to the message
queue. After viewing this file, delete it.

. Repeat steps 1 through 5 to run the ExecuteTutorial application again.

Click Browse for Data File and browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\SampleData
on the BizTalk Server installation drive.

Click POReqDeny.xml and click Open.

Click Start XLANG Schedule.

Because its total exceeds $1000, the purchase order request is denied. A message box appears notifying you that the
application is finished. A second message box notifies you that the document denial has been received. Click OK to close the
dialog boxes.

Click End to close the ExecuteTutorial application.



The following diagram illustrates the flow of data when you run the XLANG schedule.
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Module 1 Summary

In this module, you accomplished the following:

e Created the XLANG schedule drawing that described the automated procurement process. For more information,
see Creating XLANG Schedule Drawings.

e Connected the actions in a logical sequence that described the business process. For more information, see Connect Shapes.

e Implemented the business process by connecting actions to ports. For more information,
see Establish the communication flow between an action and a port.

e Added a rule to the business process by writing a script expression. For more information, see Designing Rules.
o Defined the data flow for messages. For more information, see Communication Shapes.

e Saved the XLANG schedule drawing and compiled the drawing into the XLANG schedule. For more information,
see Compiling XLANG Schedules.

® Ran the XLANG schedule twice to process the purchase order request through BizTalk Server, observing the approval and
denial. For more information, see Running XLANG Schedules.

The highlighted areas of the following diagram illustrate the steps you completed in this module.
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Module 2: Creating Specifications and Maps
In this module, you use BizTalk Editor to create specifications and BizTalk Mapper to create maps.
Objectives

e (reate a specification. For more information, see Creating Specifications.

Add new records and fields to a specification. For more information, see Add new fields to records.

Create a map. For more information, see Mapping Data.

Create links between fields in a map. For more information, see Creating Links.

Use functoids to mathematically manipulate values in a map. For more information, see Understanding Functoids.

e Save specifications and maps to the WebDAV repository. For more information, see Store specifications and Store maps.
Continue to Using BizTalk Editor.
Related Topic

Creating Specifications and Mapping Data



Using BizTalk Editor

You can use BizTalk Editor to create, edit, and manage specifications.

To use BizTalk Editor to create the payment specification, continue to Create the payment specification.

= Shortcut

To use the existing payment specification, continue directly to Use the existing payment specification.



Use the existing payment specification

1. Copy PaymentSpec.xml from \Program Files\Microsoft BizTalk Server\Tutorial\DocSpecsandMaps on the BizTalk
Server installation drive.

2. Paste the file to \Program Files\Microsoft BizTalk Server\BizTalkServerRepository\DocSpecs\Microsoft.

To use BizTalk Editor to create the purchase order request specification, continue
to Create the purchase order request specification.

» Shortcut

To use the existing purchase order request specification, continue to Use the existing purchase order request specification.



Create the payment specification

1. On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Editor.

2. On the File menu, click New.
The New Document Specification dialog box appears.

3. Click the Blank Specification icon and click OK.
4. In the root node, click BlankSpecification.
5. On the Declaration tab, double-click the Value field in the Name row, type Payment, and then press ENTER.

6. Double-click the Value field in the Model row, click Open, and then press ENTER.

Continue to Add new records to the Payment root node of the payment specification.



Add new records to the Payment root node of the payment
specification
1. Right-click the Payment root node and click New Record.

2. Name this record PaymentHeader and press ENTER.

3. Follow steps 1 and 2 to create and name four additional records under the Payment root node. These records are all child
records of the Payment root node. Name the records as follows:

e Seller
e Buyer
o Item

e PaymentSummary

Continue to Add new records to existing records in the payment specification.



Add new records to existing records in the payment
specification
1. Right-click the Seller record and click New Record.

2. Name the record Address and press ENTER.

3. Follow steps 1 and 2 to create child records for the parent records listed in the following table.

Parent record|Child record names
Seller Contactinfo

Buyer Address

Buyer Contactinfo

Continue to Add new fields to existing records in the payment specification.



Add new fields to existing records in the payment specification

1. Right-click the PaymentHeader record and click New Field.

2. Name this field PONumber and press ENTER.

3. On the Declaration tab, double-click the Value field in the Data Type row and click String, and then press ENTER.
4. On the Declaration tab, double-click the Value field in the Minimum Length row, type 1, and then press ENTER.

5. On the Declaration tab, double-click the Value field in the Maximum Length row, type 22, and then press ENTER.

(o))

. Follow steps 1 through 5 to create fields for the records or child records listed in the following table. Each record contains
multiple fields.

You do not have to create the fields for the buyer because parallel record names exist for the buyer and seller. All records
with the same name contain the same record and field information. When you add fields to the Seller/Address or
Seller/Contactinfo record, the Buyer/Address or Buyer/Contactinfo record is automatically updated with the same fields.

Parent record Field name |Data type/Minimum lengthMaximum length
PaymentHeader |Date Date Not applicable Not applicable
Seller/Address Name String 1 60

Address1 String 1 55

Address2 String 1 55

City String 2 30

State String 2 2

Zip String 3 15

Country String 2 3
Seller/Contactinfo |[Name String 1 60

Number String 1 60
Item Quantity Real(r4) |Not applicable Not applicable

Price Real(r4) |Not applicable Not applicable

Description  |String 1 80

ExtendedPricelReal(r4) |Not applicable Not applicable
PaymentSummary|Total Real(r4) |Not applicable Not applicable

Continue to Store the payment specification to WebDAV.




Store the payment specification to WebDAV

1. On the File menu, click Store to WebDAV.
The Store to WebDAV dialog box appears.

2. Double-click the Microsoft folder.
3. In the File name box, type PaymentSpec and click Save.

4. On the Tools menu, click Validate Instance.
The Validate Document Instance dialog box appears.
5. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Solution on the BizTalk Server installation
drive.
6. Click payment_valid.xml and click Open.
Warnings or errors, if any, appear on the Warnings tab.
The payment specification should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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To use BizTalk Editor to create the purchase order request specification, continue
to Create the purchase order request specification.

# Shortcut

To use the existing purchase order request specification, continue to Use the existing purchase order request specification.



Use the existing purchase order request specification

1. Copy POReq.xml from \Program Files\Microsoft BizTalk Server\Tutorial\DocSpecsandMaps on the BizTalk Server
installation drive.

2. Paste the file to \Program Files\Microsoft BizTalk Server\BizTalkServerRepository\DocSpecs\Microsoft.

Continue to Using BizTalk Mapper.



Create the purchase order request specification

In this procedure, you create the root node of the purchase order request specification.

To create the root node:

1. On the File menu, click New.
The New Document Specification dialog box appears.

2. Click the Blank Specification icon and click OK.
3. In the root node, click BlankSpecification.
4. On the Declaration tab, double-click the Value field in the Name row, type POReq and press ENTER.

5. Double-click the Value field in the Model row, click Open, and then press ENTER.

Continue to Add new records to the root node in the purchase order request specification.



Add new records to the root node in the purchase order
request specification

1. Right-click the POReq root node and click New Record.
2. Name this record Header and press ENTER.

3. Follow steps 1 and 2 to create and name five additional records under the POReq root node. These records are all child
records of the POReq root node. Name the records as follows:

o Employeelnfo
e BillTo

e ShipTo

® Item

e Total

Continue to Add new records to existing records in the purchase order request specification.



Add new records to existing records in the purchase order
request specification

1. Right-click the BillTo record and click New Record.
2. Name the record Address and press ENTER.

3. Follow steps 1 and 2 to create and name a child record Address for the parent record called ShipTo.

Continue to Add new fields to existing records in the purchase order request specification.



Add new fields to existing records in the purchase order
request specification

1

. Right-click the Header record and click New Field.

. Name this field Date and press ENTER.

. On the Declaration tab, double-click the Value field in the Data Type row, click Date, and then press ENTER.

. Right-click the Employeelnfo record and click New Field.

. Name this field EmpID and press ENTER.

. On the Declaration tab, double-click the Value field in the Data Type row, click String, and then press ENTER.

. On the Declaration tab, double-click the Value field in the Minimum Length row, type 1, and then press ENTER.

. On the Declaration tab, double-click the Value field in the Maximum Length row, type 60, and then press ENTER.

. Follow steps 4 through 8 to create fields for the records or child records listed in the following table. Each record contains
multiple fields.

You do not have to create the fields for ShipTo because parallel record names exist for BillTo and ShipTo. All records with
the same name contain the same record and field information. When you add fields to the BillTo/Address record, the
ShipTo/Address record is automatically updated with the same fields.

Parent record|Field name |Data type/Minimum lengthMaximum length
Employeelnfo |LastName String 1 30
FirstName String 1 30
BillTo/Address [Name String 1 60
Address1 String 1 55
Address?2 String 1 55
City String 2 30
State String 2 2
Zip String 3 15
Country String 2 3
Item Quantity Real(r4) |Not applicable Not applicable
Price Real(r4) |Not applicable Not applicable
Description  |String 1 80
UnitofMeasure|String 2 2
ExtendedPrice |Real(r4) [Not applicable Not applicable
Total LineltemTtl Real(r4) [Not applicable Not applicable
QtyTtl Real(r4) |Not applicable Not applicable
POTH Real(r4) |Not applicable Not applicable

Continue to Save the purchase order request specification.




Save the purchase order request specification

1. On the File menu, click Store to WebDAV.
The Store to WebDAV dialog box appears.

2. Verify that the Microsoft folder is open.
3. In the File name box, type POReq and click Save.

4. On the Tools menu, click Validate Instance.
The Validate Document Instance dialog box appears.

5. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\SampleData on the BizTalk Server installation
drive.

6. Click POReqAccept.xml and click Open.
Warnings or errors, if any, appear on the Warnings tab.

The purchase order request specification should appear similar to the following.

Click the illustration to enlarge or reduce.
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1. On the File menu, click Exit to close the BizTalk Editor console.

Continue to Using BizTalk Mapper.



Using BizTalk Mapper

In this procedure, you use BizTalk Mapper to create a map that transforms the data from a message that conforms to the
Commonlinvoice specification into data in a message that conforms to the PaymentSpec specification.

BizTalk Messaging Services uses a map within a channel to specify how data in a document of one format is transformed into a
document of a different format.

To use BizTalk Mapper to create the map, continue to Create the InvoiceToPayment map.
# Shortcut

To use the existing map, continue directly to Use existing InvoiceToPayment map.



Use existing InvoiceToPayment map

1. Copy InvoiceToPayment.xml from \Program Files\Microsoft BizTalk Server\Tutorial\DocSpecsandMaps on the
BizTalk Server installation drive.

2. Paste the file to \Program Files\Microsoft BizTalk Server\BizTalkServerRepository\Maps\Microsoft.

Continue to Module 3: Configuring BizTalk Messaging Services.



Create the InvoiceToPayment map

1. On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Mapper.

2. On the File menu, click New.

The Select Source Specification Type dialog box appears.
3. Click the WebDAV Files icon and click OK.

The Retrieve Source Specification dialog box appears.

4. Double-click the Microsoft folder.

5. Click CommonlInvoice.xml and click Open.
The Select Destination Specification Type dialog box appears.

6. Click the WebDAV Files icon and click OK.

7. Click PaymentSpec.xml and click Open.

Continue to Create links between fields.



Create links between fields

In the following procedure, you link fields from the source specification to fields in the destination specification.
To create links between fields:
1. In the Source Specification tree, expand the InvoiceHeader record to display the associated fields.
For more information, see Expand tree items.
2. In the Destination Specification tree, expand the PaymentHeader record to display the associated fields.
3. Drag the InvoiceHeader/Date field from the Source Specification tree to the PaymentHeader/Date field in the
Destination Specification tree. Follow steps 1 through 3 to create links between the fields listed in the following tables.

Source record/field |Destination record/field
InvoiceHeader/Number|PaymentHeader/PONumber

Seller/Address/Name Seller/Address/Name
Seller/Address/Address1 |Seller/Address/Address1
Seller/Address/Address2 (Seller/Address/Address?2
Seller/Address/City Seller/Address/City
Seller/Address/State Seller/Address/State
Seller/Address/PostalCode|Seller/Address/Zip
Seller/Address/Country (Seller/Address/Country

Seller/Contactinfo/ContactName |[Seller/Contactinfo/Name
Seller/Contactinfo/ContactNumber|Seller/Contactinfo/Number

Buyer/Address/Name Buyer/Address/Name
Buyer/Address/Address1 |Buyer/Address/Address1
Buyer/Address/Address2 |Buyer/Address/Address2
Buyer/Address/City Buyer/Address/City
Buyer/Address/State Buyer/Address/State
Buyer/Address/PostalCode|Buyer/Address/Zip
Buyer/Address/Country  |Buyer/Address/Country

Buyer/Contactinfo/ContactName |Buyer/Contactinfo/Name
Buyer/Contactinfo/ContactNumber|Buyer/Contactinfo/Number

Item/ItemHeader/Quantity Item/Quantity
Item/ItemHeader/Price Item/Price

Item/ItemDescription/Description|ltem/Description

InvoiceSummary/InvoiceTotal/Amount/PaymentSummary/Total

Continue to Use functoids to create links.



Use functoids to create links

In this procedure, you use a functoid to multiply the Quantity field by the Price field in the source specification, and place this
value in the ExtendedPrice field in the destination specification.

To use functoids to create links:

1.

5.

On the View menu, click Functoid Palette.
The Functiod Palette appears.

Click the Mathematical tab, drag the Multiplication functoid E to the mapping grid, and then close the Functoid
Palette.

. In the Source Specification tree, drag the Item/ItemHeader/Quantity field to the functoid.

In the Source Specification tree, drag the Item/ItemHeader/Price field to the functoid.

Drag the Multiplication functoid to the Item/ExtendedPrice field in the Destination Specification tree.

Continue to Compile the map.



Compile the map

1. On the Tools menu, click Compile Map.

2. In the lower pane, click the Output tab.

The information on the Output tab indicates that an XSL map has been created. Warnings or errors, if any, appear on the
Warnings tab.

Continue to Store the map to WebDAV.



Store the map to WebDAV

1. On the File menu, click Store to WebDAV.
The Store to WebDAV dialog box appears.

2. Double-click the Microsoft folder.

3. In the File name box, type InvoiceToPayment and click Save.

The map you create should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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1. On the File menu, click Exit to close the BizTalk Mapper console.

Continue to Module 2 Summary.



Module 2 Summary

In this module, you accomplished the following:

Created a specification. For more information, see Understanding Specifications.

Added new records and fields to a specification. For more information, see Add new fields to records.

Created a map. For more information, see Mapping Data.

Created links between fields in a map. For more information, see Creating Links.

Used functoids to mathematically manipulate values in a map. For more information, see Understanding Functoids.

Saved specifications and maps to the WebDAV repository. For more information, see Store specifications and Store maps.

The highlighted areas of the following diagram illustrate the steps you completed in this module.
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Continue to Module 3: Configuring BizTalk Messaging Services.

Related Topic

Creating Specifications and Mapping Data



Module 3: Configuring BizTalk Messaging Services

In this module, you learn how to use BizTalk Messaging Manager to configure organizations, channels, and messaging ports for
the seller and buyer systems. You also learn how to use BizTalk Server Administration to configure a File receive function.

Objectives

o Create document definitions. For more information, see Create and Manage Document Definitions.

Create organizations. For more information, see Create and Manage Organizations.

o Create messaging ports. For more information, see Create and Manage Messaging Ports and Integrating BizTalk Services.

Create channels. For more information, see Create and Manage Channels.
e Use a map in a channel to transform a document. For more information, see Mapping Data.

e Create receive function. For more information, see Receive Functions.
Continue to Configuring the Buyer System.
Related Topic

Using BizTalk Messaging Manager



Configuring the Buyer System

You use BizTalk Messaging Manager to create organizations that represent your trading partners.
To use BizTalk Messaging Manager to configure the buyer system, continue to Create the organizations for the buyer system.

= Shortcut

To use a script to configure the buyer system, continue directly to Configure the buyer system using a configuration script.



Configure the buyer system using a configuration script

This script configures the following:

e A source organization named ProElectron on Buyer on the buyer system.
e A destination organization named Bits,Bytes,Chips on Buyer on the buyer system.
e Four document definitions that reference specifications for CommonPO, Commonlinvoice, PaymentSpec, and POReq.

e A messaging port and channel that define the movement of a purchase order request from the buyer system to the seller
system by using an HTTP transport service to an ASP file on the seller system.

e A messaging port and channel that define the movement of an invoice that has been delivered to the buyer and transform it
into a payment document on the seller system.

¥ Caution

e |f you used BizTalk Messaging Manager and BizTalk Server Administration to configure the buyer system, do not run the
configuration script.

To run the script that configures BizTalk Messaging Services for the buyer system:

1. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Setup\MessagingConfigurationScript on the BizTalk
Server installation drive.

2. Double-click ConfigureBuyer.VBS.

A message box appears indicating success.

Continue to Configuring the Seller System.



Create the organizations for the buyer system

¥ Caution

e |f you used the configuration script, do not use BizTalk Messaging Manager and BizTalk Server Administration to configure
the buyer system. Continue to Configuring the Seller System.

1. On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Messaging
Manager.

2. If the BizTalk Messaging Manager dialog box appears, click Cancel.

3. On the File menu, point to New and click Organization.
The New Organization dialog box appears.

4. In the Organization name bo, type Bits,Bytes,Chips on Buyer and click OK.

5. Repeat steps 3 and 4, naming the new organization ProElectron on Buyer.

Continue to Create the document definitions for the buyer and seller systems.



Create the document definitions for the buyer and seller
systems

In this procedure, you create four document definitions that reference the document specifications, Commoninvoice, CommonPO,
PaymentSpec, and POReq. These document definitions are shared by the buyer and seller systems.

To create the document definitions:

1. On the File menu, point to New and click Document Definition.
The New Document Definition dialog box appears.

2. In the Document definition name box, type Purchase Order.

3. Select the Document specification check box and click the Browse button.
The Select a Document Specification from the WebDAV Repository dialog box appears.

4. Double-click the Microsoft folder.
5. Click CommonPO.xml and click Open.
6. Click OK to close the New Document Definition dialog box.

7. Repeat steps 1 through 6 to create a new document definition with the following variations:

o Name the new document definition Invoice.

e Click the Commonlnvoice.xml specification from WebDAV.
8. Repeat steps 1 through 6 to create a new document definition with the following variations:

e Name the new document definition Purchase Order Request.

o Click the POReq.xml specification from WebDAV.
9. Repeat steps 1 through 6 to create a new document definition with the following variations:

o Name the new document definition Payment.

e Click the PaymentSpec.xml specification from WebDAV.

Continue to Create a messaging port to Bits, Bytes, & Chips for the buyer system.



Create a messaging port to Bits, Bytes, & Chips for the buyer
system

In this procedure, you create a messaging port for the buyer system. A messaging port defines the destination for a document.

The messaging port that you create has as its destination organization "Bits,Bytes,Chips on Buyer." This port uses the HTTP
transport service to deliver documents to Bits, Bytes, & Chips.

To create the messaging port:
1. On the File menu, point to New, point to Messaging Port, and then click To an Organization.
The New Messaging Port Wizard opens.

2. In the Name box, type Port to Bits,Bytes,Chips via HTTP and click Next.

3. On the Destination Organization page, in the Organization area, click Browse.
The Select an Organization dialog box appears.

4. Click Bits,Bytes,Chips on Buyer and click OK.

5. In the Primary transport area, click Browse.
The Primary Transport dialog box appears.
6. In the Transport type list, click HTTP.
7. In the Address box, after the http:// prefix, type the name of your computer, followed by
/SubmitPO/SubmitProElectronPO.asp, click OK, and then click Next.
For example, http://Computer1/SubmitPO/SubmitProElectronPO.asp.
To find the name of your computer, complete the following steps:

a. On the Start menu, point to Settings and click Control Panel.
b. Double-click Administrative Tools.

c. Double-click Computer Management.

The Computer Management console appears.
d. On the Action menu, click Properties.

The Computer Management (Local) Properties dialog box appears.
e. Click the Network Identification tab.

The name of your computer appears in the Computer name field.

8. On the Envelope Information page, click Next.
9. On the Security Information page, verify that the Create a channel for this messaging port check box is selected.

10. In the Channel type list, click From an organization and click Finish.

The New Channel Wizard opens.

Continue to Create a channel from ProElectron for the buyer system.



Create a channel from ProElectron for the buyer system

In this procedure, you create a channel for the messaging port.

To create the channel:

1. On the General Information page, in the Name box, type Channel for POReq to PO and click Next.

2. On the Source Organization page, click Browse.
The Select an Organization dialog box appears.

3. Click ProElectron on Buyer, click OK, and then click Next.

4. On the Inbound Document page, to the right of the Inbound document definition name box, click Browse.
The Select a Document Definition dialog box appears.

5. Click Purchase Order Request, click OK, and then click Next.

6. On the Outbound Document page, to the right of the Outbound document definition name box, click Browse.
The Select a Document Definition dialog box appears.

7. Click Purchase Order and click OK.
8. Verify that the Map inbound document to outbound document check box is selected.

9. To the right of the Map reference box, click Browse.
The Select a Map from the WebDAV Repository dialog box appears.

10. Double-click the Microsoft folder.
11. Click POReqtoPO.xml, click Open, and then click Next.
12. On the Document Logging page, click Next.

13. On the Advanced Configuration page, click Finish.

Continue to Create a messaging port to Bits, Bytes & Chips within the buyer system.



Create a messaging port to Bits, Bytes, & Chips within the
buyer system

In this procedure, the messaging port sends documents within the buyer system by using the File transport service. The
documents are sent internally to the folder specified in the destination address.

To create the messaging port:
1. On the File menu, point to New, point to Messaging Port, and then click To an Organization.
The New Messaging Port Wizard opens.

2. In the Name box, type Port to Bits,Bytes,Chips via Local File and click Next.

3. On the Destination Organization page, in the Organization area, click Browse.
The Select an Organization dialog box appears.

4. Click ProElectron on Buyer and click OK.

5. In the Primary transport area, click Browse.
The Primary Transport dialog box appears.

6. In the Transport type list, click File.

7. In the Address box, after file://, type C:\TutorialFiles\Seller\payment%tracking_id%.xml. For example,
file://c\TutorialFiles\Seller\payment%tracking_id%.xml.

¥ Note

e For the File transport service, the default transport-component setting is to append new files to an existing file in the
specified directory. To create a new file with a unique name for each document instance, you must use the following
file path format:

file://C:\dir\file%tracking id%.xml

8. Click OK to close the Primary Transport dialog box and click Next.
9. On the Envelope Information page, click Next.
10. On the Security Information page, verify that the Create a channel for this messaging port check box is selected.

11. In the Channel type list, click From an organization and click Finish.

The New Channel Wizard opens.

Continue to Create a channel from Bits, Bytes, & Chips for the buyer system.



Create a channel from Bits, Bytes, & Chips for the buyer system

The channel that you create in this procedure processes invoices that are received from Bits, Bytes, & Chips and uses a map to
transform the invoice into a payment.

To create the channel:

1. On the General Information page, in the Name box, type Channel for Invoice To Payment and click Next.

2. On the Source Organization page, in the Organization area, click Browse.
The Select an Organization dialog box appears.

3. Click Bits,Bytes,Chips on Buyer, click OK, and then click Next.

4. On the Inbound Document page, to the right of the Inbound document definition name box, click Browse.
The Select a Document Definition dialog box appears.

5. Click Invoice, click OK, and then click Next.

6. On the Outbound Document page, to the right of the Outbound document definition name box, click Browse.
The Select a Document Definition dialog box appears.

7. Click Payment and click OK.
8. Verify that the Map inbound document to outbound document check box is selected.

9. To the right of the Map reference box, click Browse.
The Select a Map from the WebDAV Repository dialog box appears.

10. Double-click the Microsoft folder.

11. Click InvoicetoPayment.xml, click Open, and then click Next.
12. On the Document Logging page, click Next.

13. On the Advanced Configuration page, click Finish.

14. On the File menu, click Exit to close BizTalk Messaging Manager.

Continue to Create a File receive function for the buyer system.



Create a File receive function for the buyer system

In this procedure, you create a File receive function that retrieves the buyer’s purchase order request from a local file directory
and submits it to BizTalk Messaging Services.

The following illustration shows the relationship between the sending business application, the file system, and the receive
function.
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To create the File receive function:

1. On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Server
Administration.

2. Expand Microsoft BizTalk Server 2000, expand BizTalk Server Group, and then click Receive Functions.

3. On the Action menu, point to New and click File Receive Function.
The Add a File Receive Function dialog box appears.

4. In the Name box, type PORequest Receive Function at ProElectron.

5. In the Server on which the receive function will run box, click the name of a server in the BizTalk server group.
6. In the File types to poll for box, type *.xml.

7. In the Polling location box, type C:\TutorialFiles\Buyer.

8. Click the Advanced button.
The Advanced Receive Function Options dialog box appears.

9. In the Channel name list, click Channel for POReq to PO and click OK.
10. Click OK to close the Add a File Receive Function dialog box.

11. Close BizTalk Server Administration.

Continue to Configuring the Seller System.



Configuring the Seller System

You use BizTalk Messaging Manager to create organizations that represent your trading partners.

Continue to Create the organizations for the seller system.



Create the organizations for the seller system

1. On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Messaging
Manager.

2. If the BizTalk Messaging Manager dialog box appears, click Cancel.

3. On the File menu, point to New and click Organization.
The New Organization dialog box appears.

4. On the General tab, in the Organization name box, type Bits,Bytes,Chips on Seller and click OK.

5. Repeat steps 3 and 4, naming the new organization ProElectron on Seller and click OK.

Continue to Create a messaging port to Bits, Bytes, & Chips for the seller system.



Create a messaging port to Bits, Bytes, & Chips for the seller
system

In this procedure, you create a messaging port that defines the destination for a document. This messaging port sends documents
internally within the seller system using an application integration component (AIC) as the transport service.

An AIC typically serves as an integration point between BizTalk Server 2000 and a back-end application. In this scenario, the AIC
functions both as the integration point and as a hypothetical back-end application. The messaging port passes the purchase order
to the AIC. The AIC transforms the purchase order into an invoice and submits it to a channel in BizTalk Messaging Services on the
seller system.

The purchase order could also be transformed into an invoice by using a map in the channel, but for simplicity the AIC performs
this function in this scenario.

To create the messaging port:
1. On the File menu, point to New, point to Messaging Port, and then click To an Organization.
The New Messaging Port Wizard opens.

2. In the Name box, type Port to Bits,Bytes,Chips via AIC and click Next.

3. On the Destination Organization page, in the Organization area, click Browse.
The Select an Organization dialog box appears.

4. Click Bits,Bytes,Chips on Seller and click OK.

5. In the Primary transport area, click Browse.
The Primary Transport dialog box appears.

6. In the Transport type list, verify that Application Integration Component is selected and click Browse.
The Select a Component dialog box appears.

7. Click POToINVAIC ConvertPOTolnvoice and click OK.
8. Click OK to close the Primary Transport dialog box and click Next.
9. On the Envelope Information page, click Next.
10. On the Security Information page, verify that the Create a channel for this messaging port check box is selected.

11. In the Channel type list, click From an organization and click Finish.

The New Channel Wizard opens.

Continue to Create a channel from ProElectron for the seller system.



Create a channel from ProElectron for the seller system

In this procedure, you create a channel for the messaging port.

The channel that you create has as its source organization "ProElectron on Seller," which represents the buyer on the seller
system. This channel processes purchase orders that are received from ProElectron. Because both the inbound and the outbound
document definitions are identical, no map reference is required for this channel and no document transformation occurs.

To create the channel:

1. On the General Information page, in the Name box, type Channel for PO and click Next.

2. On the Source Organization page, in the Organization area, click Browse.
The Select an Organization dialog box appears.

3. Click ProElectron on Seller, click OK, and then click Next.

4. On the Inbound Document page, to the right of the Inbound document definition name box, click Browse.
The Select a Document Definition dialog box appears.

5. Click Purchase Order, click OK, and then click Next.

6. On the Outbound Document page, to the right of the Outbound document definition name box, click Browse.
The Select a Document Definition dialog box appears.

7. Click Purchase Order, click OK, and then click Next.
8. On the Document Logging page, click Next.

9. On the Advanced Configuration page, click Finish.

Continue to Create a messaging port to ProElectron for the seller system.



Create a messaging port to ProElectron for the seller system

The destination organization that you create for the messaging port is named "ProElectron on Seller," which represents the buyer
on the seller system. This messaging port sends documents from the seller system to the buyer system. This port uses the HTTP
transport service to deliver documents to the specified buyer address.

When this port is used, an invoice message is sent to an ASP page on the buyer system that then posts the invoice to a message
queue on the buyer system.

To create the messaging port:
1. On the File menu, point to New, point to Messaging Port, and then click To an Organization.
The New Messaging Port Wizard opens.

2. On the General Information page, in the Name box, type Port to ProElectron via HTTP and click Next.

3. On the Destination Organization page, in the Organization area, click Browse.
The Select an Organization dialog box appears.

4. Click ProElectron on Seller and click OK.

5. In the Primary transport area, click Browse.
The Primary Transport dialog box appears.
6. In the Transport type list, click HTTP.
7. In the Address box, after the http:// prefix, type the name of your computer, followed by
/InvoiceToQueue/DropinvoicetoMSMQ.asp, click OK, and then click Next.
For example, http://Computer1/InvoiceToQueue/DroplnvoicetoMSMQ.asp.
To find the name of your computer, complete the following steps:

a. On the Start menu, point to Settings and click Control Panel.
b. Double-click Administrative Tools.

c. Double-click Computer Management.

The Computer Management console appears.
d. On the Action menu, click Properties.

The Computer Management (Local) Properties dialog box appears.
e. Click the Network Identification tab.

The name of your computer appears in the Computer name field.

8. On the Envelope Information page, click Next.
9. On the Security Information page, verify that the Create a channel for this messaging port check box is selected.

10. In the Channel type list, click From an organization and click Finish.

The New Channel Wizard opens.

Continue to Create a channel from Bits, Bytes, & Chips for the seller system.



Create a channel from Bits, Bytes, & Chips for the seller system

The channel that you create in this procedure has as its source organization "Bits,Bytes,Chips on Seller.” This channel processes
invoices that are sent to ProElectron on the seller system according to the rules of the messaging port, Port to ProElectron via
HTTP.

To create the channel:

1.

10.

On the General Information page, in the Name box, type Channel for Invoice and click Next.

On the Source Organization page, in the Organization area, click Browse.

The Select an Organization dialog box appears.

. Click Bits,Bytes,Chips on Seller, click OK, and then click Next.

. On the Inbound Document page, to the right of the Inbound document definition name box, click Browse.

The Select a Document Definition dialog box appears.

. Click Invoice, click OK, and then click Next.

On the Outbound Document page, click Browse.
The Select a Document Definition dialog box appears.

Click Invoice, click OK, and then click Next.

. On the Document Logging page, click Next.

On the Advanced Configuration page, click Finish.

On the File menu, click Exit to close BizTalk Messaging Manager.

Continue to Module 3 Summary.



Module 3 Summary
In this module, you accomplished the following:

e Created document definitions. For more information, see Create and Manage Document Definitions.
e Created organizations. For more information, see Create and Manage Organizations.

e Created messaging ports. For more information, see Create and Manage Messaging Ports.

o Created channels. For more information, see Create and Manage Channels.

e Used a map in a channel to transform a document. For more information, see Mapping Data.

e Created a File receive function. For more information, see Receive Functions.

To view the document definitions, organizations, messaging ports, channels, and map that you created in this module, use the
Search Now button in the BizTalk Messaging Manager.

The highlighted areas of the following diagram illustrate the steps you completed in this module.
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Continue to Module 4: Completing the XLANG Schedule.

Related Topic

Using BizTalk Messaging Manager



Module 4: Completing the XLANG Schedule

In this module, you use BizTalk Orchestration Designer to implement a port by using BizTalk Messaging Services. You then
compile and run the completed XLANG schedule.

Objectives

e Add invoice and payment actions. For more information, see Add Shapes.
e Implement a port using BizTalk Messaging Services. For more information, see Using the BizTalk Messaging Shape.

e Compile and run the completed XLANG schedule. For more information, see Compiling XLANG Schedules
and Running XLANG Schedules.

To complete the XLANG schedule, continue to Add invoice and payment actions.

» Shortcut

To use the existing XLANG schedule, continue directly to Run the completed XLANG schedule.
Related Topic

Designing BizTalk Orchestrations



Add invoice and payment actions

In this procedure, you add an action that receives the invoice from the buyer and another action that sends the payment message
to the seller.

To create the actions:

1. On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Orchestration
Designer.

2. On the File menu, click Open.
The Open XLANG Schedule Drawing dialog box appears.

3. If you are using the existing Buyer1.skv file, in the Open XLANG Schedule Drawing dialog box, browse to \Program
Files\Microsoft BizTalk Server\Tutorial\Schedule\Solution on the BizTalk Server installation drive, click Buyer1.skv,
and then click Open.

If you created the Buyer1.skv file in Module 1, browse to \Program Files\Microsoft BizTalk
Server\Tutorial\Schedule\Lab on the BizTalk Server installation drive, click Buyer1.skv, and then click Open.

£ Note
There will be a blank drawing, in BizTalk Orchestration Designer, which you can close.

4. Highlight the connection between the Write PO Request to File action and the End action and press DELETE.
5. Move the End action down to allow room for two new action shapes.

6. On the Business Process page, drag the Action shape from the Flowchart stencil to the left side of the Separator bar.
Position the shape directly below the Write PO Request to File action.

7. Right-click the Action shape and click Properties.
The Action Properties dialog box appears.

8. In the Name box, type Receive Invoice and click OK.

9. On the Business Process page, drag the Action shape from the Flowchart stencil to the left side of the Separator bar.
Position the shape directly below the Receive Invoice action.

10. Right-click the Action shape and click Properties.
The Action Properties dialog box appears.

11. In the Name box, type Send Payment and click OK.
12. Connect the Write PO Request to File action to the Receive Invoice action.
13. Connect the Receive Invoice action to the Send Payment action.

14. Connect the Send Payment action to the End shape.

Continue to Bind the Message Queuing service to receive an invoice.



Bind the Message Queuing service to receive an invoice

The Receive Invoice action is bound to a message queuing service. When an invoice is dropped to the invoice message queue
that is defined by the service, it activates the Receive Invoice action.

To bind the message queuing service:

1. On the Business Process page, drag the Message Queuing shape from the Implementation stencil to the right side of
the Separator bar that divides the two sides of the drawing. Position the Message Queuing shape so that it is horizontally
aligned with the Receive Invoice action.

The Message Queuing Binding Wizard opens.

2. On the Welcome to the Message Queuing Binding Wizard page, verify that Create a new port is selected.
3. In the Create a new port box, type Receivelnvoice and click Next.

4. On the Static or Dynamic Queue Information page, verify that Static queue is selected and click Next.

5. On the Queue Information page, click Use a known queue for all instances.

6. In the Enter the queue name box, type .\private$\Receivelnvoice and click Next.

7. On the Advanced Port Properties page, click Finish.

Continue to Define message properties for the Receive Invoice service.



Define message properties for the Receive Invoice service

1. Select the Receive Invoice action and drag the control handle on the right of the Receive Invoice action to the
Receivelnvoice port.

The XML Communication Wizard opens.

2. On the Welcome to the XML Communication Wizard page, click Receive and click Next.
3. On the Message Information page, verify that Create a new message is selected.
4. In the Message name box, type Commonlinvoice and click Next.

5. On the XML Translation Information page, verify that Receive XML messages from the queue is selected and click
Next.

6. On the Message Type Information page, in the Message type box, type Commonlinvoice and click Next.

7. On the Message Specification Information page, click Finish.

Continue to Bind the BizTalk Messaging Services.



Bind the BizTalk Messaging Services

In this procedure, you bind a BizTalk Messaging Service to the XLANG schedule drawing and name the channel that is being used.

To bind the BizTalk Messaging Services:

1.

On the Business Process page, drag the BizTalk Messaging shape from the Implementation stencil to the right side of
the Separator bar that divides the two sides of the drawing. Position the BizTalk Messaging shape so that it is horizontally
aligned with the Send Payment action.

The BizTalk Messaging Binding Wizard opens.

. On the Welcome to the BizTalk Messaging Binding Wizard page, verify that Create a new port is selected.

In the Create a new port box, type SendPayment and click Next.

. On the Communication Direction page, verify that Send is selected and click Next.
. On the Static or Dynamic Channel Information page, verify that Static channel is selected.

. In the Enter the name of a known, pre-existing channel box, type Channel for Invoice To Payment and click Finish.

Note that Channel for Invoice To Payment was created in Module 3.

Continue to Define message properties for the BizTalk Messaging Services.



Define message properties for the BizTalk Messaging Services

1. Drag the control handle on the right of the Send Payment action to the SendPayment port.
The XML Communication Wizard opens.

2. On the Welcome to the XML Communication Wizard page, click Next.

3. On the Message Information page, click Add a reference to an existing message, click Commoninvoice, and then
click Next.

4. On the XML Translation Information page, verify that Send XML messages to the queue is selected and click Next.
5. On the Message Type Information page, click Next.

6. On the Message Specification Information page, click Finish.

Continue to Save the completed XLANG schedule drawing.



Save the completed XLANG schedule drawing

1. On the File menu, click Save As.
The Save XLANG Schedule Drawing As dialog box appears.

2. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab.

3. In the File name box, type Buyer2 and click Save.

Continue to Compile the completed XLANG schedule.



Compile the completed XLANG schedule

1. On the File menu, click Make XLANG Buyer2.skx.

The Save XLANG Schedule to dialog box appears.

2. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab on the BizTalk Server installation drive.

3. In the File name box, type Buyer2 and click Save.

Your completed XLANG schedule drawing should appear similar to the following illustration.

Click the illustration to enlarge or reduce.
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1. On the File menu, click Exit.

Continue to Run the completed XLANG schedule.
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Run the completed XLANG schedule

You have completed the configuration of a business-to-business automated procurement solution. You can now run the
application that activates the XLANG schedule.

In this procedure, you use an application that activates the XLANG schedule and delivers a purchase order request to the message
gueue that the schedule is monitoring.

To run the XLANG schedule:

1. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Solution on the BizTalk Server installation
drive.
2. Double-click ExecuteTutorial.exe. This application is used to activate the XLANG schedule by means of a moniker.
The ExecuteTutorial application opens.
3. Click Browse for Schedule.
# Shortcut

If you are using the existing XLANG schedule, browse to \Program Files\Microsoft BizTalk
Server\Tutorial\Schedule\Solution and continue to step 5.

1. If you created the Buyer2 XLANG schedule, browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab
on the BizTalk Server installation drive.

2. Click the Buyer2.skx XLANG schedule and click Open.

3. Click Browse for Data File and browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\SampleData
on the BizTalk Server installation drive.

4. Click POReqAccept.xml and click Open.

5. Click Start XLANG Schedule.

Because its total is less than $1000, the purchase order request is approved. A message box appears, notifying you that the
application passed data to the XLANG Scheduler Engine. At this point, the application is finished. A second message box
notifies you that the purchase order request has been approved. Click OK to close the dialog boxes.

6. Click End to close the ExecuteTutorial application.

7. Browse to C:\TutorialFiles\Seller.

You see the payment file. The file name is PaymentXXXX.xml, where XXXX is representative of a unique set of numbers.
Double-click the file to open it in Microsoft Internet Explorer.

You have submitted a purchase order request. The purchase order request was approved and ended in a payment message being
posted to the seller system.

Continue to Module 4 Summary.



Module 4 Summary

In this module, you accomplished the following:

e Added invoice and payment actions. For more information, see Connect Shapes.

o Implemented a messaging port using BizTalk Messaging Services. For more information about implementing a messaging
port using BizTalk Messaging Services, see Using the BizTalk Messaging Shape.

e Compiled and ran the completed XLANG schedule. For more information, see Compiling XLANG Schedules
and Running XLANG Schedules.

The highlighted areas of the following diagram illustrate the steps you completed in this module.
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Tutorial Summary

In this tutorial you configured Microsoft BizTalk Server 2000 to establish and run a business-to-business automated procurement
process.

The following illustration shows the flow of data through BizTalk Server while running the Buyer2 XLANG schedule at the end of
Module 4.
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You learned how BizTalk Server components and services work together to integrate loosely coupled, long-running business
processes, both within and between businesses.

You also learned how to:

e Use BizTalk Orchestration Designer to model business processes by creating an XLANG schedule drawing.

e Use BizTalk Messaging Manager to create organizations, channels, messaging ports, and document definitions.

e Use BizTalk Editor to create specifications.

e Use BizTalk Mapper to create maps.

e Compile and run an XLANG schedule.

You have successfully completed the tutorial. For detailed information about creating the auxiliary components used in this
tutorial, go to Appendix: Creating Auxiliary Components.



Appendix: Creating Auxiliary Components

In this appendix, you learn how to create auxiliary components that work in conjunction with Microsoft BizTalk Server 2000 to
process data. Each component and its role and relationship in the process are described in detail.

Specifically, you create:

e An application on the buyer system that activates an XLANG schedule and sends a purchase order request to a message
gueue that is bound to the XLANG schedule that controls the flow of messages through the buyer system.

e A Windows Script Component (WSC) on the buyer system that accepts the approval or denial status for a purchase order
request from the XLANG schedule. If approved, the WSC displays an approval message and writes the purchase order
request to a local file directory, where the BizTalk Messaging Services for the buyer system retrieves it. If denied, the WSC
displays a denial message and the schedule ends.

e An application integration component (AIC) on the seller system that generates an invoice based on the data in the purchase
order from the buyer.

® An ASP file on the buyer system that submits a purchase order to BizTalk Server.

e An ASP file on the seller system that delivers an invoice to a message queue.

Continue to Creating the Application.



Creating the Application

In this topic, you will create an application that activates an XLANG schedule and then drops a PO request to a queue. You use this
application to test the implementation of the XLANG schedule and the configuration of BizTalk Messaging Manager.

To complete the lab, modify the code in the sample project. You will focus on the code that is specific to activating the XLANG
schedule and to dropping a message into a queue. Ancillary code is provided for you.

Each step corresponds to a segment of code. Look for comment blocks similar to the following example:

L0 I T T T T T T T T T T T T T T T T T T T T O O L O O O A

'To Do: Step A

(LT T T T T T T T T T T T T T T T T T T T T T O O O L O O O A

Following this code are lines that have question marks (?) indicating placeholders where you must make a change. Replace the
question marks with the proper code to complete the lab. For example:

Private g MSMTxDisp As ?

should be changed to:

Private g MSMTxDisp As MSMQ.MSMQTransactionDispenser
£ Note

e These lines of code have been commented out. Be sure to remove the comment mark at the beginning of the lines to which
you make changes. The steps are not necessarily in order in the code window.

Continue to Open the application.



Open the application

Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab on the BizTalk Server installation directory.

Double-click ExecuteTutorial.vbp.

Continue to Add the required references to the application.



Add the required references to the application

In this procedure, you enable the application to implement a number of dynamic link libraries (DLLs) required to use Message
Queuing, XML, and the scripting run time.

1. On the Project menu, click References.

2. Select Microsoft Message Queue 2.0 Object Library.
The full path for this type library is \WINNT\System32\msxml2.dIl.
3. Select Microsoft Scripting Runtime.
The full path for this DLL is \WINNT\System32\Scrun.dll.
4. Select Microsoft XML, v 3.0.
The full path for this DLL is \WINNT\System32\msxml3.dIl.
5. Click OK.

Continue to Define and initialize the Message Queue objects.



Define and initialize the Message Queue objects

In this procedure, you add the code to use the chosen type libraries. The lettered steps in the following list correspond to the
lettered steps in the code provided.

1. In the Project window, expand Forms, and then click Form1 (ExecuteTutorial.frm).
2. On the View menu, click Code.

3. In the General Declarations section at step A in the code, create the Message Queue objects as shown in the following
example:

Private g MSMTxDisp As MSMQ.MSMQTransactionDispenser
Private g MSMQQueue As MSMQ.MSMQQueue
Private g MSMQInfo As MSMQ.MSMQQueueInfo

4. In the Form_Load event section at Step B in the code, initialize the Message Queue objects as shown in the following
example.

Set g MSMQInfo = CreateObject ("MSMQ.MSMQOQueueInfo")
Set g MSMTxDisp = CreateObject ("MSMQ.MSMQTransactionDispenser")

Continue to Add code to place data on a queue.



Add code to place data on a queue

In this procedure, you add a new subroutine called ExecuteMSMQ. This routine is called by the cmdRunSked_Click event. You
add the code to call this subroutine in the following procedure.

e Place the following code at the end of the code window in your project at step C:

Public Sub ExecuteMSMQ (ByVal strQueuePath As String, DataToQueue As String)
Dim QueueMsg As New MSMQMessage

Dim strData As String
Dim fSend As Boolean
Dim txt As TextStream
Dim mybyte () As Byte

g MSMQInfo.FormatName = strQueuePath
Set g MSMQQueue = g MSMQInfo.Open (MQ SEND ACCESS, MQ DENY NONE)
mybyte = StrConv (DataToQueue, vbFromUnicode)

QueueMsg.Body = DataToQueue
Set MSMQTx = g MSMTxDisp.BeginTransaction
QueueMsg.send g MSMQQueue, MSMQTx

MSMQTx .Commit

Set QueueMsg = Nothing
Set MSMQTx = Nothing

End Sub

Continue to Add code to activate the XLANG schedule and call ExecuteMSMQ.



Add code to activate the XLANG schedule and call
ExecuteMSMQ

In this procedure, you will add code to the cmdRunSked_Click event that activates the XLANG schedule and calls code that sends
a message to a queue.

1. In the cmdRunSked_Click event section at step D of the code, call ExecuteMSMQ, as shown in the following code:

ExecuteMSMQ "DIRECT=0S:.\private$\ReceivePoReq", objfs.OpenTextFile (txtData.Text, ForReading) .ReadAll

2. In the emdRunSked_Click event section at step E of the code, call GetObject to instantiate the XLANG schedule by
moniker, as shown in the following code:

Set SendPAQ = GetObject (txtSked.Text)

Continue to Save and compile the application.



Save and compile the application

In this procedure, you save and compile the application.

1. On the File menu, click Save Project.
2. On the File menu, click Make ExecuteTutorial.exe.

3. In the Make Project dialog box, browse to the folder \Program Files\Microsoft BizTalk Server\Tutorial\Schedule\Lab
on the BizTalk Server installation directory and click OK.

You can now run the application to execute the buyer schedule in Modules 1 and 4.

Continue to Creating the Windows Script Component.



Creating the Windows Script Component

In this topic, you create a Windows Script Component (WSC) that is bound to the XLANG schedule. The purpose of the WSC is to
display a message box with approval or denial status of the purchase order request, and to optionally write the purchase order
request to a local file if it is approved.

Continue to Add script to register the component.



Add script to register the component

In this procedure, you add script that allows the component to be registered to the file.

1. On the Start menu, point to Programs, point to Accessories, and then click Notepad.

2. Add the following script:

<?xml version="1.0"?>

<component>

<?component error="true" debug="true"?>

<registration
description="PORequestApproval"
progid="BTSTutorial.PORequestApproval"
version="1.00"
classid="{2938621b-40fc-48e2-827c-bed74e21a538}"

>

</registration>

Because you are using the same class ID as the preconfigured component, the old component is overwritten in the registry.

Continue to Add script to implement the methods.



Add script to implement the methods

This component exposes three methods. The first method sends an approval status in the form of a message box that is displayed
to the user. The second method sends a denial status, also in the form of a message box that is displayed to the user. The decision
as to which method is called is dictated by the decision rule in the XLANG schedule drawing. The last method writes the purchase
order to a local file if the purchase order request has been approved.

1. Add the three method signatures to the end of the file:

<public>
<method name="SendApproval">
<PARAMETER name="Document"/>
</method>
<method name="SendDenial">
<PARAMETER name="Document"/>
</method>
<method name="WriteToFile">
<PARAMETER name="Document"/>
<PARAMETER name="FileName"/>
</method>
</public>

2. Add the script that implements the methods to the end of the file:

<implements type="Behavior" id="Behavior"/>

<script language="VBScript">
<! [CDATA[

function SendApproval (Document)
MsgBox "Scheduler Engine Accepted document :" + vbcrlf + + vbcrlf + Document, 0, "Document Approval Re
ceived"

end function

function SendDenial (Document)
MsgBox "Scheduler Engine Denied document :" + vbcrlf + + vbcrlf + Document, 0, "Document Denied"

end function

function WriteToFile (Document, FileName)

dim objFileSys, strTimeNow

if FileName = "" then
FileName = "c:\TutorialFiles\Buyer\POReg*.xml"

end if

'Generate a Unique Number used to generate unique files using a mask

strTimeNow = left (Replace (CStr (FormatDateTime (Now (), 3)),":",""), 6)

'Create File System Object
Set objFileSys = CreateObject ("Scripting.FileSystemObject")

'Create the Specified file, write the document data and close
Set filestream = objFileSys.CreateTextFile (Replace (FileName, "*", strTimeNow), False)
filestream.writeline Document
filestream.close

end function

11>

</script>



</component>

3. On the File menu, click Save As.
The Save As dialog box appears.

4. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POReqApproval\Lab on the BizTalk
Server installation drive.

5. In the File name box, type PoRequestApproval.wsc.
6. In the Save as type box, click All Files and click Save.
7. Close Notepad.

8. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POReqApproval\Lab on the BizTalk
Server installation drive.

9. Right-click PoRequestApproval.wsc and click Register.

This component can be substituted for the preconfigured WSC used in Module 1. To use this component, you must remove the
existing WSC binding from the schedule and then create a new WSC binding that points to your component.

Continue to Delete the WSC component.



Delete the WSC component

In this procedure, you delete the WSC component from the Buyer2 XLANG schedule drawing. You can rebind the component you
have created.

1.

On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Orchestration
Designer.

To use the drawing created in Module 4, open the Buyer2.skv file located at \Program Files\Microsoft BizTalk
Server\Tutorial\Schedule\Lab on the BizTalk Server installation drive.

To use the existing Buyer2 drawing, open the Buyer2.skv file located at \Program Files\Microsoft BizTalk
Server\Tutorial\Schedule\Solution on the BizTalk Server installation drive.

. Click the Script Component shape and press DELETE.

. Click the Data tab.

5. Delete the SendApproval, SendDenial, and WritetoFile messages.

You are now ready to use your WSC component in the schedule. Do the following:

1.

Implement a port to Buyer2.skv by using your WSC component. For an example of how to do this,
see Implement a port by using a script component. However, use your component instead of the component in the
procedure.

Define the method communication for the port implementation. For an example of how to do this,
see Define message properties for the script component.

. Define the data flow for the port. For an example of how to do this, see Define the data flow.
. Save the XLANG file. For an example of how to do this, see Save the XLANG schedule drawing.

. To test your component, run the ExecuteTutorial application located at \Program Files\Microsoft BizTalk

Server\Tutorial\Schedule\Solution on the BizTalk Server installation drive.

Continue to Creating the Application Integration Component (AIC).



Creating the Application Integration Component (AIC)

In this topic, you create a new application integration component called POtoINVAIC that converts a purchase order document
into an invoice document using the MSXML DOM.

Continue to Create an ActiveX DLL project for the AIC.



Create an ActiveX DLL project for the AIC

1. Start Microsoft Visual Basic 6.0.

2. In the New Project dialog box, click the New tab, click ActiveX DLL, and then click Open.
This creates a new project for your component, called Project 1.

3. To rename both the project and the control to something more meaningful, in the project tree window, click Project1. In the
properties window, change the (Name) property to POtolnvAIC.

4. In the project tree window, click Class1(Class1). In the properties window, change the (Name) property to
ConvertPOtolnvoice.

Continue to Add the required references for the AIC.



Add the required references for the AIC

In this procedure you enable the component to implement a number of interfaces required by BizTalk Server 2000.

1. On the Project menu, click References.

2. Click Microsoft BizTalk Server Application Interface Components 1.0 Type Library.
The full path for this type library is \Program Files\Microsoft BizTalk Server\btscomplib.tlb.
3. Select Microsoft BizTalk Server Interchange 1.0 Type Library.
The full path for this type library is \Program Files\Microsoft BizTalk Server\cisapi.tlb.
4. Select Microsoft Scripting Runtime.

The full path for this DLL is \WINNT\System32\Scrun.dll. Use this library to create a file system object and open a text
stream that is used to write a purchase order to disk.

5. Select Microsoft XML, v 3.0.
The full path for this DLL is \WINNT\System32\msxml3.dIl.

6. Click OK.

Continue to Implement the required interface.



Implement the required interface

For BizTalk Server to recognize a component as an AlC, it must implement one of two interfaces. For the purposes of this tutorial,
you implement the IBTSApplIntegration interface.

1. In the Project window, click the ConvertPOtolnvoice class module.
2. On the View menu, click Code.

3. Add the following line of code at the top of the code window to ensure that all variables are explicitly declared to minimize
simple errors:

Option Explicit
4. Implement the required interface by adding the following line of code after the Option Explicit statement:
Implements IBTSAppIntegration

Continue to Define and initialize the class objects.



Define and initialize the class objects

In this procedure, you add code to define the MSXML class objects to create the XML files using the DOM. You will create a string
variable that points to the project style sheet that converts a purchase order into an invoice.

1. Place the following code beneath the Implements IBTSApplintegration statement:

'Class Object Defines

Private m DOMCommonPO As MSXMLZ2.DOMDocument

Private m DOMStylesheet As MSXMLZ2.DOMDocument
Private m objSubmit As BTSInterchangeLib.Interchange

'Embedded Project Stylesheet to Convert CommonPO to CommonInvoice

Private m strStylesheet As String

2. Add the following code, to initialize the XML DOM objects that will convert the purchase order to an invoice, as well as the
Interchange object that submits the final invoice document to BizTalk Server:

Private Sub Class Initialize()
'Create DOM/Interchange Objects
Set m DOMCommonPO = New MSXMLZ2.DOMDocument
Set m DOMStylesheet = New MSXMLZ2.DOMDocument
Set m objSubmit = New BTSInterchangeLib.Interchange

'Configure DOM Objects to be Synchronous
m_ DOMCommonPO.async = False

m DOMStylesheet.async = False

'Fill Stylesheet Embedded String
m strStylesheet = m strStylesheet + ""

End Sub

Continue to Implement the interface method.



Implement the interface method

The ProcessMessage method of the IBTSAppIntegration interface takes an incoming XML common purchase order document
transmitted from BizTalk Server and performs a translation on the data to convert it into an XML common invoice document. The
common invoice document is then submitted back to BizTalk Server. The intent is to simulate a back end system that receives
purchase orders and eventually returns an invoice for those purchase orders.

1. Add the function definition and dimension variables, as in the following code:

Private Function IBTSAppIntegration ProcessMessage( _
ByVal bstrDocument As String) As String
Dim bstrInvoiceDocument As String
Dim objScripting As New Scripting.FileSystemObject
'Initialize ProcessMessage to null

IBTSApplIntegration ProcessMessage = ""

2. Add the code to load the received data into a DOM object and validate that it is in the proper format by adding the following
code beneath the IBTSAppIntegration_ProcessMessage statement:

m_DOMCommonPO. loadXML bstrDocument

If m DOMCommonPO.parseError.errorCode <> 0 Then 'The data was not valid XML
'Raised errors are not caught in the component, and will be sent back to 'BizTalk Server
Err.Raise m DOMCommonPO.parseError.errorCode, "AICSample.ConvertPOToInvoice Component"

"The provided document was not valid XML and could not be processed because:" +
vbCrLf + vbCrLf + m DOMCommonPO.parseError.reason + vbCrLf + " on line: " +
CStr (m_DOMCommonPO.parseError.Line) + vbCrLf + "at position: " +
CStr (m_DOMCommonPO.parseError.linepos)

End If

3. Add code to use the resource file that contains XSL code that converts a purchase order to an invoice by adding the
following code beneath the End If statement:

If m strStylesheet = "" Then
m strStylesheet = StrConv(LoadResData (101, "CUSTOM"), vbUnicode)

End If
m DOMStylesheet.loadXML m strStylesheet

bstrInvoiceDocument = m DOMCommonPO.transformNode (m DOMStylesheet)

If bstrInvoiceDocument = "" Then ' Mapping Failed Raise an Error
Err.Raise vbObjectError + 100, "AICSample.ConvertPOToInvoice Component",
"The provided CommonPO document could not be translated into a Common Invoice " +
"as the map produced blank output.”
End If

4. Add code to submit the invoice document to BizTalk Messaging Services by adding the following code beneath the End If
statement:

IBTSAppIntegration ProcessMessage = m objSubmit.Submit (BIZTALK OPENNESS TYPE NOTOPEN, bstrInvoiceDocument,

, , "Bits,Bytes,Chips on Seller", , "ProElectron on Seller")

End Function

The submit call returns the submission ID, which in this case is not used.

Continue to Terminate the class objects.



Terminate the class objects

To ensure that all objects are released from memory when the class terminates, add this code to the end of your project:

Private Sub Class Terminate ()
Set m DOMCommonPO = Nothing
Set m DOMStylesheet = Nothing
Set m objSubmit = Nothing
End Sub

Continue to Create the resource file.



Create the resource file

In this procedure, you add the resource file that contains the XSL for transforming a purchase order into an invoice.

1.

6.

On the Add-Ins menu, click Add-In Manager.
The Add-In Manager dialog box appears.

Click VB 6 Resource Editor.

. In the Load Behavoir area, click Loaded/Unloaded to load the resource editor, click Load on Startup, and then click OK.

On the Tools menu, click Resource Editor.

. Click the Add Custom Resource icon on the tool bar.

The Open a Custom Resource dialog box appears.

Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POtolnvoice\Lab, click POtoINVAIC.txt,
and then click Open.

¥ Caution

e Make sure that the ID of your resource is 101. By default, the first resource you create will has an ID of 101, but this number

4.

increments by one if you change the resource. To change the resource ID to 101, right-click the resource ID and click
Properties. In the ID box, type 101.

. Click the Save icon.

The Save Resource File As dialog box appears.

. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POtolnvoice\Lab.

. In the File name box, type POtoIlnvAICLab.RES and click Save.

Close the Resource Editor.

Continue to Build the component and set binary compatibility.



Build the component and set binary compatibility

Since you are creating a new component, you must build the component at this point, and then set the project properties for
binary compatibility with the newly created DLL. Binary compatibility ensures that each time you compile the DLL you do not
generate a new globally unique identifier (GUID) for the object.

1

10.

11.

12.

13

Con

. On the File menu, click Save Project As.
The Save File As dialog box appears.

Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POTolnvoice\Lab on the BizTalk Server
installation directory.

. In the File name box, type ConvertPOtolnvoice.cls and click Save.
The Save Project As dialog box appears.

. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POTolnvoice\Lab on the BizTalk Server
installation directory.

. In the File name box, type POTolnvAIlCLab and click Save.

. On the File menu, click Make POTolnvAICLab.dll.
The Make Project dialog box appears.

. Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POtolnvoice\Lab on the BizTalk Server
installation directory and click OK.

On the Project menu, click POTolnvAICLab Properties.
. Click the Component tab.
Click Binary Compatibility.

Click Browse ([..]) and browse to \Program Files\Microsoft BizTalk Server\Tutorial\POtolnvoice\Lab on the BizTalk
Server installation drive.

Click POTolnvAlCLab.dll and click Open.

. Click OK.

tinue to Register the AIC.



Register the AIC

In this procedure, you register the AIC so that it can be recognized by BizTalk Server. BizTalk Server looks at the list of registered
COM components and then queries those components to determine which of these implement either the IBTSApplntegration
interface or the IPipelineComponent interface. All components that meet this criteria are displayed in a list of components in
BizTalk Messaging Manager.

1.

10.

11.

12.

13.

14.

15.

16.

On the Start menu, point to Settings and click Control Panel.

Double-click Administrative Tools.

. Double-click Component Services.

The Component Services console appears.

. In the console tree, expand Component Services, Computers, My Computer, and then click COM+ Applications.

Right-click COM+ Applications, point to New, and then click Application.
The COM Application Install Wizard opens.

On the Welcome to the COM Application Install Wizard page, click Next.

. On the Install or Create a New Application page, click Create an empty application.

In the Enter a name for the new application box, type POTolnvAlCLab.

. In the Activation type area, click Server application and click Next.

In the Account area, click Interactive User-the current logged on user and click Next.

¥ Note

e The current logged on user must be a member of the BizTalk Server Administrators group and must remain logged on
while running this scenario.

Click Finish.
In the console tree, expand COM+ Applications and expand the new package you created, called POTolnvAICLab.
Click Components.

Browse to \Program Files\Microsoft BizTalk Server\Tutorial\Components\POtolnvoice\Lab on the BizTalk Server
installation drive.

Drag the POTolnvAICLab.dll to the Components folder in Component Services.

Close Component Services.

You can now reconfigure the port to use the new AIC, using the following steps:

1.

2.

3.

4.

5.

Open BizTalk Messaging Manager.

In the Search area, click Messaging ports and click Search now.

In the Messaging port name list, double-click Port to Bits,Bytes,Chips via AIC.
On the General Information page, click Next.

On the Destination Organization page, in the Primary transport area, click Browse.



The Primary Transport dialog box appears.

. Click Browse.

. In the Available Components list, click POTolnvAICLab ConvertPOtolnvoice and click OK.

. Click OK to close the Primary Transport dialog box, and then click Finish.

. Test your component by running the ExecuteTutorial application located at \Program Files\Microsoft BizTalk
Server\Tutorial\Schedule\Solution on the BizTalk Server installation drive.



BizTalk Server 2000 Administration

BizTalk Server 2000 administration is divided into the following parts:

Installing BizTalk Server 2000

This section provides information about installing Microsoft BizTalk Server 2000. The information includes guidelines for
hardware and software requirements, and instructions for complete, tools, and custom installations. For more information about
installing Microsoft BizTalk Server 2000, see Installing BizTalk Server 2000.

Understanding Security

This section covers how businesses can securely exchange data with trading partners when they use BizTalk Server 2000. BizTalk
Server takes advantage of the security features included in Microsoft Windows 2000 and Microsoft SQL Server. For more
information about security and BizTalk Server 2000, see Understanding Security.

Enhancing Performance and Scalability

The section provides information about enhancing performance of BizTalk Server and creating scalable solutions. Issues and
guidelines covered in this section include identifying potential bottlenecks, addressing latency, and managing databases. For more
information about creating a scalable, high-performance solution, see Enhancing Performance and Scalability.

Administering Servers and Applications

This section covers how to administer servers and XLANG-related applications. Topics covered in this section include how to
centrally configure and manage servers in multiple groups, configuring and managing receive functions, managing the Shared
Queue, and managing the COM+ applications that host XLANG schedules. For more information about administering servers and
applications, see Administering Servers and Applications.

Tracking Documents

This section provides information about how to track interchanges and documents processed by BizTalk Server 2000. Topics
covered in this section include how to create queries and advanced queries, how to save interchange, document, and custom-
search data, and understanding interchange record, document record, and receipt results. For more information about tracking
documents, see Tracking Documents.

¥ Note

e The file path to open various Microsoft Windows 2000 services and tools, such as Component Services or Administrative
Tools, is different depending on whether you are using a computer that is operating on Windows 2000 Server or
Windows 2000 Professional. For more information, see Open Component Services.

In Microsoft BizTalk Server 2000 Help, the paths to these services and tools have been documented based on a
Windows 2000 Server installation. If you are using Windows 2000 Professional, refer to Windows 2000 Professional Help
for more information about how to open the service or tool that you are interested in using.

Related Topic

BizTalk Server Administration Model



Installing BizTalk Server 2000

Welcome to the Microsoft® BizTalk™ Server 2000 installation guide. It provides guidelines for hardware and software
requirements, and complete instructions for the following installation options:

e Complete Installation. Enables you to perform a complete installation of BizTalk Server 2000 that includes all BizTalk
services and tools.

e Tools Installation. Enables you to perform a complete installation of the BizTalk Server 2000 tools, including BizTalk
Orchestration Designer, BizTalk Document Tracking, BizTalk Editor, and BizTalk Mapper. The BizTalk Server 2000 parser,
serializer, correlation, and run-time binaries are not installed.

e Custom Installation. Enables you to perform a custom installation that includes any combination of BizTalk Server 2000
tools and services.

This guide includes the following topics:

e Hardware and Software Requirements

e |[nstallation Instructions



Hardware and Software Requirements

This section includes information about minimum hardware requirements and configuration options to install Microsoft BizTalk
Server 2000. It also includes installation instructions for the prerequisite software needed for BizTalk Server 2000.

The following topics are covered in this section:

® Minimum Hardware Requirements

o Recommended Configuration to Optimize Performance for Document Messaging

Software Requirements

Windows 2000 Prerequisites

Installing SQL Server 7.0 or SQL Server 2000

Installing Visio 2000 SR-1A



Minimum Hardware Requirements

The minimum hardware requirements for a basic installation of Microsoft BizTalk Server 2000 include:

e An Intel® Pentium 300 processor.
e 128 megabytes (MB) of RAM.

e A 6-gigabyte (GB) hard disk.

e A CD-ROM drive.

e A network adapter card.

e AVGA or Super VGA monitor.

e A Microsoft Mouse or compatible pointing device.



Recommended Configuration to Optimize Performance for
Document Messaging

The following are guidelines to help you achieve optimal performance with BizTalk Server 2000:

e Build a three-computer configuration. In a three-computer configuration, install BizTalk Server 2000 on one computer,
install the Tracking database on a second computer, and install the BizTalk Messaging Management and Shared Queue
databases on a third computer.

e For a configuration in which a single server is performing all processing and receiving functions, configure two BizTalk
Server 2000 servers, one dedicated to processing and the other dedicated to receiving.

o |Install the Tracking database on a computer with multiple physical hard disks. The optimal configuration includes four SCSI
[l hard disks and a SCSI Il controller. The first hard disk is dedicated to document-tracking storage. The second hard disk is
dedicated to the Microsoft Windows® 2000 system page file. The third hard disk is dedicated to the Tracking transaction
log. The fourth hard disk is dedicated to the Distributed Transaction Coordinator (DTC) log.

e Create multiple instances of receive functions to monitor multiple receive locations for documents that are to be processed.
To balance the load of documents across several computers, locate the receive functions on separate computers. Each
monitoring location must be unique and must have a separate receive function. To avoid overloading any individual receive
function, the business application that sends documents must evenly distribute the documents to all the monitoring
locations.

¢ Important

e For more information about performance enhancements to BizTalk Server, see Enhancing Performance and Scalability.



Software Requirements

The following table lists the software that must be installed to run Microsoft BizTalk Server 2000.

Complete installation

Tools installation

Custom installation

Microsoft Windows 2000 Server, Microsof
t Windows 2000 Advanced Server, or Micr
osoft Windows 2000 Professional with the
NTFS file system and Service Pack 1

Microsoft Windows 2000 Server, Microsof
t Windows 2000 Advanced Server, or Micr
osoft Windows 2000 Professional with the
NTFS file system and Service Pack 1

Microsoft Windows 2000 Server, Microsof
t Windows 2000 Advanced Server, or Micr
osoft Windows 2000 Professional with the
NTFS file system and Service Pack 1

Microsoft Internet Explorer 5 or later

Microsoft Internet Explorer 5 or later

Microsoft Internet Explorer 5 or later

Microsoft Visio® 2000 SR-1A or later (req
uired to use BizTalk Orchestration Designe

r)

Microsoft Visio 2000 SR-1A or later (requi
red to use BizTalk Orchestration Designer)

Microsoft Visio 2000 SR-1A or later (requi
red to use BizTalk Orchestration Designer)

Microsoft SQL Server™ 7.0 and SQL Serve
r Service Pack 2 (SP2) or SQL Server 2000

Microsoft SQL Server 7.0 and SQL Server
Service Pack 2 (SP2)* or SQL Server 2000

¥ Note

e BizTalk Messaging Manager will not
run unless the World Wide Web Pub
lishing Service is running.

¥ Note

e BizTalk Messaging Manager will not
run unless the World Wide Web Pub
lishing Service is running.

¥ Note

e BizTalk Messaging Manager will not
run unless the World Wide Web Publ
ishing Service is running.

*Microsoft SQL Server is required for a custom installation only if you install the core BizTalk Services. It is not required for a tools

installation.




Windows 2000 Prerequisites

Microsoft Windows 2000 Server, Microsoft Windows 2000 Advanced Server, and Microsoft Windows 2000 Professional with
Service Pack 1 are the recommended platforms for all Microsoft BizTalk Server 2000 installations. Because BizTalk Server 2000
has been thoroughly tested on Windows 2000 with Service Pack 1, this installation guide includes detailed information regarding
the necessary configuration of Windows 2000 Server, Windows 2000 Advanced Server, and Windows 2000 Professional in
combination with BizTalk Server. After installing Windows 2000 Server, Advanced Server, or Professional with Service Pack 1, you
must add a Windows 2000 user account to the Administrators group before you install any software. For more information,

see Add a user account to the Administrators group. You must also install Message Queuing. For more information,

see Install Message Queuing. If your installation does not include Service Pack 1, you must install it. For more information,

see Install Windows 2000 Service Pack 1.

The following topics are covered in this section:

Install Windows 2000 Server, Advanced Server, or Professional with Service Pack 1

Install Windows 2000 Service Pack 1

Install Message Queuing

Install Internet Information Services (IIS)

Configure IS settings for BizTalk Server 2000

Setting Up User Accounts



Install Windows 2000 Server, Advanced Server, or Professional
with Service Pack 1

If Windows 2000 Server, Advanced Server, or Professional is installed on your computer, be sure that you meet the requirements
listed in step 2 below.

1.

Insert the Windows 2000 Server, Advanced Server, or Professional with Service Pack 1 compact disc into the appropriate
drive.

If you do not have a version of Windows 2000 that includes Service Pack 1, first install Windows 2000 and then install
Service Pack 1 separately.

Run the Windows 2000 Server, Advanced Server, or Professional with Service Pack 1 Setup program and follow the online
instructions.

Observe the following requirements:

e Use only alphanumeric characters in the computer name because Microsoft SQL Server supports a limited character
set in server computer names.

® Format the partition with the Windows NT File System (NTFS).

e On the Windows 2000 Components page, in the Components list, click Message Queuing Services. If you are
installing Windows 2000 Professional, click Internet Information Services (11S) and click Next. On the Message
Queuing Type page, click Next.

e On the Network Settings page, click Typical settings.

[# Notes

After installing Windows 2000 Server, Advanced Server, or Professional with Service Pack 1, you must add a Windows 2000
user account to the Administrators group before you install any software. For more information,
see Add a user account to the Administrators group.

If you did not select Message Queuing Services on the Windows 2000 Components page during setup, you must install
it. For more information, see Install Message Queuing.

If you did not select Internet Information Services (IIS) on the Windows 2000 Components page during setup of
Windows 2000 Professional, you must install it. For more information, see Install Internet Information Services (IIS).

If your installation did not include Service Pack 1, you must install it. For more information,
see Install Windows 2000 Service Pack 1.

The Windows 2000 Server, Advanced Server, or Professional partition must be converted to the most recent version of
NTFS. Setup automatically performs this update if the existing file system is the old version of NTFS. If the existing partition
is FAT or FAT32, you are given the option to convert to NTFS. When prompted, choose NTFS.



Install Windows 2000 Service Pack 1

1. Insert the Windows 2000 Service Pack 1 compact disc into the appropriate drive.

You can also go to the downloads area of the Microsoft Windows 2000 Web site (www.microsoft.com/windows2000/) to
download Windows 2000 Service Pack 1 or to order the compact disc.

2. Run the Windows 2000 Service Pack 1 Setup program and follow the online instructions.


http://www.microsoft.com/windows2000/

Install Message Queuing

1. On the Start menu, point to Settings and click Control Panel.

2. Double-click Add/Remove Programs.
The Add/Remove Programs dialog box appears.
3. Click Add/Remove Windows Components.
The Windows Components Wizard opens.

4. In the Components list, select the Message Queuing Services check box and click Next.
5. On the Message Queuing Type page, click Next.

6. Click Finish to close the wizard.
[# Note

o Accept the default settings when installing the Message Queuing Services component.



Install Internet Information Services (11S)

1. On the Start menu, point to Settings and click Control Panel.

2. Double-click Add/Remove Programs.
The Add/Remove Programs dialog box appears.
3. Click Add/Remove Windows Components.
The Windows Components Wizard opens.

4. In the Components list, select the Internet Information Services (1IS) check box and click Next.

5. Click Finish to close the wizard.



Configure IIS settings for BizTalk Server 2000

To avoid problems accessing and saving specifications to the BizTalk Server 2000 repository, you must turn off the Enable
authoring option in Internet Information Services (lIS).

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Internet Services Manager.

2. Click the expand indicator (+) for the local IIS server.

3. Right-click Default Web Site and click Properties.
The Default Web Site Properties dialog box appears.

4. Click the Server Extensions tab and clear the Enable authoring check box.



Setting Up User Accounts

If you are installing BizTalk Server 2000 for development purposes only, you can create a standard user account. For more
information, see Add a user account to the Administrators group. If you are installing BizTalk Server 2000 for production
purposes, you should create a service account. For more information, see Create a service account. If you do not create a service
account, which is a regular user account with specific properties, BizTalk Server 2000 is automatically configured for the
interactive user (the user who is currently logged on during the setup process). If BizTalk Server 2000 is set up with an interactive
user, it fails if the specified user logs off from the server.

The following topics are covered in this section:

® Add a user account to the Administrators group

o Create a service account



Add a user account to the Administrators group

1. Log on as Administrator.

On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Computer Management.

2. In the console tree, click the expand indicator (+) for Local Users and Groups.

3. Click Groups and, in the details pane, double-click Administrators.
The Administrators Properties dialog box appears.

4. Click Add.
5. In the Look in box, click your computer name.

6. In the text box that contains the text < <Type names separated by semicolons or choose from list>>, delete the text and type
your domain and user name in the following format:

Domain\user name

7. Click OK.

8. If necessary, on the Enter Network Password page, complete the following:

o In the Connect as box, type your domain and user name in the following format:
Domain\user name

e In the Password box, type the password associated with your user name and click OK.

o Click OK to close the Administrators Properties dialog box.

9. If necessary, restart the computer and log on using your domain user account.



Create a service account

10.

11.

. Log on as Administrator.

On the Start menu, point to Settings, lick Control Panel, double-click Administrative Tools, and then double-click
Computer Management.

The Computer Management dialog box appears.

In the console tree, click the expand indicator (+) for System Tools and click Local Users and Groups.

. Click Users, right-click anywhere in the details pane, and then click New User.

The New User dialog box appears.

. In the User name box, type a name for the service account; in the Password box, type a password; and then type the same

password in the Confirm password box.

Clear the User must change password at next logon check box, click Create, and then click Close.

. Close the Computer Management window.

On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Local
Security Policy.

The Local Security Settings dialog box appears.

In the console tree, click the expand indicator (+) for Local Policies and click User Rights Assignment.

In the details pane, double-click Act as part of the operating system, click Add, click the account name you just created
from the list box, click Add, and then click OK twice.

Repeat steps 8-10 for the Log on as a service policy.

If BizTalk Server 2000 is already installed and using the interactive user account, complete the following steps after you have
created a service account.

1.

On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Services.

. In the details pane, double-click BizTalk Messaging Service.

The BizTalk Messaging Service Properties (Local Computer) dialog box appears.

. Click the Log On tab and click This account.

Click Browse, locate the user account name you created, and double-click it.

. In the Password box, type the same password you previously associated with the user account name; in the Confirm

Password box, type the password again and then click OK.
A message box appears; click OK.

Restart the computer.



Installing SQL Server 7.0 or SQL Server 2000

Prior to installing Microsoft BizTalk Server 2000, you must install Microsoft SQL Server 7.0 and SQL Server Service Pack 2 (SP2)
or Microsoft SQL Server 2000. When you install BizTalk Server 2000, the installation procedure creates four BizTalk Server 2000
databases (the BizTalk Messaging Management database, the Shared Queue database, the Tracking database, and the
Orchestration Persistence database) within SQL Server.

¢ Important

e [f you plan to install BizTalk Server 2000 on a computer that has Microsoft Windows 2000 Professional with Service Pack 1,
you must install SQL Server 7.0 and SQL Server Service Pack 2 (SP2) or SQL Server 2000 on another computer.
Windows 2000 Professional does not support SQL Server 7.0 or SQL Server 2000 installations. When you install the
databases for BizTalk Server 2000, you need to specify the name of the computer where you installed SQL Server 7.0 or
SQL Server 2000.

Before you install SQL Server, verify that your logon account is a member of the Windows 2000 Administrators group on the
computer on which you want to install SQL Server. For more information about adding your logon account,
see Add a user account to the Administrators group.

If you install SQL Server 2000, you must specify mixed authentication. By default, when you install SQL Server 2000, the
authentication mode is set to Windows 2000 only. BizTalk Server 2000 uses SQL Authentication to access the BizTalk Messaging
Management, Shared Queue, and Tracking databases and does not work with this setting. Verify that you have the authentication
mode set to mixed before installing BizTalk Server 2000. For more information,

see Set SQL authentication mode for SQL Server 2000.

If you install SQL Server on a cluster and you plan to install BizTalk Server 2000 on another computer, you must install SQL
Server client tools on the computer where BizTalk Server 2000 is installed. A cluster is a collection of servers that act as a single
server. For more information, see Install SQL Server client tools. When complete, you must use the Client Network Utility to
change the default network library from named pipes to TCP/IP. For more information,

see Change the default network library to TCP/IP.

When you install SQL Server 7.0 or SQL Server 2000, it is important to use the correct collation settings. Collation refers to a set
of rules that determines how data is sorted and compared. Character data is sorted using rules that define the correct character
sequence, with options for specifying case sensitivity, accent marks, kana character types, and character width. For instance, to
store Japanese characters, select case-sensitive sort order to distinguish Japanese-Hiragana from Japanese-Katakana when
setting up SQL Server. For more information about collation settings, on the Start menu, point to Programs, point to Microsoft
SQL Server, and then click Books Online. The topics, Using SQL Collation and Windows Collation Sorting Styles, provide
additional information.

The following topics are covered in this section:

e Install SQL Server 7.0 or 2000

e Check for SQL Server 7.0 Service Pack 2

e Install SQL Service Pack 2 for SQL Server 7.0

e Install SQL Server client tools

e Change the default network library to TCP/IP

e Set SQL authentication mode for SQL Server 2000
e Verify that SQL Server is running

e Avoid unnecessary disk space allocation

e SQL Server and BizTalk Server 2000 Database Interactions



Install SQL Server 7.0 or 2000

1. Insert the Microsoft SQL Server compact disc into the appropriate drive.

2. Run the SQL Server Setup program and follow the online instructions.

The setup wizard walks you through the steps necessary to install SQL Server, but you must observe the following
requirements:

e On the Setup Type page, click Typical.
e On the Services Accounts page, use a domain user account (if connected to a network).

e When installing SQL Server 2000, specify mixed authentication.
¢ Important

e If you install SQL Server 7.0, you must install SQL Service Pack 2 (SP2). You can check to see whether you have SP2 installed
by using the Query Analyzer. For more information, see Check for SQL Server 7.0 Service Pack 2. For more information
about installing SQL SP2, see Install SQL Service Pack 2 for SQL Server 7.0.



Check for SQL Server 7.0 Service Pack 2

1. On the Start menu, point to Programs, point to Microsoft SQL Server 7.0, and then click Query Analyzer.
The Connect to SQL Server dialog box appears.

2. Click OK.
If your server name does not appear in the SQL Server list, select it from the list or type it in, and then click OK.

3. In the Query box, type SELECT @ @VERSION.

4. On the Query menu, click Execute.

The first line of the query return indicates the version of SQL Server that is running. If you have SP2 installed, you should
see 7.00.842.



Install SQL Service Pack 2 for SQL Server 7.0

1. Insert the SQL Service Pack 2 compact disc into the appropriate drive.

2. Run the SQL Service Pack 2 Setup program and follow the online instructions.



Install SQL Server client tools

1. Insert the Microsoft SQL Server compact disc into the appropriate drive.

2. Run the SQL Server Setup program and follow the online instructions.

The setup wizard walks you through the steps necessary to install SQL Server, but you must observe the following
requirements:

e On the Installation Selection page, click Create a new instance of SQL Server, or install Client Tools.

e On the Installation Definition page, click Client Tools Only.



Change the default network library to TCP/IP

1. On the Start menu, point to Programs, point to Microsoft SQL Server 7.0 or Microsoft SQL Server, and then click Client
Network Utility.

The SQL Server Client Network Utility dialog box appears.
2. If you have installed Microsoft SQL Server 7.0, on the General tab, in the Default network library list, click TCP/IP.
-Or-
If you have installed Microsoft SQL Server 2000, on the Network Libraries tab, in the Network Library list, click TCP/IP.

3. Click OK.



Set SQL authentication mode for SQL Server 2000

1. Click Start, point to Programs, point to Microsoft SQL Server, and then click Enterprise Manager.
2. Click the expand indicator (+) for Microsoft SQL Servers and for SQL Server Group.

3. Right-click the name of your server and click Properties.
The SQL Server Properties dialog box appears.

4. Click the Security tab, click SQL Server and Windows, and then click OK.



Verify that SQL Server is running

Before installing BizTalk Server 2000, verify that SQL Server is running on your server. This is necessary because BizTalk
Server 2000 must create four SQL databases during installation.

1. On the Start menu, point to Programs, point to Microsoft SQL Server (if you installed SQL Server 2000) or Microsoft
SQL Server 7.0 (if you installed SQL Server 7.0), and then click Service Manager.

The SQL Server Service Manager dialog box appears.
2. In the Server list, verify that the name of the server is the name of your computer.
If it is not, click the drop-down arrow to view a list of available servers and scroll to locate your server.

3. In the Services list, click MSSQLServer (for SQL Server 7.0) or SQL Server (for SQL Server 2000).

4. Verify that the MSSQLServer or SQL Server service is running.

The service is running if the Start/Continue button in the dialog box is unavailable. Also, at the bottom of the dialog box is
a message that states that the service is running. For example, \\<servername>—MSSQLServer—Running.

5. If the service is not running, the Start/Continue button is available; click it to start the service.



Avoid unnecessary disk space allocation

1. Click Start, point to Programs, point to Microsoft SQL Server 7.0 or Microsoft SQL Server, and then click Enterprise
Manager.

2. Click the expand indicator (+) for Microsoft SQL Servers, SQL Server Group, <server name>, and Databases.

3. Right-click the BizTalk Messaging Management database and click Properties.
The BizTalk Messaging Management database properties dialog box appears.

4. Click the Options tab.

5. In the Settings area, select the Truncate log on checkpoint and the Auto shrink check boxes and click OK.
¥ Note
o [f you have Microsoft SQL Server 2000 installed, you can only select the Auto shrink check box.
6. Repeat steps 3 through 5 for the Tracking and Shared Queue databases.
¢ Important

® You can complete this procedure only if you have BizTalk Server 2000 installed. For more information about installing
BizTalk Server 2000, see Installation Instructions.

[# Note

e During setup, the BizTalk Messaging Management database object name defaults to InterchangeBTM; the Tracking
database object name defaults to InterchangeDTA,; and the Shared Queue database object name defaults to
InterchangeSQ. You may have renamed these default database object names during setup.



SQL Server and BizTalk Server 2000 Database Interactions

To avoid unnecessary disk space allocation, use the Truncate log on checkpoint and Auto shrink features of Microsoft SQL
Server. Otherwise, the SQL Server logs can consume large amounts of disk space.

Related Topic

Avoid unnecessary disk space allocation



Installing Visio 2000 SR-1A

Because BizTalk Orchestration Designer is a Microsoft Visio 2000-based user interface, you must have Visio 2000 Service Release
1A installed on your computer prior to using BizTalk Orchestration Designer. BizTalk Orchestration Designer has been tested with

Visio 2000 Standard Edition SR-1A, and might work with later versions of Visio.
The following topic is covered in this section:

e [nstall Visio 2000 Standard Edition SR-1A



Install Visio 2000 Standard Edition SR-1A

1. Insert the Visio 2000 Standard Edition SR-1A compact disc (or a later version of Visio 2000 Standard Edition) into the
appropriate drive.

2. Run the Visio 2000 Standard Edition SR-1A Setup program and follow the online instructions.
¥ Note

o For more information, see the Microsoft Visio 2000 Standard Edition SR-1A documentation.



Installation Instructions

You can install Microsoft BizTalk Server 2000 using the Installation Wizard (Microsoft BizTalk Server.msi) or using Microsoft
Windows Installer (Msiexec.exe). The Installation Wizard is a step-by-step process in which you select options that correspond to
specific property values. The Microsoft Windows Installer allows you to specify property values from the command line. You can
use this method to install BizTalk Server 2000 silently (without constant interaction or prompts). A silent installation of BizTalk
Server 2000 is ideal for test scenarios or as part of a large-scale enterprise deployment. Regardless of which installation you
perform, it is recommended that you maintain a record of the following information for later use:

BizTalk Server group names

SQL Server names

User names

Passwords

The BizTalk Messaging Management database name
The Tracking database name

The Shared Queue database name

The WebDAV repository URL

¢ Important

BizTalk Server 2000 requires Microsoft XML Parser version 3.0. This release of BizTalk Server 2000 automatically installs
Microsoft XML (MSXML) Parser version 3.0. If you install other versions of the MSXML parser, it might cause unexpected
results with BizTalk Server 2000.

[# Note

e During BizTalk Server 2000 installation, the installation program determines the hard-disk space availability of your

computer. A complete installation will require approximately 52 megabytes (MB), not including the requirements of the
BizTalk Messaging Management database, the Tracking database, the Shared Queue database, and the Orchestration
Persistence database. A tools installation will require approximately 30 MB of hard disk space. A custom installation will
require approximately 2 to 52 MB of hard disk space, not including database requirements, depending on the services and
tools that you install.

Before you run Setup, verify that your logon account is a member of the Windows 2000 Administrators group for the computer
on which you are installing BizTalk Server 2000. For more information about joining the Administrators group,
see Add a user account to the Administrators group.

¥ Note

e |f BizTalk Server was installed using an interactive user, it will not start if a user is not logged on to BizTalk Server 2000. All

COM+ packages run under an interactive user account, not the local system account. This means that the service starts only
if a user is logged on to BizTalk Server 2000. For example, if a user is not logged on to BizTalk Server 2000 when a client
application submits documents to BizTalk Server 2000 remotely, the service does not start. To avoid this situation, create a
service account or have the user who starts the service lock the computer and keep the services running in the background.
For more information about creating a service account, see Create a service account.

The following topics are covered in this section:

e Complete Installation

e Tools Installation

o Custom Installation



e Silent Installation

e Removing BizTalk Server 2000



Complete Installation

You can use the following section to perform a complete installation of BizTalk Server 2000 that includes all BizTalk services, tools,
and samples.

The following topics are covered in this section:

e Perform a complete installation of BizTalk Server 2000
e Start the World Wide Web Publishing Service

e Install BizTalk Document Tracking Remotely



Perform a complete installation of BizTalk Server 2000

1. Insert the Microsoft BizTalk Server 2000 Setup compact disc into the appropriate drive.

2. Run the Microsoft BizTalk Server 2000 Setup program and follow the online instructions.

¢ Important
e The setup wizard guides you through the steps necessary to install BizTalk Server 2000. You must observe the

requirements listed in the following steps.

e BizTalk Server 2000 requires Microsoft XML Parser version 3.0. This release of BizTalk Server 2000 automatically
installs Microsoft XML (MSXML) Parser version 3.0. If you install other versions of the MSXML parser, it might cause
unexpected results with BizTalk Server 2000.

3. On the License Agreement page, read the license agreement, click | accept this license agreement, and then click Next.
£ Note
e |f you do not accept the license agreement, you cannot continue with the installation.

4. On the Customer Information page, type your name in the User name box, type the name of your company in the
Organization box, click either Anyone who uses this computer (all users) or Only for me if you want to limit access to
BizTalk Server 2000, and then click Next.

5. On the Destination Folder page, click Next to install BizTalk Server 2000 to the folder shown on the page, or click Change
to select another location.

6. On the Setup Type page, click Complete and click Next.

7. On the Configure BizTalk Server Administrative Access page, in the Group name box, type the group name that you
want to use (or accept the default, BizTalk Server Administrators).
[ Notes

e To create a group name, adhere to the following group naming restrictions:

e The group name must be different from any other group or user name on this computer.

e The group name cannot contain the following characters: ! @ #$ % A & * () + = [1{}|\\"'<>,.?
e The group name cannot consist solely of periods () or spaces.

e Do not rename this group without also modifying the value of "AdminGroupName" in the Windows registry under
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\BizTalk Server\1.0\NTGroups. BizTalk Server 2000 relies on this
registry key to find the group.

8. In the Group description box, type a new description for the group name or accept the default and click Next.
9. On the Microsoft BizTalk Server Service Log On Properties page, click the default setting, Local system account, or
click This account to limit BizTalk Server 2000 access to a specific user.

If you select This account, type a new user name or accept the default name in the User name box, type a valid password
in the Password box.

If you do not want BizTalk Services to automatically start when setup completes, clear the Start service after setup
completes checkbox. BizTalk Services will not automatically start, but Orchestration Services will.

[# Notes

e BizTalk Server setup will grant Log on as a service and Act as part of the operating system rights to the account
specified on the Microsoft BizTalk Server Service Log On Properties page.



o If you select This account, specify an account that is in the Windows 2000 Administrators group. To configure
certificates for the S/MIME components by using BizTalk Messaging Manager, you must belong to a user account in
the Windows 2000 Administrators group, and BizTalk Messaging Services must be running as a local system account
or as a user account in the Windows 2000 Administrators group.

10. Click Next.

11. On the Ready to Install the Program page click Install.
The BizTalk Server 2000 installation procedure might take several minutes.

12. When the Welcome to the Microsoft BizTalk Server 2000 Messaging Database Setup Wizard page appears, click
Next.

During BizTalk Server 2000 database setup, you are prompted for logon information (server, database, user name, and
password) to configure the BizTalk Messaging Management, Tracking, and Shared Queue databases.

¥ Caution

e Do not change the code, such as stored procedures or triggers, in the BizTalk Messaging Management, Tracking, and
Shared Queue databases. Do not access the database directly. Do not directly call the stored procedures. Make all
changes to the database by using the methods and properties of the BizTalk Messaging Configuration object model.
Making changes to the database directly bypasses many constraints enforced by the BizTalk Messaging Configuration
object model and either causes the server to function incorrectly or corrupts the database.

13. On the Configure a BizTalk Messaging Management Database page, click either Create a new BizTalk Messaging
Management database or Select an existing database and type a server name and user information in the following
text boxes:

® Server name
e User name
e Password

e Database

You can choose unique server and database names and type new information or accept the defaults.
¢ Important

e [f you are installing BizTalk Server 2000 on a computer that has Microsoft Windows 2000 Professional with Service
Pack 1, the Server name you must specify is the name of the computer where you installed Microsoft SQL Server 7.0
or Microsoft SQL Server 2000.

e [f you select Create a new BizTalk Messaging Management database and choose an existing database, you
should manually delete the contents of the database. For more information about deleting database content, on the
Start menu, point to Programs, point to Microsoft SQL Server, and then click Books Online. To create a new
database with the same name as an existing database on the same server, it is recommended that you manually delete
the database content. BizTalk Server setup only verifies if a stored procedure required by the database exists, rather
than verifying if all the variables required by the database exist. If a stored procedure exists, BizTalk Server setup does
not modify the database. If the stored procedure does not exist, BizTalk Server setup deletes the database. Then it
reinitializes the BizTalk Messaging Management database tables. The above-mentioned information is true for the
Shared Queue and Tracking databases.

e [f you are set up more than one BizTalk Server installation and want to centrally manage the BizTalk Messaging
Management database, it is highly recommended that you review information about BizTalk Server database
interactions. For more information about configuring the database,
see Changing the BizTalk Messaging Management database.

14. Click Next.



15.

16.

17.

18.

19.

20.

21.

On the Configure a BizTalk Server Group page, type the name that you want to use as your BizTalk Server group in the
Group name box or accept the default (BizTalk Server Group), and then click Next.

You can also click Select an existing BizTalk Server group and select a name from the Group Name list.

¥ Notes
e The group name cannot contain the following characters: " ! @ #$ % A & * () + = [1{}|\\"'<>,.?

On the Configure a Tracking Database page, repeat the procedure in step 13 and click Next.
¢ Important

o If you change the default User name on the Configure a Tracking Database page, the account that you specify
must have SA-level permissions. This account is used to create a SQL Server user login. After installing BizTalk Server,
change the account user name and password to remove SA-level access to the Tracking database by the BizTalk
Server service. For more information, see Configure connection properties for a server group. Or you can change the
SA-level permission for the account used during setup. For more information about changing SQL Server account
permissions, on the Start menu, point to Programs, point to Microsoft SQL Server, and then click Books Online.

On the Configure a Shared Queue Database page, repeat the procedure in step 13 and click Next.

On the Verify BizTalk Server Group page, verify that the information in the BizTalk Server group properties box is
correct and click Next.

On the final page of the Microsoft BizTalk Server 2000 Messaging Database Setup Wizard, click Finish to complete the
configuration of the BizTalk Messaging Management, Tracking, and Shared Queue databases.

On the Welcome to the Microsoft BizTalk Server 2000 Orchestration Persistence Database Setup Wizard page, click
Next to install the Orchestration Persistence database.

[# Note

e If you click Cancel, BizTalk Server 2000 is installed, but the Orchestration Persistence database and the Data Source
Name (DSN) are not installed. You can install the database and the DSN later. For more information,
see Create a new persistence database, Configure the default XLANG Scheduler application,
and Configure a COM+ application to host XLANG schedules.

On the Configure a default Orchestration Persistence Database page, click either Create a new default
Orchestration Persistence database or Select an existing database and then choose a server name and type database
information in the appropriate text boxes or, accept the defaults.

¢ Important

o If you select Create a new default Orchestration Persistence database and choose a database with the same
name, on the same server, as an existing database, BizTalk Server setup deletes everything in the database. BizTalk
Server setup then reinitializes the Orchestration Persistence database tables.

e [f you are installing BizTalk Server 2000 on a computer that has Windows 2000 Professional with Service Pack 1, the
Server name you specify is the name of the computer where you installed SQL Server 7.0 or SQL Server 2000.

[# Notes

e The Orchestration Persistence database is created based on the current user log-on identity.

e Touse SQL Server remotely, you must have the appropriate permissions set for the Orchestration Persistence
database. If you have not reconfigured the identity for the XLANG Scheduler Engine, permissions will be granted to
the interactive user (the user who was logged on during installation of BizTalk Server 2000). If you have reconfigured
the identity for the XLANG Scheduler Engine to match a service account you created or another unique user account,
you must set permissions to match the reconfigured identity.

22. Click Finish.

23.

On the final page of the Microsoft BizTalk Server 2000 Setup Wizard, click View Readme to read important, late-breaking



information about BizTalk Server 2000, and then click Finish.

¥ Caution

e Do not change the impersonation level for any COM+ application. By default, it is set to Impersonate. Changing this security
property to Anonymous, Identify, or Delegate may cause problems during installation.

¢ Important

e To dramatically increase the performance of BizTalk Orchestration Services, in Windows Explorer, browse to Program
Files\Common Files\System\ado, and then double-click adofre15.reg. In the confirmation dialog box, click Yes, and then
click OK. This procedure changes the ADO threading model from "Apartment threaded" to "Both" and may affect other
applications that use ADO. Any provider that is not thread safe cannot be used.

¥ Note

e BizTalk Messaging Manager will not run unless the World Wide Web Publishing Service is running. For more information
about the World Wide Web Publishing Service, see Start the World Wide Web Publishing Service.



Start the World Wide Web Publishing Service

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, click Services (Local).

3. In the details pane, right-click World Wide Web Publishing Service and click Start.



Install BizTalk Document Tracking Remotely

When BizTalk Document Tracking is installed from the BizTalk Server 2000 compact disc, a shortcut is created in the program
group for BizTalk Server 2000 to access the BizTalk Document Tracking Web application. However, when BizTalk Document
Tracking is installed over the Internet, you must manually create a shortcut or a favorite for later access to the Web application.
Additionally, to prevent the display of security warning dialog boxes, you must manually configure your browser's settings to

trust the Web application.

The following topic is covered in this section:

e Configure Internet Explorer security settings



Configure Internet Explorer security settings

1. Click Start, point to Programs, and then click Internet Explorer.

2. On the Tools menu, click Internet Options.
The Internet Options dialog box appears.
3. On the Security tab, click Trusted Sites and click the Sites button.
The Trusted Sites dialog box appears.
4. In the Add this Web site to the zone box, type the location of the BizTalk Document Tracking server.

To find the location of the BizTalk Document Tracking server, on the Start menu, point to Programs, point to Microsoft
BizTalk Server 2000, and then click BizTalk Document Tracking. The location of the BizTalk Document Tracking server
appears in the Address list.

5. Clear the Require server verification (https:) for all sites in this zone check box.

6. Click Add and click OK twice to close the dialog boxes.



Tools Installation

A Microsoft BizTalk Server 2000 tools installation enables you to install only BizTalk Orchestration Designer, BizTalk Document
Tracking, BizTalk Editor, BizTalk Mapper, and the BizTalk Server 2000 Help.

The following topic is covered in this section:

® Perform a tools installation of BizTalk Server 2000



Perform a tools installation of BizTalk Server 2000

1. Insert the Microsoft BizTalk Server 2000 Setup compact disc into the appropriate drive and follow the on-screen
instructions.

¢ Important

e The setup wizard guides you through the steps necessary to install BizTalk Server 2000. Observe the requirements
listed in the following steps.

2. On the License Agreement page, read the license agreement, click | accept this license agreement, and then click Next.

¥ Note
e |f you do not accept the license agreement, you cannot continue with the installation.

3. On the Customer Information page, type your name in the User name box, type the name of your company in the
Organization box, click Anyone who uses this computer (all users) or Only for me if you want to limit access to BizTalk
Server 2000, and then click Next.

4. On the Destination Folder page, click Next.
5. On the Setup Type page, click Tools and click Next.
6. On the Ready to Install the Program page of the Microsoft BizTalk Server 2000 Setup Wizard, click Install.

7. On the final page of the Microsoft BizTalk Server 2000 Setup Wizard, click View Readme to read important, late-breaking
information about this release of BizTalk Server 2000.

8. Click Finish to complete the installation process.
¢ Important

e To dramatically increase the performance of BizTalk Orchestration Services, in Windows Explorer, browse to Program
Files\Common Files\System\ado, and then double-click adofre15.reg. In the confirmation dialog box, click Yes, and then
click OK. This procedure changes the ADO threading model from "Apartment threaded" to "Both" and may affect other
applications that use ADO.

¥ Note

e To install the BizTalk Server 2000 interchange component on a remote computer, use the Windows 2000 COM Application
Export Wizard.

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, expand Component Services, Computers, My Computer, and COM+ Applications.

3. Right-click BizTalk Server Interchange Application and click Export.

Follow the on-screen instructions to create an .msi file that you can run on a client computer.



Custom Installation

A custom Microsoft BizTalk Server 2000 installation enables you to install all the features of BizTalk Server 2000 or only those
features that you want.

¥ Note

e [f you want to install the server components of BizTalk Server 2000, you must first install Microsoft SQL Server. For more
information, see Install SQL Server 7.0 or 2000.

The following topic is covered in this section:

® Perform a custom installation of BizTalk Server 2000



Perform a custom installation of BizTalk Server 2000

1.

Insert the Microsoft BizTalk Server 2000 Setup compact disc into the appropriate drive and follow the on-screen
instructions.

¢ Important

e The setup wizard guides you through the steps necessary to install BizTalk Server 2000. You must observe the
requirements listed in the following steps.

2. On the License Agreement page, read the license agreement, click | accept this license agreement, and then click Next.

¥ Note
e If you do not accept the license agreement, you cannot continue with the installation.

3. On the Customer Information page, type your name in the User name box, type the name of your company in the
Organization box, click Anyone who uses this computer (all users) or Only for me if you want to limit access to BizTalk
Server 2000, and then click Next.

4. On the Destination Folder page, click Next.

5. On the Setup Type page, click Custom and click Next.

6. On the Custom Setup page, follow the on-screen instructions to select the BizTalk Server 2000 components that you want
to install.

To perform a different type of installation, click Back. Otherwise, click Next. Additional pages appear on which you provide
additional information, depending on the installation components that you have selected.

7. On the Ready to Install the Program page, click Install.

The BizTalk Server 2000 custom installation procedure might take a few minutes.

8. On the final page of the Microsoft BizTalk Server 2000 Setup Wizard, click View Readme to read important, late-breaking
information about this release of Microsoft BizTalk Server 2000.

9. Click Finish to complete the installation process.

¢ Important

e BizTalk Messaging Manager will not run unless the World Wide Web Publishing Service is running. To start the World Wide

Web Publishing Service:

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, click Services (Local).

3. In the details pane, right-click World Wide Web Publishing Service and click Start.

e To dramatically increase the performance of BizTalk Orchestration Services, in Windows Explorer, browse to Program

Files\Common Files\System\ado, and then double-click adofre15.reg. In the confirmation dialog box, click Yes, and then
click OK. This procedure changes the ADO threading model from "Apartment threaded" to "Both" and may affect other
applications that use ADO.



Silent Installation

The Microsoft Windows Installer allows you to specify property values from the command line. This method gives you the ability
to install Microsoft BizTalk Server 2000 silently (without constant interaction or prompts). A silent installation of BizTalk
Server 2000 is ideal for test scenarios or as part of a large-scale enterprise deployment.

The following topic is covered in this section:

® Perform a silent installation of BizTalk Server 2000



Perform a silent installation of BizTalk Server 2000

1. Click Start and click Run.

2. In the Open box, type cmd and click OK.

3. Type the following to install BizTalk Server 2000 silently:

msiexec /I "\\server\folder\Microsoft BizTalk Server.msi"

/ab /Lv*"C:\Temp\install.log" INSTALLLEVEL=200

ALLUSERS=1

PIDKEY="your 25-character product key

DSNCONFIG="C:\Temp\BizTalkInstall.ini"

¢ Important

(without dashes)"

e You must add the ALLUSERS =1 parameter to complete the installation for all users. This parameter also ensures that the
services are able to see the registry settings.

[# Notes

® In the preceding code:

e /lis the command line to install or configure a product.

e /gb is the command line to present a basic user interface (progress bar only).

e /Lv* produces a log file.

e [INSTALLLEVEL=200 installs the server. If you do not specify the INSTALLLEVEL, the value defaults to 100, which is
the Tools installation of BizTalk Server 2000.

e PIDKEY="your 25-character product key (without dashes)" is the product key. For example,
PIDKEY=AB6CDEFGH71JK8LMN45LLTT34.

e DSNCONFIG="CA\Temp\BizTalkInstall.ini" provides installation information to the setup wizard.

You can specify various options at the command line to set properties for a BizTalk Server 2000 installation. Unspecified
properties take on the default values. The properties unique to BizTalk Server 2000 are listed in the following table.

Public property

Value

Description

USERNAME

(built-in installer p
roperty)

<name>

Default: {LogonUser}

The name of the user performing the installation. Customer Informati
on dialog box; User name edit box.

COMPANYNAME

(built-in installer p
roperty)

<organization>

Default: {LogonCompany}

The organization name for the user performing the installation. Custom
er Information dialog box; Organization edit box.

(built-in installer p
roperty)

Default: 100

PIDKEY <product-id> The CD-key of the form ###-#####3## for the product. Customer Infor
mation dialog box; Serial number masked edit box.
Default: ""
INSTALLLEVEL <install level> The feature installation level. For BizTalk Server 2000 setup, 100=Client

and 200=Server setup type.

INSTALLDIR

(built-in installer p
roperty)

<install path>

Default: "{ProgramFiles} \Microsoft Bi
zTalk Server"

The destination folder for the installation.




BTS_GROUP_NAM
E

(Complete installat
ion only)

<Group Name>

Default: "BTSAdmin"

The name of the BizTalk Server 2000 Windows NT group. ConfigAdmi
nGroup dialog box; Group name edit box.

BTS_GROUP_DESC
RIPTION

(Complete installat
ion only)

<Group Description>

Default: "Members can fully administ
er Microsoft BizTalk Server"

The description of the BizTalk Server 2000 NT group. ConfigAdminGro
up dialog box; Group description edit box.

(Complete and To
ols installation)

Default: "localhost"

BTS_USERNAME |<username> The logon DOMAIN\name for the BizTalk Server 2000 service. ConfigS
) erviceLogon dialog box; User name edit box.

(Complete installat|Default:

ion only)

BTS_PASSWORD |<password> The logon password for the BizTalk Server 2000 service. ConfigService
) Logon dialog box; Password edit box.

(Complete installat|Default:

ion only)

BTS_SERVER <servername> The name of the BizTalk server to remotely administer. ConfigMgmtD

esk dialog box; Server name edit box.

BTS_SDK_SERVER

(Complete and To
ols installation)

<servername>

Default: ""localhost""

The name of the BizTalk server to use for DCOM. ConfigSDK dialog box
; Server name edit box.

DSNCONFIG

(initialization file)

<pathname>

Default: ""

The path of the initialization file for the BTSsetupDB.exe and XLANGsetu
pDB.exe database setup wizard to use.

[# Notes

o The DSNCONFIG property is required to complete a silent installation of BizTalk Server 2000. The initialization path file
listed on the command line is passed to the BTSsetupDB.exe and XLANGsetupDB.exe database setup wizards. Use one of the
following command-line values:

o DSNCONFIG="Full path to .ini file for BTSsetupDB.exe and XLANGsetupDB.exe"

-Or-

e BTSSETUPDB.INI="Full path to .ini file for BTSsetupDB.exe" and XLANGSETUPDB.INI="Full path to .ini file for
XLANGsetupDB.exe"

e The database setup wizard processes the contents of the initialization file using these rules:

e All [sections] and keys= are optional; if a key is absent, the default value as shown in the sample initialization file is

used.

o [f the GroupName exists in the specified BizTalk Messaging Management database, the [InterchangeDTA] and the
[InterchangeSQ)] sections are ignored since the group defines the values.

e Specified databases are created if they do not already exist on the specified server.

e The BizTalk Messaging Management database setup and the Orchestration Persistence database setup are mutually

independent.

e Depending on the features you install, setup configures either, neither, or both of the following:

e BizTalk Messaging Management database - only configured if BizTalk Messaging Services and its associated
components are installed.

e Orchestration Persistence database - only configured if Orchestration Service is installed.




e The following properties are used on the command line:
o DSNCONFIG - specifies location of .ini file to be used by BTSsetupDB.exe and XLANGsetupDB.exe

_Or_
BTSSETUPDB.INI - specifies location of .ini file to be used by BTSsetupDB.exe

o XLANGSETUPDBL.INI - specifies location of .ini file to be used by XLANGsetupDB.exe
Sample initialization file with all [sections], keys=, and default values shown

The following is an example of the format of an .ini file needed to silently install BizTalk Server 2000. These command-line
properties are required to perform a first-time installation of BizTalk Server 2000 using the Windows Installer.

Example SetupDB.ini

; SQL Server connection parameters for BizTalk Messaging Management database
; Required section used by BTSsetupDB.exe only.
; Specify new or existing database.

[InterchangeBTM]
Server=localhost
Username=sa
Password=
Database=InterchangeBTM

; Name for BizTalk Server Group

; Required section used by BTSsetupDB.exe only.
; Specify new or existing server group.

[Group]

GroupName=BizTalkGroup

; SQL Server connection parameters for BizTalk Tracking database
; Required section used by BTSsetupDB.exe only.

; Optional if existing server group specified.

[InterchangeDTA]

Server=localhost

Username=sa

Password=

Database=InterchangeDTA

[InterchangeSQ]
Server=localhost
Username=sa
Password=
Database=InterchangeSQ

; SQL Server connection parameters for Orchestration database
; Required section used by XLANGsetupDB.exe only.

; Specify new or existing Orchestration database.
[Orchestration]

Server=localhost

Database=XLANG

The following table describes the properties and values of the sample BizTalkDB.ini initialization file.

Property Value Description
[InterchangeBT [Server=BIZTALK Log on to this first SQL Server with default user name and password.
M]

Database=BizTalkBTM

Create this BizTalk Messaging Management database if it does not already exist on
the server.

[Group] GroupName=BizTalkServerG |The rest of the values are ignored if this group already exists.
roup




[InterchangeDT

Al

Server=DTA-SERVER

Log on to this second SQL Server with default user name and password.

Database=BizTalkDTA

Create this Tracking database if it does not already exist on the server.

[InterchangeSQ

]

Server=SQ-SERVER

Log on to this third SQL Server with default user name and password.

Database=BizTalkSQ

Create this Shared Queue database if it does not already exist on the server.

[Orchestration]

Server=localhost

Log on to this fourth SQL Server with default user name and password.

Database=0Orchestration

Create this XLANG database if it does not already exist on the server.

Command-line options of Microsoft Windows Installer

Microsoft Windows Installer (Msiexec.exe) is the program that interprets packages and installs products. It also sets an error level
on return that corresponds to the Microsoft Win32® error codes. The following table describes command-line options for this
program that you can use in addition to the properties and values listed previously.

or

[u|m]Package /t
Transform List

or

[u|m]Package /
g LanguagelD

O |[Parameters |Meaning
pt
io
n
/I |Package|Produc|installs or configures a product.
tCode
/f |[p|o|e|d|c|alulm]||Repairs a product. This option ignores any property values entered on the command line. The default argume
s|v] Package|Pr |nt list for this option is pecms. This option shares the same argument list as the REINSTALLMODE property.
oductCode . ey
p - Reinstall only if file is missing.
o - Reinstall if file is missing or if an older version is installed.
e - Reinstall if file is missing or an equal or older version is installed.
d - Reinstall if file is missing or a different version is installed.
¢ - Reinstall if file is missing or the stored checksum does not match the calculated value. Repairs only files th
at have msidbFileAttributesChecksum in the Attributes column of the File table.
a - Force all files to be reinstalled.
u - Rewrite all required user-specific registry entries.
m - Rewrite all required computer-specific registry entries.
s - Overwrite all existing shortcuts.
v - Run from source and recache the local package.
/a |Package Administrative installation option. Installs a product on the network.
/x |Package|Produc|Uninstalls a product.
tCode
/j |lum]Package |Advertises a product. This option ignores any property values entered on the command line.

u - Advertise to the current user.
m - Advertise to all users of the computer.
t - Apply transform to advertised package.

g - Language ID.




/L

[ilwlelalrfulc[m]
o|p|v|+|!]Logfile

Specifies the path to a log file; the flags indicate which information to log.
i - Status messages

w - Nonfatal warnings

e - All error messages

a - Startup of actions

r - Action-specific records

u - User requests

¢ - Initial Ul parameters

m - Out-of-memory or fatal exit information
o - Out-of-disk-space messages

p - Terminal properties

v - Verbose output

+ - Append to existing file

I - Flush each line to the log

"*" - Wildcard; log all information except the v option. To include the v option, specify "/I*v".

filename

Generates a Systems Management Server (SMS) status .mif file. Must be used with the install (-i), remove (-x),
administrative installation (-a), or reinstall (-f) option. The Ismif32.dll is installed as part of SMS and must be o
n the path.

The fields of the status .mif file are filled with the following information:
Manufacturer - Author

Product - Revision number

Version - Subject

Locale - Template

Serial Number - Not set

Installation - Set by Ismif32.dll to "DateTime"

InstallStatus - "Success" or "Failed"

Description - Error messages in the following order: 1) Error messages generated by installer; 2) Resource fro
m Msi.dll if installation could not commence or user exits; 3) System error message file; 4) Formatted messag
e: "Installer error %i", where %i is the error returned from Msi.dll

/p

PatchPackage

Applies a patch. To apply a patch to an installed administrative image, you must combine options as follows:

/p <PatchPackage> /a <Package>

/9

n|b|r|f

Sets the user interface level.

g, qgn - No Ul

gb - Basic Ul.

gr - Reduced Ul with a modal dialog box displayed at the end of the installation.
gf - Full Ul with a modal dialog box displayed at the end.

gn+ - No Ul except for a modal dialog box displayed at the end.

gb+ - Basic Ul with a modal dialog box displayed at the end. The modal dialog box is not displayed if the user
cancels the installation.

gb- - Basic Ul with no modal dialog boxes. /qb+- is not a supported Ul level.




/? Displays copyright information for the Windows Installer.

or

/h

/y |[module Calls the system API DIIRegisterServer to self-register modules passed in on the command line. For example,
msiexec /y my_filedll.
This option is used only for registry information that cannot be added using the registry tables of the .msi file.

/z |Imodule Calls the system API DIlUnRegisterServer to unregister modules passed in on the command line. For example,
msiexec /z my_file.dIl.
This option is used only for registry information that cannot be removed using the registry tables of the .msi fi
le.

[ Notes

o In the preceding table:
e The options /i, /%, /f[p|oleld|c|alulm|s|v], /jlu|m], /a, /p, /y, and /z should not be used together. The one exception to
this rule is that patching an administrative installation requires using both /p and /a.

e The options /t and /g should be used only with /j.

e The options /I and /q can be used with /i, /x, /f[p|o|e|d|c|a]u]m]|s|v], /j[u|m], /a, and /p.
Syntax rules for properties and values

Only public properties can be modified using the command line. All property names on the command line are interpreted as
uppercase, but the value retains case sensitivity. If you type MyProperty at a command line, the installer overrides the value of
MYPROPERTY and not the value of MyProperty in the Property table. To install a product with PROPERTY set to VALUE, use the
following syntax on the command line. You can put the property anywhere except between an option and its argument.

Correct syntax:
msiexec /i A:\Example.msi PROPERTY=VALUE

Incorrect syntax:

msiexec /i PROPERTY=VALUE A:\Example.msi

Property values that are literal strings must be enclosed in quotation marks. Include any white spaces in the string between these
marks.

msiexec /i A:\Example.msi PROPERTY="Embedded White Space"

To clear a public property using the command line, set its value to an empty string.

msiexec /i A:\Example.msi PROPERTY=""

For sections of text set apart by literal quotation marks, enclose the section with a second pair of quotation marks.
msiexec /i A:\Example.msi PROPERTY="Embedded ""Quotes"" White Space"

The following is an example of a complicated command line.

msiexec /i testdb.msi INSTALLLEVEL=3 /1* msi.log COMPANYNAME="Acme ""Widgets"" and ""Gizmos."""
The following example illustrates advertisement options. Switches are not case sensitive.

msiexec /JM msisample.msi /T transform.mst /G langid /LIME logfile.txt

For more information about Microsoft Windows Installer, go to the MSDN™ Downloads Web site
(msdn.microsoft.com/downloads/).


http://msdn.microsoft.com/downloads

Removing BizTalk Server 2000

Use the Microsoft Windows 2000 Add/Remove Programs utility to remove Microsoft BizTalk Server 2000.

The following topic is covered in this section:

® Remove BizTalk Server 2000



Remove BizTalk Server 2000

1. On the Start menu, point to Settings and click Control Panel.
2. Click Add/Remove Programs.

3. Click Microsoft BizTalk Server 2000 and click Remove.
The Add/Remove Programs dialog box appears.

4. Follow the on-screen instructions and click Yes when prompted to remove BizTalk Server 2000.



Understanding Security

Microsoft BizTalk Server 2000 enables businesses to securely exchange data with trading partners. BizTalk Server takes advantage
of the security features offered through Microsoft Windows 2000 and Microsoft SQL Server security.

Windows 2000 security features include the following:

e Public-key infrastructure

e Microsoft Component Services
e Microsoft Cryptography API

e Smart Cards

e Kerberos Protocol

Public-key certificate management includes requesting certificates, processing certificates in a certificate-request response, and
exchanging certificates with trading partners. These certificates are available for both digital signature and encryption. Exchanging
certificates provides a method of securing data with trading partners. However, as a business grows, the process of managing
certificates can be time consuming.

Because BizTalk Server takes advantage of Windows 2000 security features, such as Secure Sockets Layer (SSL), Web pages can
be created and used by trading partners to securely exchange data using the Internet. SSL, which is implemented in Internet
Information Services (lIS), is a protocol designed to provide privacy between a Web client and a Web server. The protocol begins
with a handshake phase that negotiates an encryption algorithm, checks the keys (public and private), and authenticates the
server to the client. Once the handshake is complete and application data transmission begins, all data is encrypted using the
session keys negotiated during the handshake. Support for open PKI (public-key infrastructure) standards and secure protocols,
such as IPSec, L2TP, SSL/TLS, and S/MIME, enables a network to be extended to suppliers and partners quickly, while protecting
against impostors, data theft, or malicious hackers.

Component Services, one of Windows 2000's Administrative Tools, offers comprehensive component functionality, such as
automatic transaction support for data-integrity protection and simple, but powerful, role-based security.

The following topics are covered in this section:

e BizTalk Server 2000 Setup and Configuration

e Transport Services

Security for Applications That Host XLANG Schedule Instances

Certificates Overview

Crypto API

Collaborative Data Objects

Related Topic

Administrative Privileges



BizTalk Server 2000 Setup and Configuration

Trading partner transactions must be secure. Microsoft BizTalk Server 2000 addresses security by providing several
authentication and encryption components that leverage Microsoft Windows 2000 security services. In addition to Windows 2000
security, BizTalk Server also takes advantage of Microsoft SQL Server security. To keep data secure in the

BizTalk Messaging Management database, BizTalk Server relies primarily on SQL Server login security. However, the default
BizTalk Orchestration persistence database relies on Windows 2000 authentication. When creating a COM+ component that hosts
schedule instances and its persistence database, you can choose whether to use SQL Server authentication or Windows 2000
authentication. In addition, the administration console uses the Windows Management Interface (WMI) available in

Windows 2000 security.

The following topics are covered in this section:

® Logon Properties
e Local Policies
e Using a Service Account

e Submitting Work Items



Logon Properties

Logon properties are the initial layer of security for BizTalk Server 2000. These properties control a user's ability to log on to a
specific computer. Logon properties require a user to provide a user name and password prior to accessing resources, such as a
file share or message queue. Messages received through HTTP and SMTP also use logon properties to ensure security. For
example, an ASP page accessed through HTTP would require a user to enter a user name and password prior to displaying the
contents of the Web page.

BizTalk Server uses Internet Information Services (IIS) and ASP pages for its receive functions. ASP pages (actually the code
behind the pages) provide a layer of security for BizTalk Server by verifying signatures from Secure Sockets Layer (SSL) and
maximizing additional security, such as certificates, through IIS. For more information about IIS security, see Internet Information
Services in Windows 2000 Help.

Related Topic

Administrative Privileges



Local Policies

Local Policies, which is part of the Local Security Settings console, determine the security options for a user or service account.
Local policies are based on the computer a user is logged into, and the rights the user has on that particular computer. To set local
policies, on the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, double-click Local
Security Policy, and then expand the Local Policies folder.

Local policies define the privileges and rights for BizTalk Server 2000 users. Local Policies can be used to configure:

o Audit policy. Determines which security events are logged into the Security log on the computer (successful attempts,
failed attempts or both). (The Security log is part of Event Viewer.)

e Userrights assignment. Determines which users or groups have logon or task privileges on the computer.

e Security options. Enables or disables security settings for the computer, such as digital signing of data, Administrator and
Guest account names, floppy drive and CD ROM access, driver installation, and logon prompts.

Other policies in the Local Security Settings console can be configured to maintain the integrity of your data. For example,
Account Policies can be used to configure:

e Password policy. For local user accounts, determines settings for passwords such as enforcement, and lifetimes.

e Account lockout policy. For local user accounts, determines when and for whom an account will be locked out of the
system.

¢ Important

e Local policies, by definition, are local to a computer. When these settings are imported to a Group Policy object in Active
Directory, they will affect the local security settings of any computer accounts to which that Group Policy object is applied.
Therefore, it is important to note the order of precedence for security policies. Security policies associated with Group Policy
(Organizational Units) override policies established at the local level. Policies from the domain override locally defined
policies. In either case, user account rights may no longer apply if there is a local policy setting that overrides those
privileges. This is important because the behavior of Microsoft Windows 2000 can be quite different from the behavior in
Microsoft Windows NT. For example, when password policies are configured for the Domain group policy (as they are by
default), they affect every computer in that domain. This means that the local account databases (on individual workstations)
in the domain have the same password policy as the domain itself.

¥ Note

e Do not set Local Policies for public keys. Public keys provide security protection for BizTalk Server. Public keys are a
component of certificates that are used to encrypt and decrypt data. By adding additional policies to a public key, BizTalk
Server will not be able to use the associated certificate.

Related Topic

Administrative Privileges



Using a Service Account

A service account is similar to an interactive user account because they both enable a user to access computer and/or network
resources. A service account is a regular user account with specific properties that allow it to act as part of the operating system.
Whereas, an interactive user account refers to the user currently logged on during the BizTalk Server 2000 setup process.

If the identity is set to interactive user, the application runs only when a user is logged on. Therefore, if BizTalk Server is set up
with an interactive user account, it fails if the specified user logs off from the server. Choosing interactive user identity, though,
carries security risks, because the application runs under the identity of the logged-on user without that user's knowledge or
consent. For instance, if the application is running on a computer while an administrator is logged on, the application runs under
the administrator's identity, potentially making calls as such on behalf of clients.

If the identity is set to a service account, it can act as part of the operating system and allow users to access applications on a
server even when the user is not logged on to the computer.

For more information about service accounts, see Create a service account.
Related Topic

Create a service account



Submitting Work Items

Controlling a user's ability to send work items to BizTalk Server 2000 can be accomplished using the BizTalk Server Interchange
Application COM+ component. The BizTalk Server Interchange Application COM+ component uses the following security
configuration properties:

e Authentication level

Impersonation level

Access permissions

Launch permissions

e Configuration permissions

To control a user's ability to send work items, a role must first be added to the BizTalk Server Interchange Application, which is
one of the COM+ applications, and then associate the role with the Submit and SubmitSync methods.

The following topics are covered in this section:
e Add a role to the BizTalk Server Interchange Application
e Associate a new role with the Submit and SubmitSync methods

Related Topic

Administrative Privileges



Add a role to the BizTalk Server Interchange Application

1.

On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

The Component Services console appears.

2. Expand Component Services, Computers, My Computer, and COM+ Applications.
3. Right-click BizTalk Server Interchange Application and click Properties.
The BizTalk Server Interchange Application Properties dialog box appears.
4. Click the Advanced tab and, in the Permission area, clear the Disable changes check box, click OK, and then in the
message dialog box, click Yes.
5. Repeat step 3.
6. Click the Security tab and, in the Authorization area, select the Enforce access checks for this application check box.
7. In the Security level area, click Perform access checks at the process and component level. Security property will
be included on the object context. The COM+ security call is available.
8. Click OK.
9. In the message dialog box, click Yes.
10. Expand BizTalk Server Interchange Application.
11. Double-click the Roles folder, right-click the folder, point to New, and then click Role.
The Role dialog box appears.
12. Type a name for the role and click OK.
13. In the message dialog box, click Yes.
14. Expand the role you just created, double-click the Users folder, right-click Users, point to New, and then click User.
15. In the Select Users or Groups box, type the full name of the user you want to add.
16. When you have finished adding user accounts to the role, click OK.
¥ Note

e For each user account or group assigned to the role, an icon appears in the Users folder. The new role membership will be

activated when the application is started.

Related Topic

Shut down the BizTalk Server Interchange Application



Associate a new role with the Submit and SubmitSync methods

1.

On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

The Component Services console appears.

2. Expand Component Services, Computers, My Computer, COM+ Applications, BizTalk Server Interchange
Application, Components, BizTalk.Interchange.1, Interfaces, linterchange, and Methods.

3. Right-click Submit and click Properties.
The Submit Properties dialog box appears.

4. Click the Security tab.

5. In the Roles explicitly set for selected item(s) area, select the check box for the role you just created in
the Add a role to the BizTalk Server Interchange Application procedure and click OK.

6. Right-click SubmitSync and click Properties.
The SubmitSync Properties dialog box appears.

7. Click the Security tab.

8. In the Roles explicitly set for selected item(s) area, select the check box for the role you just created in
the Add a role to the BizTalk Server Interchange Application procedure and click OK.

¥ Note

e Anew role for the BizTalk Server Interchange Application must first be created before the Submit and SubmitSync

methods can be associated with it.

Related Topic

Shut down the BizTalk Server Interchange Application



Transport Services

Microsoft BizTalk Server 2000 supports a core set of transport services. These transport services enable the server to send
documents to organizations or applications whether or not the applications are capable of communicating directly with the server
by using a COM interface. BizTalk Server supports the HTTP, HTTPS, and SMTP network protocols and Message Queuing.

The following topics are covered in this section:

o HTTP and HTTPS
e SMTP
® Message Queuing 2.0

e File
Related Topics

Select a transport type

Set Transport Properties



HTTP and HTTPS

HTTPS is used to provide strong authentication when using HTTP to gain access to content on the Web. The most common use of
HTTPS is to provide an encrypted connection to an authenticated Web server. When clients attempt to establish an HTTPS
connection, typically triggered by browsing to a URL beginning with https://, the client and server jointly negotiate a security
protocol to use and then exchange authenticating information.

Microsoft Internet Explorer 5 or later supports common secure communication protocols for HTTP transactions, including the
following:

e Transport Layer Security (TLS version 1.0)
e Secure Sockets Layer (SSL versions 2 and 3)

e Private Communications Technology (PCT version 1.0).

Each protocol provides both encryption services (for confidentiality of exchanged data) and authentication services (for mutual
identification between clients and servers). SSL support, which is provided through the built-in HTTPS transport service, adds
server-to-server authentication and transport layer encryption to an interchange.

BizTalk Server and HTTPS can be used to securely exchange data within an organization or with a trading partner by means of
HTTP. The following provides specific details regarding how BizTalk Server 2000 uses HTTP and HTTPS to send and receive data.

Send

The HTTP and HTTPS transport services can be used to secure data that is sent to an application or trading partner. Security for
these transport services relies on certificates.

For example, prior to sending data over HTTP, a BizTalk Server administrator sends a copy of the client certificate to a trading
partner. The trading partner retains a copy of the certificate in the BizTalk store. In the future, the certificate is used to authenticate
the trading partner sending data. A unique certificate manager must be created to send or export a certificate to a trading partner.

Receive

To secure data over HTTP, BizTalk Server uses Microsoft Internet Information Services (IIS) and ASP pages. When using HTTPS to
connect to IIS, the client and browser negotiate a common protocol to secure the channel. In cases where the server and client
have multiple protocols in common, IIS secures the channel with a supported protocol, such as SSL. To secure data that is received
by BizTalk Server over HTTP, the process is identical. The ASP page serves as the gateway for sending data to BizTalk Server. If the
data is secure, BizTalk Server receives the data provided the ASP code uses the Submit method or the SubmitSync method to
make a call.

Related Topics

Select a transport type

Set Transport Properties



SMTP

SMTP (Simple Mail Transfer Protocol) is a protocol for sending e-mail messages between servers. SMTP is a common protocol for
sending mail over the Internet. An e-mail message can be retrieved with an e-mail client using either POP or IMAP. In addition,
SMTP is used to send messages from a mail client to a mail server. When configuring an e-mail application, both the POP or IMAP
server and the SMTP server must be specified.

SMTP can be used to securely exchange data within an organization or with a trading partner. BizTalk Server 2000 uses SMTP to
send and receive data using the following methods:

Send

BizTalk Server implements a transport protocol to send data over SMTP. At a minimum, SMTP requires that data be MIME-
encoded. This process enables BizTalk Server to identify where a set of data ends and the next set of data begins. However, MIME-
encoding does not provide security. S/MIME is the secure MIME version. Documents encoded using built-in S/MIME encoding
components ensure document integrity, authentication of the sending party, and payload encryption. BizTalk Server creates an
S/MIME document with the encrypted message as the body of the document. To add this security layer, a certificate must be
associated with the MIME-encoded message. MIME encoding can be specified when messaging ports are created in

BizTalk Messaging Manager. This is also where certificates are specified.

Receive

To implement security on the receive side of SMTP using Microsoft Exchange Server, an administrator must create a receive
account for BizTalk Server. Once the account is set up, trading partners send their public keys to Exchange Server, which
authenticates the sender (trading partner). The public key is added to the Exchange Server certificate store.

When Exchange Server receives a message, the Submit method sends the data to BizTalk Server. BizTalk Server verifies the
certificate against the public key; if they match, BizTalk Server decrypts the data and processes the document.

Related Topics

Messaging Port Elements
Select a transport type
Select an encryption certificate

Set Transport Properties



Message Queuing 2.0
Message Queuing 2.0 supports privacy and security using the following:

® Access control
e Auditing
e Encryption

o Authentication

Message Queuing also takes advantage of the Kerberos V5 security protocol available with Microsoft Windows 2000. In addition,
Message Queuing supports 128-bit encryption as well as 40-bit encryption. Message Queuing can also be used to integrate
applications, implement a push-style business-event delivery environment between applications, and build reliable applications
that work over unreliable but cost-effective networks.

Message Queuing can be used to securely exchange data within an organization and with a trading partner. BizTalk Server 2000
uses Message Queuing to send and receive data using the following methods:

Send

The first layer of security for Message Queuing is a user name and password, which is required by anyone to store data or
retrieve data from Message Queuing. In addition, Message Queuing can store data that has a certificate. Users are able to specify
a certificate for data stored on a message queue using BizTalk Messaging Manager.

Receive

If an administrator creates logon properties for a message queue, a user name and password must be used to retrieve the data.
Creating logon properties forms a fundamental layer of security. If a trading partner has added a certificate to the data, a copy of
its private key must be received to decrypt the data before BizTalk Server can process the package.

Related Topics

Add a Message Queuing receive function

Configure advanced properties for File or Message Queuing receive functions
Configure a Message Queuing receive function: General tab

Configure a Message Queuing receive function: Services tab

Select a transport type

Set Transport Properties



File

Microsoft Windows 2000 ensures data and system protection by defining discretionary file access control. The Windows NTFS file
system, required for BizTalk Server 2000, can prevent users from damaging key system or application files. NTFS also provides
robust security for the supporting files in an application.

File storage can be used to securely exchange data within an organization and with a trading partner. File storage can also be
used to send and receive data using the following:

Send

The first layer of security for file storage is a user name and password. A user name and password is required by anyone storing
or retrieving data from a folder. In addition, folders can store data that has a certificate associated with it. To use this added layer
of security, use BizTalk Messaging Manager to create a certificate for the data to be stored in a folder.

Receive

If logon properties for a folder have been applied, a user name and password must be used to retrieve the data. An administrator
can also designate access levels (read, delete, and so on) to the file directory for specific users. If a trading partner has added a
certificate to the data, a copy of its private key must be received to decrypt the data before BizTalk Server can process the package.
Inbound documents can also be digitally signed to ensure that the sending source cannot deny that it sent the document.

Related Topics

Add a File receive function

Configure advanced properties for File or Message Queuing receive functions
Configure a File receive function: General tab

Configure a File receive function: Services tab

Select a transport type

Set Transport Properties



Security for Applications That Host XLANG Schedule Instances

After installing BizTalk Orchestration Services, security levels can be set for the following:

e Creating new XLANG schedule instances
e |Interacting with existing XLANG schedule instances
e Administrative functions relating to XLANG schedule instances

e Applications hosting XLANG schedule instances.

Applications that host XLANG schedule instances rely on role-based security, which is an automatic service provided by COM+.
Role-based security enables users to construct and enforce an access control policy for COM+ applications. With a flexible and
extensible security configuration model, role-based security offers considerable benefits over enforcing all security within
components. There are two default COM+ applications, the XLANG Scheduler and the XLANG Scheduler Persistence Helper,
which are automatically created when BizTalk Orchestration Services are installed. The XLANG Scheduler COM+ application has
four roles that can be used to ensure the security of schedule instances regardless of the COM+ application in which they execute.
The four roles are:

o XLANG Schedule Creator. This role allows specified users to create XLANG schedule instances. For instance, if an
administrator wants a user to be able to create an XLANG schedule instance, the administrator must add the user to the
membership list for this role. Any user who is not listed as a member of this role and attempts to create an XLANG schedule
instance will see an error message indicating that access has been denied. In addition, an entry is generated in the event log
indicating that access has been denied.

o XLANG Schedule User. This role allows specified users to interact with XLANG schedule instances. For instance, if an
administrator wants a user to be able to interact with an schedule instance, the administrator must add the user to the
membership list for this role. Any user who is not listed as a member of this role and attempts to interact with a schedule
instance will see an error message indicating that access has been denied. In addition, an entry is generated in the event log
indicating that access has been denied.

o XLANG Scheduler Administrator. This role can be used to indicate who has administrative rights to the following tasks:
e Determining whether a COM+ application is able to act as a host for XLANG schedule instances.

e Setting the DSN type for a COM+ application that is hosting XLANG schedule instances and setting the state
management value for the level of persistence the COM+ application needs to support.

e Shutting down all XLANG schedule instances.

e Suspending, resuming, or terminating an XLANG schedule instance.

o XLANG Scheduler Application. This role is used by the XLANG Scheduler to interact with any COM+ application that a
user creates. Therefore, the role must include the same identity that the COM+ application is using to run.

The following topics are covered in this section:

® Best Practices for Securing COM+ Applications
e Securing the Orchestration Persistence Database

e Confirming the Sender's Identity

Related Topic

XLANG Schedules



Best Practices for Securing COM+ Applications

Using roles, an administrator can administratively construct an authorization policy for an application, choosing (down to the
method level, if necessary) which users can access which resources. Because all XLANG schedules are hosted in COM+ server
applications, access to the installed COM objects can be limited by configuring security properties for various roles.

¢ Important

o If security properties are added at the component level, individual components, interfaces, and methods based on the role
settings at these levels are also limited. For more information about COM+ security, go to the MSDN Online Library Web
site (msdn.microsoft.com/library/defaultasp), and browse to the Security in COM+ page.

Recommendations for securing COM+ applications
The following recommendations apply primarily to securing deployed applications:

o Do not configure a COM+ application as an interactive user. COM+ applications that use the interactive user identity
can be used only if a user is logged on to the computer where the application resides. If no one is logged on, the COM+
application cannot run. In addition, if a user creates a COM+ application using interactive user, it will be more difficult to
configure access to its persistence database and other resources. For more information about service accounts,
see Using a Service Account.

o Reconfigure the identity for XLANG Scheduler. During setup, the XLANG Scheduler identity is automatically configured
as Interactive User. This configuration is suitable for most developers. On production systems, you should change the
identity property for the XLANG Scheduler so that the application runs under a unique user account. The identity is used by
all messages sent by the XLANG Scheduler.

¥ Note

e When using the client for Microsoft Windows 2000 Terminal Services to initiate an XLANG schedule, the COM+
application hosting the XLANG Scheduler Engine must have its identity set to a valid Windows 2000 user or group
name. The identity of the COM+ application is set on the ldentity page of the properties dialog box for that
application. The identity cannot be set to interactive when using the XLANG Scheduler Engine through a session
hosted by Terminal Services.

e Create a new COM+ application with a unique identity for every application that is hosting XLANG schedule
instances. Create a new COM+ application with a unique identity for each business process, such as purchasing, with
unique security requirements. This enables individual security levels to be specified for each application. In addition, it
safeguards from excessive damage that can be done by unstable application code and makes it easier to audit the
operations of individual applications.

o Install application-specific components into their associated business processes. This protects data and keeps out
applications that do not have access to these components, provided the server application is adequately protected.
¥ Note

e Each COM+ application must contain at least one component. If an application-specific component is not installed, a
placeholder component in the application must be created and installed, or the COM+ application will not be
available.

e Change the membership list of the XLANG Scheduler roles from their defaults to provide added security. When
BizTalk Server is installed, the XLANG Scheduler is created and configured with the following roles, shown with their default
settings:

e XLANG Schedule Creator. Membership role defaults to Everyone.

o XLANG Schedule User. Membership role defaults to Everyone.
o XLANG Scheduler Administrator. Membership role defaults to Administrators.

e XLANG Scheduler Application. Membership role defaults to Everyone.

Related Topics
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Change the application identity for the default XLANG Scheduler application
Create a COM+ application to host XLANG schedules
XLANG Schedules



Securing the Orchestration Persistence Database

When a COM+ application that hosts XLANG schedule instances is created, a persistence database must be associated with the
COM+ application. Therefore, first create a persistence database in Microsoft SQL Server. When creating a database, a user must
choose whether to use SQL Server authentication or Microsoft Windows 2000 authentication for security. After creating the
database, a user needs to give permission rights to the COM+ application that will be created later to host XLANG schedule
instances. Make sure that the COM+ application has permissions to both create tables and create procedures to the persistence
database associated with it. The interaction between the BizTalk Orchestration Services and the default BizTalk Server
Orchestration Persistence database is based on the Windows 2000 security model rather than on SQL Server.

Related Topic

Manage the Default XLANG Scheduler Application and Database



Confirming the Sender's Identity

During schedule design, various shapes can be used to describe implementation technologies used to implement a portin a
business process. The COM Component shape represents a technology that can be used to implement a port by using a method
call for each message that is sent or received. The Script Component shape represents a technology that can be used to
implement a port by using a method call for each message that is sent or received. The Message Queuing shape represents a
technology that is used to implement a port. Message Queuing transport services are used to send or receive messages. When
adding one of the three technologies, a user can require that the sender's identity be confirmed prior to receiving messages.

For more information about COM components, Windows Script components, or Message Queuing security for XLANG schedules,
see Implement a port by using a COM component, Implement a port by using a Windows Script Component,
and Implement a port by using Message Queuing.

Related Topics

Using the COM Component Shape
Using the Message Queuing Shape

Using the Script Component Shape



Certificates Overview

Digital certificates bind a cryptographic key with one or more attributes of a user. Issued by certification authorities, the
certificates protect the Internet by assuring the authenticity of network messages. This technology and its underlying digital
signatures are now helping to increase the widespread deployment of electronic commerce on the Internet.

The following topics are covered in this section:

e Understanding Certificates
o Certificates Needed by BizTalk Server

e Certificate Name Restrictions



Understanding Certificates

Microsoft BizTalk Server 2000 relies heavily on the security provided by certificates. Through the use of public keys, which encrypt
the data, and private keys, which enable the data to be decrypted, BizTalk Server can send data that can be trusted and can ensure
that the data it processes is secure. Public Key Policies, which are part of the Microsoft Management Console, enable a user to
configure encrypted data recovery agents for Encrypting File System (EFS), domain-wide root certificate authorities, trusted
certificate authorities, and so on. Certificates also contain digital signatures, which can be applied to documents and verified on
inbound documents using the BizTalk Server native support for digital signatures.

Certificates are used to authenticate and secure exchanges of information on non-secured networks, such as the Internet.
Certificates can be managed for a user, a computer, or a service. The X.509-based Public Key Certificate Server built into Windows
2000 Server lets organizations issue public-key certificates for authentication to their users, without depending on commercial
Certification Authority (CA) services.

BizTalk Server supports certificates through BizTalk Messaging Manager. Certificates make it easy to encrypt, decrypt, and digitally
sign data. Public-key encryption technology is supported for all documents that are transmitted using BizTalk Server
transport services. BizTalk Server also supports decryption and signature verification for the documents that it receives.

MachineKeys versus UserKeys

When obtaining certificates, it is best to use MachineKeys, which are associated with the computer, rather than UserKeys, which
are associated with the current, logged on user. If a user, currently logged onto a server, obtains a certificate with UserKeys only
that user can access the certificate because the certificate UserKey contains the user's logon information. Therefore, if users need
to access certificates with UserKeys in BizTalk Server, BizTalk Server must be run in the context of that user. To enable any user to
log onto BizTalk Server and access keys, certificates must have MachineKeys.

For BizTalk Server to access the Certificates (Local Computer), BizTalk Server must run as LocalSystem or Administrator.
Additionally, if UserKeys are used, BizTalk Server must run in the context of that user, who also must be an administrator.



Certificates Needed by BizTalk Server

A certificate server stores certificates for a user and for a computer. Every user has a certificate store, and every computer has its
own certificate stores. If a user creates a certificate, Windows 2000 assumes the certificate is for the user. An organization needs
to store its certificates in the Personal store located under the Certificates (Local Computer) of the Certificates console. However,
to provide the proper security, BizTalk Server 2000 needs all trading partner certificates to be stored in the BizTalk store located
under the Certificates (Local Computer) of the Certificates console.

During design time, when messaging ports and channels are created, a user needs to have all trading partner certificates
associated with the BizTalk store, under Certificate (Local Computer) of the Certificates console, rather than with the user. When
specifying security, such as encryption or signature verification, for trading partners through the BizTalk Messaging Manager, the
certificates displayed are the trading partner certificates located in the BizTalk store. BizTalk Messaging Manager displays the
certificates located in the Personal store under Certificate (Local Computer) of the Certificates console when specifying security,
such as verified decryption and signing, for SSL clients. Where certificates are located is important because at run time, when a
user attempt to process documents through BizTalk Server, the computer is acting as the background service, and it is this service
that needs to access the certificates.

There are two ways to resolve issues about where certificates are stored:

e |If a user has already created certificates, Windows 2000 has stored them in the user store. The certificates must be moved
from the user store to the corresponding store under Certificates (Local Computer). This process is done through the
certificate manager.

e |f a user has created a service account, all the certificates are associated with the computer, rather than with the user.

Certificate management through Windows 2000

BizTalk Server provides certificate management through Microsoft Windows 2000. Tightly integrated within the Windows 2000
security model is IIS 5.0, which includes a certificate server. This lets organizations issue and manage Internet-standard X.509
digital certificates. In addition to key management services in IIS 5.0, the Microsoft certificate server in IS 5.0 provides
customizable services for issuing and managing digital certificates. A certificate server performs a central role in the management
of software security systems to enable secure communications across the Internet, corporate intranets, and other non-secure
networks.

The following topic is covered in this section:

o Create a certificate manager

Related Topics

Select a certificate for outbound signature
Select a certificate to verify inbound document decryption
Select a certificate to verify inbound document signature

Select an encryption certificate



Create a certificate manager

1. On the Start menu, click Run and type mmc.
The Console1 dialog box appears.
2. On the Console menu, click Add/Remove Snap-in.
The Add/Remove Snap-in dialog box appears.
3. Click Add.
The Add Standalone Snap-in dialog box appears.
4. Click Certificates and click Add.
The Certificates snap-in dialog box appears.

5. Click Computer account, click Next, and then click Finish.

6. In the Add Standalone Snap-in dialog box, click Certificates and click Add.
The Certificates snap-in dialog box appears.

7. Click Computer account, click Next, click Finish, click Close, and then click OK to close the dialog boxes.

Related Topic

Certificates Overview



Certificate Name Restrictions

Microsoft BizTalk Server 2000 does not allow identical names for certificates. If identical names for certificates exist, only one of
the certificates can be selected in BizTalk Messaging Manager. For example, if an organization uses two certificates that have the
same name and reference, it is impossible for the organization to use both certificates. If the organization uses one of the
certificates, the other certificate disappears from the list of available certificates in the Channel dialog box.



Crypto API

Microsoft BizTalk Server 2000 uses Crypto API to secure data it processes. Recent developments in cryptography have added
additional uses, including mechanisms for authenticating users on a network, ensuring the integrity of transmitted information,
and preventing users from denying ownership of their transmitted messages.

Any application, message, data, and so on that uses encryption and uses Microsoft-specific encryption, such as Microsoft
Windows 2000 for generating certificates, uses Crypto API. BizTalk Server uses Crypto API for receive functions that a user
specifies when using a custom-made COM+ component such as preprocessing component, which enables BizTalk Server to
handle unique encryption components.



Collaborative Data Objects

Microsoft BizTalk Server 2000 requires MIME encoding for all its data, whether sending the data or receiving it. Through the use
of Collaborative Data Objects (CDOs), which are part of the Windows 2000 environment, data can be encoded and processed by
BizTalk Server. For example, before BizTalk Server can send a catalog that contains text and graphics, it first needs the data
(graphics) to be changed from binary to string. CDOs encode the text and graphics into a string format so that BizTalk Server can
process it.



Enhancing Performance and Scalability

Understanding the various components of BizTalk Server 2000 enables you to create scalable, high performance solutions. There
are several methods, such as identifying potential bottlenecks, addressing latency, and managing databases, which you can use to
increase the performance of BizTalk Server. However, the extent to which you can achieve an optimal solution depends on the
complexity of your organization's system architecture and your budget requirements.

Optimizing the BizTalk Messaging Management database, the Shared Queue database, the Tracking database, and the
Orchestration Persistence database is critical to achieving optimal performance with BizTalk Server. For more information about
optimizing the databases, see Scale Up the Databases and Scale Out the Databases.

The following topics are covered in this section:

e Scaling BizTalk Server

e Performance Optimization



Scaling BizTalk Server

To optimize performance, it is highly recommended that you distribute key components across multiple servers. The key
components of BizTalk Server 2000 include:

e BizTalk Services. These services include BizTalk Messaging Services and BizTalk Orchestration Services. For more
information, see BizTalk Services.

e Databases. These databases include the BizTalk Messaging Management, Tracking, Shared Queue, and
Orchestration Persistence databases.

o Transport services. The transport services include HTTP, File, SMTP, and Message Queuing. Each component has unique
scaling requirements.

The following topics are covered in this section:

e Scaling BizTalk Server Vertically

e Scaling BizTalk Server Horizontally

Related Topics

Managing BizTalk Server Databases

Managing the BizTalk Messaging Management Database
Persistence

Set Transport Properties

Shared Queue Database

Tracking Database



Scaling BizTalk Server Vertically

By using multiple processors and significant memory, you can vertically scale (scale up) BizTalk Server 2000. Scaling BizTalk
Server vertically requires fewer servers and simplifies site management, but is more costly than scaling a system horizontally or
improving software architecture. In addition, once capacity on existing hardware is maximized, you must begin to scale the system
horizontally.

The following topics are covered in this section:

e Scale Up BizTalk Server
e Scale Up the Databases

e Scale Up the Transport Services



Scale Up BizTalk Server
To scale BizTalk Server 2000 vertically, the following are recommended:

e Increase the processor size (such as the Pentium Il and its Xeon derivatives with large level Il caches).
e Use symmetric multiple processing (SMP) servers that accommodate up to eight CPUs.
e Decrease file I/0 and network bottlenecks.

e Run Microsoft Windows 2000 Server on four-way SMP servers.
¥ Note

e When running Microsoft Windows 2000 Server on one CPU, adding three additional CPUs improves performance,
but does not increase the processing speed of one CPU by a multiple of four.

Recommended solutions for scaling BizTalk Server vertically
To achieve optimal performance with BizTalk Server, the following is recommended:

o A multi-processor Plll Xeon MHz processor system (the highest MHz possible for maximum performance), capable of being
upgraded to eight CPUs.

® A 1-to2-MB L2 Processor Cache (increases parsing performance).
e 512 MB of RAM (more if an organization is processing multiple megabyte documents).

e Multiple 100 Mbps (megabits per second), or greater, network cards connected to 100 MB/s switch ports to increase
network I/O throughput.

e Provide multiple disks and controllers for Message Queuing and Distributed Transaction Coordinator (DTC) file and log
operations. Write DTC log operations to a central remote server to offload file I/O contention on the local BizTalk Server.

e Use dual honed network interface cards (NICs) in the BizTalk Servers to separate HTTP processes from the Shared Queue
and BizTalk Messaging Management databases dedicated SQL Server processes.

e These recommendations assume that BizTalk Server is running on a dedicated server. If the BizTalk Services are sharing the
server with other application services, additional hardware is recommended.



Scale Up the Databases

To vertically scale the databases, you must determine the disk configuration. To determine the disk configuration, you must
consider throughput, fail-over, and cost.

The following table identifies the options available and compares each option relative to each other.

RAID level |Cost |Effective disk utilization percentage Spe |Fault tolerance
ed
0 (Striping) Low (100 Fast |Low
1 (Mirroring) |High |50 Medi|High
um
5 (Striping wit|Mode |Effective disk space is the total space of all disks in the arra|Slow |Moderate (only because performance degr
h parity) rate |y combined minus 1 (for parity) ades with a failed disk)

To achieve optimal performance, it is recommended that you install an efficient caching Redundant Array of Independent Disks
(RAID) controller with a fast CPU and a high amount of RAM that is nonvolatile. You can also combine multiple RAID levels to
achieve desired performance. For example, RAID 0 provides the best performance, but does not provide fault tolerance. RAID 1
provides the best fault tolerance, but does not provide the best performance (due to writing data to one disk, as opposed to

multiple disks, concurrently). To achieve optimal performance, you can combine RAID 1 and RAID 0 by mirroring a set of striped

disks.

[# Notes

e RAID 5 does not meet or exceed the speed or cost of any other RAID level. RAID 5 provides key advantages, but is slower
when writing data to disk than RAID 0 or RAID 1.

e For any strategy, the number of available disk controllers is critical. You can significantly improve overall performance by

using one disk per controller. When configuring disks, effectively using disk channels is equally important. Disk channels are
disks that share the same controller. These disks may be configured as stand-alone disks, or configured to run as part of an

array. For example, if there are 10 disks in a server, 5 disks each in two arrays, and each array is connected to its own
controller, there would be 2 disk channels.

Ideally, the BizTalk Messaging Management, Shared Queue, Tracking, and Orchestration Persistence databases should be on
separate disk channels. However, if your organization's system environment requires that the databases reside on individual
servers, it is important to understand the use of each database when planning for this deployment scenario:

e The BizTalk Messaging Management database contains all the configuration information, such as organizations,

server groups, servers, channels, and messaging ports, for BizTalk Server. This information is read and cached in Microsoft
SQL Server memory. This database receives the least activity of the four databases and can reside on the same disk channel
as one of the other three databases if necessary.

The Shared Queue database manages the data for all the queues. Every document that uses asynchronous communication
is sent to and stored in the Shared Queue database. When BizTalk Server is ready to handle the document, it is removed
from the Shared Queue database for processing. Because this database manages all transactions, data is written to and read
from the Shared Queue database frequently.

The Tracking database tracks documents that pass through the server, either individually or in batches. This database stores
both the data and its logging information. Therefore, data is often written to the Tracking database, but data is rarely read
from the database.

The Orchestration Persistence database stores the structure of the XLANG schedules, progress of activated
XLANG schedule instances, and messages that are sent or received when an XLANG schedule instance begins or completes
a transaction, the system is shut down, or when the XLANG schedule instance is dehydrated.

Optimization recommendations to vertically scale the databases

Consider the following for optimal performance of BizTalk Server databases:

e A multi-processor Plll Xeon MHz processor system (the highest MHz possible for maximum performance), capable of being

upgraded to eight CPUs.



e 512 MB of RAM (more if an organization is processing multiple megabyte documents).

e Optimize the underlying Microsoft SQL Server databases and logs based on standard database best practices. For more
information about SQL Server, on the Start menu, point to Programs, point to Microsoft SQL Server, and then click Books
Online.

e If you initially plan to complete only a few transactions, you can install the databases on the same disk I/O channel. As more
transactions are being processed, add disks and/or controllers to a server and move the databases to these new disk I/O
channels. Additionally, an individual database can be moved to a new server. For more information about scaling the
databases horizontally, see Scale Out the Databases.

To optimize the BizTalk Messaging Management database:

o |nstall the database on the same disk I/0 channel as the Shared Queue database or the Tracking database. The contents of
the BizTalk Messaging Management database are read and cached in Microsoft SQL Server memory.

e |f an organization processes a high volume of data, consider placing this database on its own disk I/O channel so as not to
hinder the performance of the Shared Queue or the Tracking databases.

To optimize the Shared Queue database:

o |f the CPU exceeds 80 percent, add additional CPUs.

o |[f disk queue length averages more than 1 or, if disk I/O utilization is greater than 100 percent, add additional physical disks.
e |Install the database on its own dedicated disk I/O channel.

e Purchase disks with the fastest access times, and controllers with the highest throughput.

e Consider RAID 0 and mirror it to obtain fault tolerance.
To optimize the Tracking database:
e Add more physical disks and additional disk space than currently exists on the Shared Queue database.
e Estimate the average document size for a single transaction. Multiply the document size by the number of times the
document will be logged to the Tracking database. This estimate suggests the amount of document storage space required
per document in the Tracking database. Multiply the document storage space value by the throughput requirement to

determine the amount of space needed before the Tracking database becomes full. Ensure that the Tracking database has
adequate space to accommodate logging an average document size.

e |Install this database on its own disk I/O channel due to the high volume of data that is written to it. A separate disk /O
channel is particularly important in heavy transaction environments.

¥ Note

e There is size limit for tracking interchanges and documents, which if exceeded, greatly affects the performance of
BizTalk Server. For more information about the size limit, see Interchange and document size limit.

To optimize the Orchestration Persistence database:
e Because data is written to and read from this database frequently, the database should have a dedicated disk 1/0 channel. It
is best to purchase disks with the fastest access times, and controllers with the highest throughput, if possible. Consider
RAID 0 and mirror it to achieve fault tolerance.
o |f the CPU capacity exceeds 80 percent, add more CPUs.

o |[f the disk queue length averages more than 1, or if disk I/0 utilization is greater than 100 percent, add more physical disks.

Related Topic



Scaling BizTalk Server



Scale Up the Transport Services

BizTalk Server 2000 supports four transport services. Each of these transport services can be scaled vertically:

e HTTP
e File
e SMTP

® Message Queuing
The following topics are covered in this section:

e HTTP/HTTPS (Scale Up)
® File (Scale Up)
o SMTP (Scale Up)

® Message Queuing (Scale Up)



HTTP/HTTPS (Scale Up)

Receive

The HTTP/HTTPS receive function sends documents to BizTalk Server 2000 by calling the BizTalk Server Interchange object.
BizTalk Server does not have a unique HTTP/HTTPS receive function. The HTTP receive function calls a local object. Therefore, no
network latency exists to affect performance. However, because the HTTP receive function and BizTalk Server both reside on the
same server, the HTTP receive function must perform two functions: transport data and process data.

In high-volume environments, running the HTTP receive function and BizTalk Services on the same server degrades the
performance of both. Additionally, if secure sockets layer (SSL, also referred to as HTTPS) is used to receive documents,
performance is degraded further due to decryption processing. Depending on the security needs of an organization, data may
need to be encrypted using HTTPS. This added level of security may affect the performance of BizTalk Server.

Send

BizTalk Server is a native HTTP/HTTPS client. If a channel is configured to use HTTP/HTTPS as its outbound transport service,
BizTalk Server uses HTTP/HTTPS to send data to a trading partner's HTTP/HTTPS server. You cannot move the HTTP/HTTPS
outbound transport service to a separate server from the server on which BizTalk Messaging Services resides. If a server is
configured to participate in work-item processing and it processes a document that uses an HTTP/HTTPS transport service, this
same server sends the document. For more information about work-item processing, see Scale Up BizTalk Server.

BizTalk Server functions as an HTTP client, which affects the document-serializing power of the server. If the port is using HTTPS,
the performance of the HTTP transport service is greatly affected. SSL accelerator cards cannot be used when acting as an HTTPS
client because these cards only enhance HTTPS server performance.

Recommended optimization for HTTP/HTTPS
To optimize performance for the HTTP/HTTPS, which enhances the performance of BizTalk Server:

e Configure the inbound HTTP/HTTPS receive service on a separate server than BizTalk Server. If the inbound HTTP/HTTPS
receive service cannot be installed on a separate server than BizTalk Server, use a faster CPU or, add more CPUs.

® Increase the CPU MHz that is required for BizTalk Server (to accommodate the additional need for sending documents) and
add additional CPUs until the desired performance level is achieved.

e Apply best practices when using ASP pages with the receive or send HTTP/HTTPS service. For more information about
optimizing ASP pages and Internet Information Services, go to the Internet Information Services Help Web site
(localhost/iisHelp) and click Active Server Pages Guide.


http://localhost/iisHelp/iis/misc/default.asp

File (Scale Up)

Receive

Although performance is high when using a File receive function for business-to-business transactions, a File receive function is
not secure for Internet-based transactions, and therefore is not widely used. However, for application-to-application transactions
within a corporation, a File receive function can provide optimal performance without jeopardizing security. In addition, a File
receive function can be used securely with external trading partners provided it is combined with another receive function, such
as SMTP or HTTP. The SMTP or HTTP receive function can accept a document from a trading partner (using HTTPS or S/MIME for
security) and write the file to an internal file system directory. Then BizTalk Server can use a File receive function to receive the
document. This combination of transports may not increase performance, but will provide greater flexibility and security.

¥ Note

e Using S/MIME significantly degrades the performance of BizTalk Server.

Send

The security and performance issues detailed for a File receive function are also applicable for sending documents using a File
transport service.

Recommended optimization for File receive function and File transport service

To optimize performance for the File receive function and File transport service, which enhances the performance of BizTalk
Server:

e Use a local file directory rather than a remote file directory to reduce network latency.

e Use disk arrays to achieve high throughput. For more information about disk array speed and redundancy tradeoffs,
see Scale Up the Databases.



SMTP (Scale Up)

Receive

The SMTP receive function is similar to the HTTP receive function for inbound transactions in that there is no native SMTP receive
function built into BizTalk Server. An SMTP receive function can receive a document through an event-based mechanism and send
the document to BizTalk Server. If an SMTP receive function exists, BizTalk Server accepts the MIME/SMIME-encoded document
and prepares it for processing.

Send

The same security and performance issues listed in the inbound S/MIME and outbound HTTP/HTTPS sections apply here. If a
channel uses SMTP as a transport service in a messaging port or port, the processing server processes the document and sends it
to the receiving application.

¥ Note

e BizTalk Server performance is significantly degraded if a digital certificate is needed to S/MIME-encode the outbound
document.

Recommended optimization for SMTP
To optimize performance for SMTP, which enhances the performance of BizTalk Server:

o The performance level achieved depends greatly on the SMTP service that is used for receiving documents. An organization
may have an SMTP server that is used to perform this function. However, if an SMTP server does is not available and an
organization chooses to use Microsoft Exchange Server or another third-party messaging system, the server may need a
significant amount of additional hardware to maintain an adequate performance level for BizTalk Server. The SMTP server
must be able to invoke an event-based mechanism, which is capable of sending documents to BizTalk Server.

e |f an organization chooses to run BizTalk Server on a SMTP server, CPU performance will be impacted. To minimize the
impact to performance, use a faster CPU.

e |f an organization uses S/MIME, BizTalk Server performance is significantly degraded. To reduce the overall performance
impact of S/MIME to BizTalk Server, use faster CPUs.



Message Queuing (Scale Up)

Receive

Message Queuing generally uses a high volume of disk I/0 to receive and send messages. Message Queuing is transactional,
which is highly recommended to improve fault-tolerance. However, it is only transactional on a local server. If Message Queuing
is used to improve fault-tolerance, an adequate number of disks must be installed on each BizTalk Server to handle the increased
disk 1/0.

Send

Sending documents by using Message Queuing creates the same security and performance issues as receiving documents by
using Message Queuing.

Recommended optimization for Message Queuing
To optimize performance for Message Queuing, which enhances the performance of BizTalk Server:

e Use transactional queues (local queues on BizTalk Server, rather than remote queues, must be used for transactional queues
to receive) and a fast disk I/O channel. Local queues do not need to query Microsoft Active Directory; however, a public
message queue must query Active Directory. Therefore, reading data from and writing data to local message queues results
in better performance. Non-transactional local queues can be used to achieve better performance. However, non-
transactional local queues do not provide the same reliability offered by transactional queues. Additional memory is also

required.
¥ Note

e For more information about how to define hardware requirements for Message Queuing, see "Selecting Message
Queuing server hardware" in Windows 2000 Server Help.

® The maximum limit for Message Queuing messages is 4 MB. If documents exceed 4 MB, the Message Queuing
transport service cannot be used. The Orchestration Persistence database has a 2-MB document size limit.

e Message Queuing is database-intensive if journaling is used. Ensure that the standard rules for optimizing databases are
applied when setting up Message Queuing transport services.

e To maximize throughput, separate data and logs and use multiple disks and controllers.



Scaling BizTalk Server Horizontally

A successful BizTalk Server 2000 implementation uses both a vertical and horizontal (scale out) strategy. Scaling vertically
minimizes the number of servers required. Scaling horizontally provides the following benefits:

o Heightened performance. Performance exceeds what could cost-effectively be accomplished on a single server.
e Server fault-tolerance.

e Separation and optimization of the different components. Performance of BizTalk Services, the databases, and the
transport services can be increased.

Scaling hardware horizontally minimizes costs. However, as site management complexity increases, your organization must begin
scaling vertically.

The following topics are covered in this section:

e Scale Out BizTalk Messaging Services
e Scale Out the Databases

e Scale Out the Transport Services

Related Topic

Scaling BizTalk Server



Scale Out BizTalk Messaging Services

BizTalk Messaging Services can be scaled horizontally by using server groups. Server groups are collections of individual servers
that are centrally managed, configured, and monitored. For more information about adding and configuring server groups,
see Groups and Servers.

Servers that are members of the same server group share the following:

e A Shared Queue database that monitors activity in the BizTalk Server state engine.

A Tracking database that logs document activity and generates reports.

A BizTalk Messaging Management database that stores configuration information.

Receive functions.

All components that the server requires at run time, such as transport components and application integration components
(AICs), as well as data translation, data encryption, and signing.

A BizTalk Server group does not provide a load-balancing mechanism for either receiving inbound documents or for facilitating
document submission by using Distributed Component Object Model (DCOM). It does provide multiple-server work processing.
Once a document is sent to the Shared Queue database, any server in the group can process, serialize, and send it out. This
functionality allows for one server in a group to send a document that another server processes.

An organization can have multiple server groups for the following reasons:

e Group similar transport services (HTTP or File)
e Enhanced security

e Trading partner categorization

You can also use server groups to avoid duplicating organization, channel, and messaging port configurations. Server groups
share databases. Configuration information for the organization, group, channel, and messaging port is stored in the BizTalk
Messaging Management database. Therefore, two or more BizTalk Server groups can share the same BizTalk Messaging
Management database.

¥ Note

e |f two or more BizTalk Server groups share the same BizTalk Messaging Management database, each group must have its
own Shared Queue, Tracking, and Orchestration Persistence databases, which are shared by all members of the group.

Recommended solutions for scaling BizTalk Server horizontally

To optimize BizTalk Server performance:
Separate transport services and receive functions

By separating transport services and receive functions for BizTalk Server groups, you can achieve higher performance. The level of
performance you can achieve depends on the number of documents being processed and the complexity of the data translation.
BizTalk Server provides separate thread pools for receiving and processing data. Separating transport services and receive
functions reduces context switching by eliminating the need for the server to alternate between send and receive operations.

All servers process work-items by default, which involves picking up work from the Shared Queue database, processing it, and
then sending it out using the transport service the channel is configured to use (process outbound work). This process degrades
the overall performance of the CPU because context switching must occur. Provided you use two or more servers, you can
eliminate this degradation by enabling at least one server to function as a receive service. To configure a server to act as a receive
service, you can use BizTalk Server Administration to disable the Participate in work-item processing functionality and create a
new receive function for the server. For more information about disabling the Participate in work-item processing
functionality, see Configure a server in a group. For more information about setting up a File receive function,

see Add a File receive function. For more information about setting up a Message Queuing receive function,

see Add a Message Queuing receive function.

¥ Note



e For Message Queuing, only transacted reads can be done from local queues, so only one server can read from that queue.
BizTalk Server receives documents if one of the following conditions exist:

e Areceive function has been configured on the same server as BizTalk Server.

® SMTP or HTTP process has been configured to call the Submit method on the server where BizTalk Server has been
installed.

Prioritize parsers
By prioritizing parsers, you can optimize the performance of BizTalk Server. BizTalk Server provides four data parsers:

e XML
e EDIFACT
e X12

o Flat file

When BizTalk Server receives a document, it attempts to parse the document in the order in the previous list. By moving the most
commonly used parsers to the top of the list, you can improve the performance of BizTalk Server. For more information about
configuring the parser order, see Configure the parse order for a server group.

Because the parser-order functionality is a server group setting, it is recommended that you create a separate group for each data
type (XML, EDIFACT, X12, flat file) that is processed. Then, specify the appropriate parser priorities set for each group.

The following topic is covered in this section:

® Component Load Balancing



Component Load Balancing

Component load balancing (CLB) is a feature of Microsoft Application Center 2000. To use CLB, Application Center 2000 must be
installed on the same server as Microsoft BizTalk Server 2000. CLB enables organizations to load-balance the
BizTalk.Interchange.1 component in the COM+ Services manager. CLB is a load-balancing mechanism for COM components. In
a BizTalk Server environment, CLB provides the ability for an HTTP transport to use the Submit method to call a cluster of BizTalk
Servers instead of to a single server (to the sending application, using the Submit method to call the cluster still appears as a
submission to a node). A cluster is a collection of servers that act as a single server. For example, if you use a cluster of HTTP
servers, a single submission can go to any of the three servers. Without CLB, the HTTP transport services must be configured to
send to one of the three servers. In the latter scenario, if the server that an HTTP service was configured to send to failed, the HTTP
transport service would need to be reconfigured to send to a different server in the BizTalk Server group.

¢ Important

e Do not replicate the default XLANG Scheduler application or any COM+ applications that host XLANG schedules. If
component load balancing is used, these COM+ applications must be installed on each server. You can replicate COM
components that are bound to XLANG schedules.



Scale Out the Databases

To horizontally scale the databases, install each database on its own server. In high-volume transaction environments, installing a
database on a unique server enables the server's CPU, disk I/O, and memory resources to be allocated to the appropriate
database.

Recommended optimization for horizontally scaling the databases

To optimize database performance of BizTalk Server:

Install each database on a separate server with 933 MHz, or greater, CPU. Do not install any of the databases on the same
server as BizTalk Server 2000.

Install any COM+ application that hosts XLANG schedules on its own server with 933 MHz, or greater, CPU.

Multiple 100 Mbps (megabits per second), or greater, network cards connected to 100 mb/s switch ports to increase
network I/O throughput.

For an organization that is processing a small number of documents, use a database that can be upgraded easily. If
processing needs increase, move the Shared Queue database, Tracking database, and Orchestration Persistence database to
their own servers. However, moving the BizTalk Messaging Management database is more difficult. It is highly
recommended that the server on which the BizTalk Messaging Management database is stored contain suitable disk space
and memory available to cache the configuration as document processing needs increase.

For the Tracking database, install fast network hardware to compensate for the high volume of uncompressed data that is
exchanged between BizTalk Server and the database.
¥ Note

e There is a size limit for tracking interchanges and documents, which if exceeded greatly affects the performance of
BizTalk Server. For more information about the size limit, see Interchange and document size limit.

Related Topic
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Scale Out the Transport Services

BizTalk Server supports four transport services. Each of these transport service can be scaled horizontally:

e HTTP
e File
e SMTP

® Message Queuing
The following topics are covered in this section:

o HTTP/HTTPS (Scale Out)
e File (Scale Out)
® SMTP (Scale Out)

® Message Queuing (Scale Out)



HTTP/HTTPS (Scale Out)

Receive

The HTTP/HTTPS receive function can be horizontally scaled by using a Web cluster. For example, a trading partner can send a
document to one address, but the submission can be routed to any server in the cluster. Web clusters are a feature of the network
load-balancing (NLB) service included with Microsoft Windows 2000 Advanced Server. For more information about configuring
NLB, see Windows 2000 Advanced Server Help. To improve the performance of BizTalk Server, you can configure a Web cluster to
place received documents into a file directory or a message queue, or you can configure it to send documents directly to BizTalk
Server through one of the following two methods:

e By statically configuring each server to send documents to a BizTalk Server.

e By configuring each server to send documents to a Web cluster of BizTalk Servers (servers that are members of the same
group) by using the Microsoft Application Center 2000 component load balancing (CLB) functionality.

¢ Important

e Do not replicate the default XLANG Scheduler application or any COM+ applications that host XLANG schedules. If
component load balancing is used, these COM+ applications must be installed on each server. You can replicate
COM components that are bound to XLANG schedules.

Send

Horizontally scaling the send HTTP/HTTPS transport service is an inherent feature of using multiple servers in a group that are
configured to participate in work-item processing. The HTTP/HTTPS send functionality cannot be separated from the BizTalk
Server that processes documents because sending functionality is used on every server in the group that is configured to
participate in work-item processing.

Recommended optimization for HTTP/HTTPS
To optimize the HTTP/HTTPS transport service, which enhances the performance of BizTalk Server:

e Dedicate the receive HTTP/HTTPS transport to a separate server from the BizTalk Services (in high-volume transaction
environments). In addition, have the HTTP/HTTPS server send documents to a File or Message Queue receive function, or
call the Submit method on the BizTalk Server Interchange object using DCOM. Dedicating the receive HTTP/HTTPS
transport or having the HTTP/HTTPS server send documents to a receive function introduces network latency; however,
configuring the HTTP/HTTPS transport server and the BizTalk Server separately enables you to accommodate their unique
architectures and optimize each. In addition, by separating these servers, you can maintain optimal performance on the
BizTalk Server because it is not affected by the cost of using SSL for encryption/decryption.

e Create a load-balanced cluster of HTTP/HTTPS transport servers. This will further enhance the performance of the receive
HTTP/HTTPS transport because it provides horizontal scaling redundancy. For more information about using the network
load-balancing service to create a Web cluster, see Windows 2000 Advanced Server Help.

® Forecast how many documents need to be processed by servers in a group configured to participate in work-item
processing. Then determine how many channels use messaging ports that require the send HTTP/HTTPS transport.
Combine the channels that use the send HTTP/HTTPS transport into a single group. This will allow all servers in the group
configured to participate in work-item processing to serialize documents that use any transport.

e Apply best practices when using ASP pages with the receive or send HTTP/HTTPS service. For more information about
optimizing ASP pages and Internet Information Services, go to the Internet Information Services Help Web site
(localhost/iisHelp). Then, click Active Server Pages Guide.

e Use Message Queuing or a File transport services on a local system with a receive function, rather than calling the Submit
method to poll documents into BizTalk Server.


http://localhost/iisHelp

File (Scale Out)

Receive

The File receive function can be separated from the servers or can reside on the server. Although separating the File receive
function to a separate server can minimize performance impact to the disk /O, network latency will impact performance when
attempting to retrieve the file.

Send

Scaling horizontally is accomplished with multiple servers in the group processing documents and then sending them to File
transport service. Performance will depend on whether or not BizTalk Server is used as the receive function, or whether or not
BizTalk Server is configure as a separate server as the receive function.

Recommended optimization for a File receive function or File transport service
To optimize a File receive function or File transport service, which will enhance the performance of BizTalk Server:

e Store the File receive function on a separate server from BizTalk Server. This solution; however, does not address the
performance impact resulting from network latency, which occurs when attempting to retrieve the file. Store the File receive
function on a separate server from BizTalk Server will also reduce the disk 1/0 impact on the performance of BizTalk Server.
Additionally, this separation of servers will keep unknown applications from placing files on BizTalk Server, or making
requests, which can maximize server resources and cause poor performance.

e Configure a receive function to run on every server in the group polling the same File receive function to ensure that all
servers in the group are retrieving documents for processing. File receive services are configured by default to run on a
server within a group. Therefore, if you have five servers in a group and you configure a File receive function to run on one
server in the group, when a File receive function is polled at \\receiveserver\receivelocation, only the one server of the five
retrieves files for processing. This limits the number of document-processing servers to one for the entire group. The
remaining four servers are not capable of retrieving files from the receive function to parse.

e Configure a File receive function on a separate server from BizTalk Server. This will keep unknown applications from
retrieving files from BizTalk Server. Because sending files and receiving files are different processes, all servers in the group
that are configured to participate in work-item processing send out files. Horizontal scalability is based only on the number
of servers in the group that are configured to participate in work-item processing.



SMTP (Scale Out)

Receive

SMTP can receive documents from BizTalk Server, but it cannot send documents to BizTalk Server. To send a document to BizTalk
Server, SMTP must be able to invoke an event-based mechanism to poll the received message and send it to a file share or a
message queue, or send the document using the BizTalk Server Interchange object. The SMTP servers, which are capable of
providing these event-based mechanisms (Microsoft Exchange Server or a third-party messaging server), typically use a high
volume of hardware resources. Therefore, adding this functionality to a server will degrade its ability to process documents.

Send

Lightweight SMTP transport services that do not have event-based mechanisms can be used for sending documents using SMTP.
The SMTP transport server sending the document simply acts as a relay agent. The outbound SMTP server is configured at the
group level, not at the server level. Therefore, if the SMTP transport exists on one server in a group, the server containing the
SMTP transport service would use it to send outbound documents. All other servers in the group would use the same server for
SMTP outbound.

Recommended optimization for SMTP
To optimize the SMTP, which will enhance the performance of BizTalk Server:

e Configure the SMTP transport to execute on a separate server from the BizTalk Services (for send and receive functionality).
In most cases, an organization will have an SMTP server on its network that can be used for send and receive functionality.



Message Queuing (Scale Out)

Receive

You must decide whether to have the Message Queuing receive function on the same server as BizTalk Server, or to install it on a
separate server. If you are using a transacted queue, the Message Queuing receive function must reside on the same server.
However, if you are not using a transacted queue, the Message Queuing receive function can reside on a separate server. You
must decide whether to incur the affects on performance by having the disk I/O on the local BizTalk Server or the network latency
of the multiple server communication. In the latter example, the need for disk I/O would still exist, but it would exist only on the
remote server instead of the local server. For more information about how to define hardware requirements for the Message
Queuing service, see "Selecting Message Queuing server hardware" in Windows 2000 Server Help.

Send

Sending documents by using Message Queuing creates the same security and performance issues as receiving documents by
using Message Queuing.

Recommended optimization for Message Queuing
To optimize performance for Message Queuing, which will enhance the performance of BizTalk Server:

e Message Queuing is database-intensive if journaling is used. Ensure that the standard rules for optimizing databases are
applied when setting up Message Queuing transport services. For example, separate data and logs and use multiple disks
and controllers to maximize throughput.



Performance Optimization

To meet your transaction requirements and enhance performance, you must optimize BizTalk Server 2000. In addition to BizTalk
Server, you can optimize Microsoft Windows 2000 and database interactions to enhance performance. After configuring your
system, test it, and then evaluate the results to determine if your initial configuration can meet your transaction requirements. It is
likely that you will need to reconfigure your architecture to achieve optimal performance. After each reconfiguration, test it again
and evaluate the results. Once you have achieved your desired results, initiate a maintenance plan, because server performance
changes over time, and the quantity and type of transactions that your organization handles may change.

The following topics are covered in this section:

e General Performance Recommendations
e Architecture Design, Review and Testing

e Maintaining Performance



General Performance Recommendations

This section provides general recommendations for optimizing system settings, and includes topics for optimizing
BizTalk Server 2000 settings, to obtain increased performance. For example:

e Optimize Microsoft Windows 2000 settings. Apply best practices, such as not running unnecessary services or protocols, to
improve Microsoft Windows 2000 performance. Many techniques used to optimize Windows 2000 also can be used to
optimize BizTalk Server. For more information about optimizing Microsoft Windows 2000 settings, see Best Practices in
Windows 2000 Help.

e Maintain fast, reliable network connectivity between transport services, BizTalk Services (BizTalk Orchestration Services and
BizTalk Messaging Services), and the databases (100 megabits per second or higher Ethernet). To optimize network
throughput, use multiple adapters in each server, with a unique switch port for each, with inbound and outbound
transactions separated between the network interface cards (NICs). When used in conjunction with Microsoft Windows
2000 NLB or Microsoft Application Center 2000 component load balancing (CLB) (linterchange or IPipelineComponent),
performance is significantly increased.

¢ Important

e Do not replicate the default XLANG Scheduler application or any COM+ applications that host XLANG schedules. If
CLB is used, these COM+ applications must be installed on each server. You can replicate COM components that are
bound to XLANG schedules.

The following topics are covered in this section:
e Optimizing BizTalk Orchestration Services
e Optimizing BizTalk Messaging Services

Related Topic

Scaling BizTalk Server



Optimizing BizTalk Orchestration Services

Using BizTalk Orchestration Services, you can optimize XLANG schedules and the contents contained within schedules. By
understanding how schedules use memory and how the structure of a business-process flow affects performance, you can design
schedules that improve the performance of BizTalk Orchestration Services. Implementation technologies that are supported by
BizTalk Orchestration Services include BizTalk Messaging Services, COM components, Message Queuing Services, and Windows
Script Components. By optimizing these components and services, you can further enhance the performance of BizTalk
Orchestration Services.

The following topics are covered in this section:

e Optimizing XLANG Schedules

e Optimizing the Contents of XLANG Schedules



Optimizing XLANG Schedules

An XLANG schedule can contain a large number of internal business processes. The business processes may include

short-lived transactions or long-running transactions. While BizTalk Server does not control the contents of these processes, it
does manage the flow of information through these processes within an XLANG schedule. When designing an XLANG schedule,
whether it consists of several short-lived transactions or long-running transactions, consider the following:

e An XLANG schedule instance runs in memory each time it is invoked.
e Multiple XLANG schedules may run on the same server.

o Several different XLANG schedules may be running concurrently, with multiple XLANG schedule instances.

The Orchestration Persistence database provides a mechanism, called dehydration, to control the memory that is used by running
XLANG schedules. Dehydration occurs if an XLANG schedule instance is waiting for a message, and no other activity is occurring
within the XLANG schedule. At this point, the XLANG Scheduler Engine dehydrates the XLANG schedule instance to maximize
performance. Dehydrating an XLANG schedule instance consists of persisting all instance-specific states to a database and
removing the instance from memory. Only a small portion of the XLANG schedule instance remains in memory within the XLANG
Scheduler Engine. When a message arrives at a port for the XLANG schedule instance, the instance is rehydrated. Rehydrating an
XLANG schedule instance consists of restoring the instance from the database to memory.

An XLANG schedule instance remains dehydrated until it is either rehydrated or explicitly terminated by an administrator. This
enables a business process to run reliably for an extended time period. For more information about configuring hydration
settings, see Dehydration and Rehydration. While dehydration and rehydration saves memory, it does affect performance.
Because dehydration and rehydration requires that data be read and written to the Orchestration Persistence database, network
latency is incurred.

¢ Important

e To dramatically increase the performance of BizTalk Orchestration Services, in Windows Explorer, browse to Program
Files\Common Files\System\ado, and then double-click adofre15.reg. In the confirmation dialog box, click Yes, and then
click OK. This procedure changes the ADO threading model from "Apartment threaded" to "Both" and may affect other
applications that use ADO.



Optimizing the Contents of XLANG Schedules

An XLANG schedule describes the business process and the binding of that process to implementation technologies. The
performance of an XLANG schedule often mirrors the performance level of the actions contained within it. There are a number of
relevant issues for optimizing the contents of an XLANG schedule. Some of these are things specific to an XLANG schedule, while
others are applicable to authoring any distributed application:

Reset the dehydration value to conserve memory for XLANG schedules. The default wait time is 0 seconds. You can
change this time. Any time less than or equal to 180 seconds causes the XLANG schedule to never dehydrate. Any time
greater than 180 seconds causes the XLANG schedule to dehydrate immediately. For more information about wait times
and XLANG schedule dehydration, see Dehydration and Rehydration and Synchronous and Asynchronous Communication.

Use persistent components. Persistent components, such as IPersistStream or IpersistStreamlinit, enable the
XLANG Scheduler Engine to dehydrate XLANG schedules flexibly.

Run the COM objects on the same server as the Orchestration Persistence database. This ensures that the XLANG
schedule does not incur the network latency.

Run COM+ packages in-process to achieve optimal performance. Although running a COM+ package in-process can
affect the stability of the COM+ application (For example, if one component within the application fails, the entire
application can fail.), it is significantly faster than running the application out-of-process. To avoid this potential instability,
be sure to heavily test the components within the application for stability prior to deploying the application to a production
environment.

Batch work into a single transaction. Persisting the state of an XLANG schedule instance at the beginning and end of a
transaction greatly impacts the computer's resources. However, batching work items in a single transaction greatly reduces
this impact to performance. In addition, an XLANG schedule cannot dehydrate in the middle of a Microsoft Distributed
Transaction Coordinator (MSDTC) transaction. MSDTC transactions are quick, but they degrade performance. Group
multiple actions within a single MSDTC transaction, provided the actions can be completed quickly.

Long-running transactions should be accomplished asynchronously and XLANG schedules should be designed
to complete COM calls quickly. Results from asynchronous work can be communicated back to the XLANG schedule
instance through message queues, or through COM calls. With COM, the name of a "response” port can be passed in the
form of a moniker that will be valid even with computer restarts.

Related Topic

Moniker Syntax



Optimizing BizTalk Messaging Services
To optimize BizTalk Messaging Services:

e Send documents to a server group. BizTalk Server groups are used to distribute work across multiple servers. To send data
to BizTalk Server, use the following methods:

e Configure a receive function (such as Message Queuing or File).

e Call the Submit method on the BizTalk Server Interchange object.

Using receive functions provides better performance than using the Submit method to call the Interchange object because
the receive functions run within BizTalk Services and can cache the internal state of objects. Whereas, the Submit method
runs out-of-process and has to rebuild its internal state for each call.

Calling the Interchange object for submission rather than using a receive function uses more resources because the
Interchange object needs to be created outside the BizTalk Server process. However, if the Interchange object is used,
there are two methods available for sending data to the servers in a group:

e Statically configure portions of the total submissions to specific servers within the group. Although this does not
provide much fault tolerance if the server, which has a transport service, is statically mapped to a BizTalk Server that
has failed.

e Use the Microsoft Application Center 2000 component load-balancing (CLB) functionality to improve performance.
BizTalk Server groups do not provide load balancing for the submission of documents. In addition to load balancing,
CLB provides fault tolerance. For more information about CLB, see Component Load Balancing.

¢ Important

e Do not replicate the default XLANG Scheduler application or any COM+ applications that host XLANG schedules. If
component load balancing is used, these COM+ applications must be installed on each server. You can replicate
COM components that are bound to XLANG schedules.

The following topics are covered in this section:

e Creating and Optimizing Specifications

e Creating and Optimizing Maps

e Optimizing BizTalk Server Group Properties
e Optimizing Server Properties

e Optimizing Registry Settings

e Optimizing Encryption

e Optimizing Communication

e Configuring Firewalls



Creating and Optimizing Specifications

If the default global tracking settings are used, BizTalk Server 2000 can support a 20-MB XML Unicode format document. For
other file types, such as an ANSI flat-file, BizTalk Server does not support a 20-MB file size because any file that is not XML has to
be converted to XML. The conversion process adds XML tags to the data, thus increasing the size of the document that BizTalk
Server needs to process. Other file types must be less than 20 MB to maintain optimal performance by BizTalk Server. The
amount of memory required to process a document that has been converted to XML depends on the original structure of the
document. If global tracking settings are enabled, XML Unicode format documents that are larger than 20-MB can be processed
without greatly impacting BizTalk Server performance.

¥ Note

o Exceeding the size limit for tracking interchanges will impact the performance of BizTalk Server. For more information about
the size limit, see Interchange and document size limit. Performance is also affected by document logging. For more
information about document logging, see Set document logging properties.

When designing specifications, you can configure validation rules within a specification. For example, you can specify that a field
contain a particular data type (such as a string) or more complex rules, (such as requiring a field to be validated against a list of 80
values). The latter requires that the data be checked against 80 values and, if it does not conform to one of them, the specification
fails validation. Specification validation in BizTalk Server is enabled by default; it affects performance but ensures the validity of
the data being sent or received. You can disable validation, which increases performance and might not adversely affect the
validity of data because BizTalk Server has several other mechanisms for validating data. For example, if a you have a map that
requires certain data types and values and specification validation is disabled, the data successfully passes the parsing phase but
fails during the serializing phase when the map is applied. If other mechanisms (such as maps that rely on valid data) are
available, specification validation can be disabled to avoid the potential performance degradation caused by the validation
process. Alternatively, you might choose to do so because you have agreed to data standards with business partners and have
validated these transactions. You might also choose to do so because you have complete control of how the data is sent (such as
application-to-application transactions).

The following registry setting can be used to disable validation:

o NoValidation. If specification validation is not required (documents are not validated against a specification for settings
such as minimum/maximum values, data types, and/or required values), set this to a non-zero value and the data will not be
validated. This might help with performance, but may result in non-valid data being sent. Changing the specification
validation to a non-zero value may be the right option for servers that are receiving documents for which the organization
has control over the structure.

The registry setting is accomplished at the individual server level. When specification validation is on, every document processed
by the server is validated against its specification. This performs more slowly than if no specification validation were used.

Recommended solutions for optimizing document size and specifications
To optimize performance of BizTalk Server:

e Do not include more fields and/or attributes in specifications than necessary. Increased fields and attributes equate to
increased memory requirements for BizTalk Server. A larger specification requires a proportional increase in memory. For
example, the EDI specifications included with BizTalk Server are compliant with EDI standards. Typically, most organizations
that use EDI specifications only require approximately ten percent of the entire specification. So, if an organization and its
trading partner use only ten percent of the entire specification, the unnecessary records and fields can be deleted and the
modified specification can be used for transactions.

o |[f specification validation is enabled, do not specify validation rules in specifications for fields that will contain valid data. For
example, if a field contains a number but will be processed only as a string (a phone number, for example), do not specify
that it must be numeric. In this situation it is not necessary to specify a data type because the default data type is string.
Therefore the data type field could be left blank. Specifying acceptable values for a field takes longer to validate than a
simple data type validation.



Creating and Optimizing Maps

Translating data, as part of a transaction, may reduce the performance of BizTalk Server 2000. Mapping specifications can be
CPU-intensive, which can reduce BizTalk Server's ability to process the overall transaction. The level to which BizTalk Server is
affected depends largely on the complexity of the map being used for translation. For example, mapping a field called productID
in the source specification to a field called itemID in the destination specification is not as intensive as performing a complex
mathematical operation on the data being translated.

Recommended solutions for designing maps

e Use functoids only when needed. Functoids use script, which causes BizTalk Server to load a scripting engine. This may
degrade performance as opposed to native XML transformations.

e Use the Database Lookup functoid only when needed. BizTalk Server must establish a database connection, query for data,
populate a recordset, and close the connection each time this functoid is used. This may degrade performance of BizTalk
Server.

e Avoid invoking COM objects within functoid scripts and using custom functoids. Both of these techniques cause BizTalk
Server to instantiate an instance of a COM object. This affects the performance of the overall operation. In addition, the
performance of instantiating COM objects is affected by the answers to the following questions:

® |sitin-process or out-of-process?
® |s the object local or remote?
o How well is the object written?

e |[s it transactional?

e Analyze each map to determine how to achieve optimal performance. For example, two different techniques can be used to
concatenate two source fields together and have the resultant value placed in two different destination fields. The first
concatenation technique would be to use one concatenation functoid and map its output to two places. The second
concatenation technique would be to use two functoids each with a single output link to a destination source field. The first
technique is slightly more efficient due to the fact that the script, which runs as part of the functoid, is only called once.
Through testing, you can determine which techniques result in the best performance.



Optimizing BizTalk Server Group Properties

In BizTalk Server Administration, you can specify the following properties in the BizTalk Server Group Properties dialog box:

o Messaging Management object cache refresh interval (seconds). This field can be set to a maximum of 300 seconds.
BizTalk Server 2000 caches configurations (such as channels, messaging ports, envelopes, and document definitions) in
memory to avoid calling the database each time. If these objects are not regularly changed, set this value to 300 to reduce
the number of times data is written to and read from the database. Because BizTalk Server refreshes management objects
every five minutes, the service must be restarted for the change to take effect immediately.

o Disable document tracking. The Tracking tab can be used to enable or disable document tracking. If tracking is not used,
disable this field to minimize the number of read/writes to the database for a single transaction. If this field is enabled,
BizTalk Server connects to the database and logs data. Do not disable this field unless tracking is not needed. However, it is
highly recommended that document tracking remain enabled. For more information about setting tracking properties,
see Configure tracking properties for a server group.

[# Note

e Asize limit exists for tracking interchanges. If the size limit is exceeded, the performance of BizTalk Server will be
affected. For more information about the size limit, see Interchange and document size limit. Performance is also
affected by document logging. For more information about document logging,
see Set document logging properties.

e Arrange the server call sequence. BizTalk Server parsers can be prioritized if a group is predominately receiving a
particular document type. BizTalk Server has four parsers that it uses to parse data: XML, EDIFACT, X12, and Flat File. When
BizTalk Server receives a document, it tries to parse it using these parsers in the order in which they are listed. If an
organization primarily receives a particular document type, the order of the parsers should be changed so that the first one
matches the type of documents being received.

Related Topic

Scale Out BizTalk Messaging Services



Optimizing Server Properties
In BizTalk Server Administration, you can set the following properties in the <Server> Properties dialog box:

e Create multiple instances of receive functions. This will enable BizTalk Server to poll multiple receive functions for
documents that are processed. To balance the load of documents across several computers, locate the receive functions on
separate computers. Each polling location must be unique and must have a separate receive function. To avoid overloading
any individual receive function, the business application that sends documents must evenly distribute the documents to all
the polling locations.

e Maximum number of receive function threads allowed. You can specify how many receive function worker threads
per processor you want for a receive function. Setting this too low can cause a slow down in BizTalk Server because it uses
I/O completion ports. Setting this too high should not have serious effects, but it might cause performance degradation. You
can adjust this number to find the optimal value for their setup. The recommended value for the Maximum number of
receive function threads allowed, is 4.

e Maximum number of worker threads allowed. You can specify the number of worker threads per processor for the
processing side. By appropriately adjusting the number of worker threads, you can improve performance. In BizTalk
Server Administration, right-click a server in the console tree and click Properties. Change the default value in the
Maximum number of worker threads per processor allowed box. The default value is 4. The recommended value is
from 10 to 16, depending on the deployment.



Optimizing Registry Settings

You can optimize the registry settings to improve BizTalk Server performance. All keys should be added as DWORD values to
HKLM\System\Current Control Set\Services\BTSSVC. To improve performance, you can implement the following registry setting
adjustments:

o NoValidation. Use this registry key to disable specification validation. If specification validation is not required (documents
are not validated against a specification for minimum/maximum values, data types, or required values, for example), set this
to a non-zero value and the data will not be validated. While this may improve performance, it may result in non-valid data
being sent. This setting would be appropriate for servers that are receiving documents for which the organization controls
the structure.

o ParserRefreshinterval. By default this is set to 60,000 (60 seconds). This value indicates how often BizTalk Server should
check the database to see if a new parser has been added (this is the only group-level property that is refreshed while the
server is running). If no new parsers will be added, set this value to 0 and BizTalk Server will not check the database. This
value is also used to verify if new parsers have been added to the Tracking database group settings or, if the settings have
been altered.

e CacheSize. Use this registry key to indicate how large the BizTalk Server management object cache is allowed to grow. The
default value for this is 20. Therefore, as soon as the BizTalk Server object cache exceeds 20 channels, messaging ports,
envelopes, or document definitions, BizTalk Server must delete some items from memory. If a server has a high volume of
memory, this value can be set higher (above 20) and BizTalk Server will keep more in memory. This does not affect the
refresh interval. BizTalk Server deletes the cached objects and reloads them when they have expired.

e BatchSize. Use this value only with the Message Queue receive function. By default the BatchSize is set to 20. To improve
performance, BizTalk Server reads up to 20 items at a time from the queue and sends all 20 within one transaction.
Reducing the number of times data is written to a database will greatly improve performance. If a deadlock occurs, and
BizTalk Server ends the transaction, it must resubmit the items. BizTalk Server does not lose the documents. Values that
exceed 20 have not been tested. Do not set this value to 0.

The following topic is covered in this section:

® Improve processing performance



Improve processing performance

1. Click Start, click Run, type regedit and then type OK.

2. In the Registry Editor dialog box, click the expand indicator (+) for the HKEY_LOCAL_MACHINE node; expand SYSTEM,
CurrentControlSet, and Services, and then click BTSSvc.

3. Right-click in the details pane, point to New, and then click DWORD Value.

4. Type NoValidation and press ENTER twice.
The Edit DWORD Value dialog box appears.

5. In the Value data box, type any nonzero value, such as 1, and then click OK. The default value is 0O (validation).
6. Right-click in the details pane, point to New, and then click DWORD Value.

7. Type ParserRefreshinterval and press ENTER.

8. Right-click in the details pane, point to New, and then click DWORD Value.

9. Type CacheSize and press ENTER twice.
The Edit DWORD Value dialog box appears.

10. In the Value data box, type the number of channels, messaging ports, envelopes, and document definitions that you expect
to or do have in memory.

11. Right-click in the details pane, point to New, and then click DWORD Value.

12. Type BatchSize and press ENTER twice.
The Edit DWORD Value dialog box appears.

13. In the Value data box, type a value for the number of items you want to process as a batch.



Optimizing Encryption

Using encryption or other security mechanisms may decrease the performance of BizTalk Server. When using encryption, the
following is recommended:

o Increase CPU clock rating (MHz). Increasing the number of processors will increase performance.
o Increase the number of servers.
e Use a faster CPU.

e Separate BizTalk Server functionality. For example, send and receive functions can be placed on separate servers. The
HTTPS transport service can also be placed on a separate server.

e Use an existing virtual private network (VPN) if File or Message Queuing is used. If a VPN is available, data transfer
is secure. It is not required to secure BizTalk Server transactions if all data transfer conducted with trading partners is
secured through a VPN.

e Purchase encryption hardware accelerator cards. Accelerator cards provide dedicated processors that may eliminate
the performance impact of encryption and decryption on a server's CPU. Accelerator cards are less expensive than adding
multiple CPUs.



Optimizing Communication

BizTalk Server provides both synchronous communication and asynchronous communication integration mechanisms.
BizTalk Server 2000 can accept documents through COM integration or through server receive functions (File or Message
Queuing).

Typically, when a document is sent to BizTalk Server, it is placed in the Shared Queue database. BizTalk Server polls the database
and then processes the document. This process is an asynchronous communication mechanism. It uses the Microsoft SQL Server
database as a queue for check-pointing documents that are waiting to be processed. This extra layer of abstraction allows the
transport service to send documents to BizTalk Server independent of the transport mechanism used to deliver the documents.

A synchronous communication interchange bypasses all queues and processes all the components required by the

messaging port on the calling thread. For synchronous communication protocols, an optional response document is returned, if
available. This method is valid only for a single channel match and only for a single messaging port (not distribution lists). If the
parameters that are set cause multiple channels to match, a synchronous communication submission returns an error which
indicates that multiple channel matches are not allowed for a synchronous communication submission. This method can be used
only for single document interchanges. If the submission contains multiple documents, an error is returned for synchronous
submissions, which indicates that multiple document submissions are not allowed. This method does not support groups.
Synchronous communication is not scalable. Synchronous communication uses a single thread to process a transaction and
cannot be load-balanced with other BizTalk Servers in the group because the entire process must run on the server that sends
documents.

The synchronous communication mechanism sends documents directly to BizTalk Server for immediate processing. BizTalk
Server blocks the return to the caller of the linterchange:SubmitSync interface until processing is completed, whereby a
response document is delivered to the caller. This mechanism is available only to the COM-based integration method.

Recommended solutions for optimizing synchronous and asynchronous communication
To optimize performance of BizTalk Server:

e To achieve optimal performance and scalability, asynchronous communication is highly recommended. Asynchronous
communication is highly scalable and provides a high-level of throughput. Synchronous communication calls provide a
near-immediate response to the caller under a high volume of transactions because each SubmitSync call runs under a
separate thread. However, if there are many calls at once, this leads to many threads running on a single server thereby
degrading the overall performance of BizTalk Server. Microsoft Windows 2000 is designed to context switch between all the
threads, thus degrading the overall performance of BizTalk Server. Additionally, the following criteria cause a synchronous
communication submission to fail but do not cause an asynchronous communication submission to fail:

e |[f the transaction criteria matches more than one channel.

e |[f the interchange contains multiple documents.
e Self-routing documents may degrade the performance of BizTalk Server.



Configuring Firewalls

Firewalls help secure internal networks, but introduce latency and may potentially create a single point of failure. Even if a load-
balancing mechanism is used to alleviate the single point of failure, a firewall can reduce a network's performance.

When configuring a BizTalk Server 2000 environment with a firewall, two primary configurations are recommended:

e Configuration 1. Install servers on an internal corporate network and some, which communicate to trading partners, on a
corporate demilitarized zone (DMZ). A company that wants to host its own Internet services without sacrificing
unauthorized access to its private network uses a DMZ. The DMZ is the boundary between the Internet and an internal
network's line of defense, usually a combination of firewalls and bastion hosts, which are gateways between inside
networks and outside networks. The servers in the DMZ should use local transport services, such as HTTP, Message Queue,
or SMTP. In this environment, all inbound and/or outbound transactions will pass through a firewall. The servers in the DMZ
send documents through another firewall to Microsoft SQL Server. This configuration will allow servers, such as BizTalk
Server and HTTP in the DMZ, to communicate with Microsoft SQL Server through an internal firewall.

e Configuration 2. Install the servers on a corporate network. Trading partners exchanging documents through the Internet
send their data using SMTP/HTTP servers in the DMZ (first firewall of protection). These servers then send the data to the
servers residing on the corporate network through a second firewall.

Configuration 1 and 2 will impact performance. To avoid a noticeable degradation in performance, you can construct the firewall
to accommodate a typical number of transactions between an organization and its trading partners.



Architecture Design, Review and Testing

The key components of BizTalk Server 2000 include the BizTalk Services, the BizTalk Server databases, and the transport services.
Poor configuration of any component can degrade the performance of the entire system.

This section provides comprehensive detail about defining, testing, and refining the architecture of BizTalk Server to optimize
performance.

The following topics are covered in this section:
e Architectural Design
e Architecture Testing and Analysis

Related Topic

Scaling BizTalk Server



Architectural Design

To accurately determine the number of the documents that can be processed by BizTalk Server 2000, you must first consider if
the following are in use:

e Specification validation

e Application Integration Components
® Transport services

e Encryption

e BizTalk Orchestration Services

e Firewalls

® Maps

You must also consider the size of the documents being processed, as well as the current server configuration.

Performance testing is successful when accomplished with controlled processes. It is important to start with a few variables and
then slowly add additional variables. When performance begins to degrade, you can easily identify the cause of degradation.

The following topics are covered in this section:

® Develop Transaction Components
e |dentify Transports

e |[nitial Architecture

Related Topics

Administering Servers and Applications
BizTalk Orchestration Services

Creating Application Integration Components
Creating Specifications

Mapping Data

Run XLANG Schedules

Use BizTalk Orchestration Designer



Develop Transaction Components

To develop transaction components, you must design transactions and set transaction properties for business processes. For
more information about designing transactions and setting transaction properties, see:

e Designing Business Processes
e Designing Transactions

e Transaction Properties for an XLANG Schedule Drawing

For information about techniques that can help you to determine the most efficient transaction configuration,
see Evaluating the Performance of a Configuration.

To develop transaction components, you must first determine the transaction types that the components process. In an
application-to-application and/or business-to-business environment, you must determine transaction needs and transaction
profiles. For example, you might have a scenario in which a single transaction receives a custom XML purchase order and maps it
to a standard EDI purchase order, which is later processed by a custom internal application.

This scenario requires that you create a specification for the XML purchase order and a specification for the EDI purchase order. To
create these specifications, use BizTalk Editor, which includes XML and EDI templates. Because the templates include all potential
records and fields, you can remove unnecessary records and fields, and then save the templates as the final specifications. During
design time, any fields in a specification that require validation decrease the performance of BizTalk Server 2000. For more
information about optimizing specifications, see Creating and Optimizing Specifications.

In addition to creating a specification, you must map data. Because there are a number of ways to translate data in map files (by
using XSLT translations, functoids, or a custom script), all of which affect performance, it is important to test different translation
methods. Testing one method of data translation over another helps to reduce performance impacts to BizTalk Server as a result
of mapping. For more information, see Creating and Optimizing Maps.

Related Topics

Designing Business Processes
Designing Transactions
Identify Transports

Transaction Properties for an XLANG Schedule Drawing



Identify Transports
To determine how to send and receive data, consider if the following are in use:

e Business-to-business transactions

e Application-to-application transactions
e Transport services (send and receive)
e Encryption

e HTTPS or S/MIME

Consider whether different transports are needed based on the type of transactions you are processing. Determine whether
unique transports are required for business-to-business and application-to-application transactions or if the same transports can
be used for these two types of transactions.



Initial Architecture

To successfully plan an initial architecture, consider the following:

e One server with Microsoft SQL Server and BizTalk Server can be used to process a low volume of transactions.
o Installing BizTalk Server and SQL Server on separate machines can be used for moderate volume of transactions.

e An existing SMTP transport service can be used to send and receive data. Placing this server on a separate server is
recommended for this transport type.

e HTTP, Message Queuing, or File transport services can be used to write data to disk drives on other servers than the local
BizTalk Server, which can improve BizTalk Server performance.

An initial architecture should contain as many separate servers as possible. For example, within a company, one person may
administer SMTP servers and Message Queuing, whereas another person may handle security policies. The goal of the initial
architecture is to determine how many servers are needed and the hardware required by those servers to process the anticipated
work. After you determine the required number of servers, test the initial architecture.

Related Topic

Architecture Testing and Analysis



Architecture Testing and Analysis

Prior to testing the architecture, define the architectural components, determine the transaction needs and profiles, determine
what transaction components need to be developed, and determine the necessary transports. Begin this process by creating a
baseline, which will require the following:

e Configure BizTalk Messaging Services, organizations, document definitions, channels, and messaging ports needed to
process transactions.

e Configure BizTalk Orchestration Services.

e |Install and/or configure any COM+ applications, BizTalk Server channels, databases, or message queues required for
XLANG schedules.

Once a baseline has been established, process transactions using BizTalk Server. This test helps to identify factors affecting
performance.

The following topic is covered in this section:
e Evaluating the Performance of a Configuration
e |mproving the Architecture

Related Topics

Architectural Design

Scaling BizTalk Server



Evaluating the Performance of a Configuration

You can use the Microsoft Windows 2000 Performance tool to test the performance of BizTalk Messaging Services.

To use the Performance tool, on the Start menu, point to Programs, point to Administrative Tools, and then click
Performance. The System Monitor, which is part of the Performance tool, graphically displays counter readings as they change
over time. There are, however, different counters that should be monitored depending on the system component being
monitored. Numerous white papers are available describing how to monitor performance for Windows 2000, IS, SQL Server, and
the Message Queue; however, the following tables lists only some of the primary objects and counters to monitor. In addition, the
table contains specific information regarding the objects and counters to monitor to determine BizTalk Messaging Services

performance.

Obje|Counter Observation Component affected

ct

Acti |Requests queue|There should not be a significant queue except at peak periods. HTTP transport services th

(if using ASP). If files are posted to an HTTP page, this counter does not provide
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ve S |d at use .asp pages
erve
rPa
ges
Requests/sec |[Indicates the volume of ASP requests the HTTP transport services are receiving |HTTP transport services th

at use .asp pages

Request wait ti
me
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HTTP transport services th
at use .asp pages

Net
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k Se
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Bytes received
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es sent per seco
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If this number is close to the capacity of the connection, and processor and me
mory use are moderate, the connection may affect performance.

All

Proc
ess, |
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nfo i
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Private bytes

Monitor this for memory leaks or size approaching maximum available RAM.

HTTP transport service
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Available bytes

Available byes should not stay below 10 MB consistently. If so, a memory spike
would cause paging to disk to start.

All

Page Faults/sec,
Memory: Pages
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Memory: Page
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If these numbers are low, the server should be responding to requests quickly. |
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All
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ical
Disk

Disk read/write
s/sec

Combined, these two counters should be significantly under the maximum cap

acity for the disk device. To enable this counter, on the Start menu, point to Pro
grams, point to Accessories, and then click Command Prompt. At the Comma
nd Prompt, type diskperf -y. Then, restart the computer.

SQL Server, Message Queu
e, and File transport servic
es

% Disk time

This counter should be well below 100 percent. If it is above this value (and it ca
n go into the 1000 percent range), add more physical disks or move one of the
databases to another server.

SQL Server, Message Queu
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Current Disk Q
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This counter is the number of requests outstanding on the disk at the time the
performance data is collected. This counter should average less than 2 for good
performance.

BizTalk Server
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Indicates how much activity the SQL server actually performs.

SQL Server
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Documents Pro
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Indicates how quickly BizTalk Server 2000 is polling documents from its
Work queue and sending them.

BizTalk Messaging Services




BizT Documents Rec|Indicates how quickly BizTalk Server is sending documents to the Work queue. |BizTalk Messaging Services
alk S|eived/sec This number reflects only the number of documents BizTalk Server has receive
erve d (this includes documents that fail parsing), not the number of documents BizT
r alk Server checkpoints to its Work queue. The number of documents that are ch
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BizT |Synchronous S |Indicates how quickly the Submit method and/or the SubmitSync method call|BizTalk Messaging Services

alk S|ubmissions/sec,|s occur. Because each interchange can contain any number of documents, this c
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r Submissions/se|cessing interchanges without parsing them) is being used exclusively, this is the
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sage|eue essive memory use on the Message Queue server and degrade the performanc |service
Que e of the entire system.
ue
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value of two or more threads, the processor is degrading the performance of th
e entire system.
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parating the send and receive functions to separate servers.
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Web|Get or post req |Indicates the volume of files being received through the HTTP get/post metho |HTTP transport service
Serv [uests/sec ds.
ice

There are no counters specific to the SMTP transport service listed because there are a variety of SMTP transport service products
available. Regardless of the SMTP transport service being used, monitor the volume of messages sent to and from BizTalk Server.
Monitoring the counters listed in the table enables you to identify performance degradation. Because all the components work
together to determine the health of a system, do not make drastic changes to your system configuration based on the poor
performance of one.

Data obtained from performance monitoring is also useful for identifying symptoms that can contribute to problems. For
example, a high amount of disk activity may indicate that SQL Server is writing a large amount of data to disk, but it may also
indicate that the system is often paging to disk. Excessive disk paging typically indicates that memory is too low. In this case, the
disk activity is the indicator of a problem, but not the problem.

Related Topic

Scaling BizTalk Server




Improving the Architecture

By identifying areas that affect performance, you can refine the system architecture to achieve optimal results. For example,
hardware may need to be upgraded, or different components of BizTalk Server may need to be moved to separate servers.
Additionally, you might need to adjust BizTalk Server settings. For more information about adjusting settings,

see Optimizing Server Properties.

Ensure that changes are made methodically. After implementing a change, such as adding CPUs, changing a setting, or separating
functionality to separate servers, document the change, and then test the new configuration to determine if performance has
improved. If the new configuration enhances performance, then you can continue to modify the configuration. However, if the
new configuration is degrading performance, re-configure the system to its previous state, and analyze the data to determine
what may be contributing to the problem.

Related Topic

Evaluating the Performance of a Configuration



Maintaining Performance

To maintain performance, create an ongoing maintenance plan to ensure the health and future performance of BizTalk Server.
BizTalk Server will most likely process increased numbers of documents over time. Although the initial BizTalk Server architecture
may have performed well, if the number of transactions has increased over time, it may not be capable of sustaining the same

level of performance unless the system architecture or configuration is modified. Hardware failures, or out of memory conditions,
also can affect the performance of a system.

The following topics are covered in this section:

e Creating a Performance Maintenance Plan

e Using Application Center 2000



Creating a Performance Maintenance Plan

A successful monitoring plan includes:

o A detailed plan of which counters to monitor. For example, there are several Windows 2000 System Monitor counters,
thresholds to monitor, and possible interpretations of the problems that might be indicated by the thresholds. Additionally,
you can also monitor application-level problems such as whether SQL Server queries should return valid data or return
hardware problem conditions.

o Identifying processes for resolving performance issues. For example, a Windows 2000 event-log message might
written, e-mail notification might enabled, or a custom program might start a series of events.

e Defining which performance thresholds generate a notification. For example, a monitoring tool might be configured
to write an event to the Windows 2000 event log if the CPU reaches 90-percent use capacity. However, if the CPU stayed at
90-percent use capacity for more than 5 minutes, an e-mail message might be sent. Defining different actions for different
problem-severity levels depends on the monitoring tool that you use.

o Defining the course of action in response to events published in Windows 2000 event logs. Windows 2000,
BizTalk Server 2000, SQL Server, and native Microsoft transport services such as Message Queuing and HTTP write events
to the Windows 2000 event log. This event log contains valuable information that may indicate impending problems on one
of the servers in a BizTalk Server system. If addressed early, you can avoid a system failure that would degrade the
performance of the overall system. A plan should include the frequency at which the logs are monitored and archived, and
include the party responsible for the tasks. A third-party tool can be used to accumulate the logs from multiple servers and
write them to a database for consolidated analysis. These tools can also be used to purge the logs from the servers.

e Determining the required tools for performance monitoring. The built-in Windows 2000 System Monitor tool
examines performance counters and can take action when a predefined condition occurs. For more information about
configuring System Monitor alerts, see "Setting up a monitoring configuration" in Windows 2000 Help. Additionally,
Microsoft Application Center 2000, as well as a number of other third-party tools, perform this functionality with additional
features such as logging to a database and performing application-level tests.



Using Application Center 2000

Microsoft Application Center 2000 contains a tool called Health Monitor. Health Monitor supercedes the functionality of the
Windows 2000 event log and system monitor tools. It allows administrators to set up monitors. These monitors include checking
TCP/IP, performance monitor counter thresholds, event log errors, and WMI events. Conditions can be configured for these
monitors so that when certain criteria are met, for example, when a threshold of 90 percent on a CPU is met or exceeded, an
action occurs such as a taking a server offline or sending an e-mail message to an administrator. These tools can be used to
proactively monitor and maintain the performance of BizTalk Server 2000.

¢ Important

e Do not replicate the default XLANG Scheduler application or any COM+ applications that host XLANG schedules. If
component load balancing is used, these COM+ applications must be installed on each server. You can replicate COM

components that are bound to XLANG schedules.



Administering Servers and Applications

The administration features provided by Microsoft BizTalk Server 2000 help you to efficiently and effectively administer all
installations of BizTalk Server 2000. There are 4 areas of administration in BizTalk Server 2000:

e Server administration
e Application administration
® Programmatic administration

e Database administration

This section covers server administration and programmatic administration. For more information about application and
database administration, see BizTalk Server Administration Model. Server administration includes configuring and managing
server groups, servers, receive functions, and the Shared Queue for each server group. Application administration includes
configuring and managing the COM+ applications that host XLANG schedules, the default XLANG Scheduler application and the
Orchestration Persistence database.

The following topics are covered in this section:
e Server Administration
® Programmatic Administration

Related Topic

BizTalk Server Administration Model



Server Administration

BizTalk Server Administration provides a central user interface (Ul) from which you can:

e Add and manage servers installed with Microsoft BizTalk Server 2000 in server groups.
e Configure server group properties, such as the location for the Shared Queue and Tracking databases.
e Configure and manage receive functions.

e View and manage queues.

For help with specific tasks, see How To.
For general background information, see Concepts.

For problem-solving instructions, see Troubleshooting BizTalk Server Administration.
Related Topic

BizTalk Server Administration Environment



How To...

This section provides task-specific information about using BizTalk Server Administration. It is highly recommended that you
review the Concepts section to fully understand all the features and capabilities of BizTalk Server Administration.

The following topics are covered in this section:

e Open BizTalk Server Administration

e Open Component Services

® Add users to the BizTalk Server Administrators group
e Configure the BizTalk Messaging Management database
e Refresh the administration console

e Start the BizTalk Messaging Service

e Add, Delete, and Configure a Server Group

e Add, Delete, and Configure Servers in a Group

® Run Servers in a Group

® Manage Queues

e Manage Databases for a Server Group

® Manage Receive Functions for a Server Group

e Manage Event Viewer

e Manage XLANG Applications and Databases



Open BizTalk Server Administration

e On the Start menu, point to Programs, point to Microsoft BizTalk Server 2000, and then click BizTalk Server
Administration.



Open Component Services

e On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.



Add users to the BizTalk Server Administrators group

To add users to the BizTalk Server Administrators group, you must be a member of the Windows 2000 Administrators group. For
more information about adding users to the Windows 2000 Administrators group,
see Add a user account to the Administrators group.

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Computer Management.

2. Expand System Tools, expand Local Users and Groups, and then click the Groups folder.
The folder contents appear in the details pane.

3. In the details pane, click BizTalk Server Administrators.

4. On the Action menu, point to All Tasks and click Add to Group.
The BizTalk Server Administrators Properties dialog box appears.

5. Click Add.
6. In the Look in list, click your domain or computer name.

7. In the list that contains the users and computers associated with the domain or computer you selected in step 6, click the
user account to add, click Add, and then click OK.

8. Click OK to close the BizTalk Server Administrators Properties dialog box.
¥ Notes

e This procedure is based on the assumption that the BizTalk Server Administration group name is BizTalk Server
Administrators.

e If necessary, log off and log in using your user account.

Related Topic

Administration Privileges



Configure the BizTalk Messaging Management database

1. In BizTalk Server Administration, click Microsoft BizTalk Server 2000.

2. On the Action menu, click Properties.
The Microsoft BizTalk Server 2000 Properties dialog box appears.

3. On the General tab, you can change the following properties:

e SQL database name. Type the name of the BizTalk Messaging Management database that you want all server groups
to use.

e SQL Server name. Type the name of the server that stores the Microsoft SQL Server database on which the BizTalk
Messaging Management database is stored.

e User name. You can change the SQL Server logon user name that is used to connect to the server on which the
BizTalk Messaging Management database is stored.

e Password. You can change the SQL Server logon password that is used to connect to the server on which the BizTalk
Messaging Management database is stored.

4. Click OK.
¥ Caution

e Use this procedure if you need to bring the BizTalk Messaging Management database offline for maintenance. However, you
must point to a replicated database, not a different BizTalk Messaging Management database that has other server groups
associated with it. For more information about changing the database,
see Changing the BizTalk Messaging Management database.

[# Notes

e When you change either the BizTalk Messaging Management database or point the server groups to a different Microsoft
SQL Server, you must complete the following steps:

1. Stop all servers in the Microsoft BizTalk Server 2000 node. For more information about how to stop servers,
see Stop a server in a group.

2. Shut down the BizTalk Server Interchange Application. For more information about how to shut down the BizTalk
Server Interchange Application, see Shut down the BizTalk Server Interchange Application.

3. Restart all servers in the Microsoft BizTalk Server 2000 node. For more information about how to restart servers,
see Start a server in a group.

When you change the BizTalk Messaging Management database or point the server groups to a different Microsoft SQL
Server, all BizTalk servers in the central BizTalk Messaging Management database are updated with the new information.

e |f you change the BizTalk Messaging Management database of your existing server and then add your existing server to a
new group, you might encounter problems when you submit a document to your existing server. To avoid potential
problems, stop all servers in the Microsoft BizTalk Server 2000 node, shut down the BizTalk Server Interchange Application,
and then restart all the servers in the Microsoft BizTalk Server 2000 node. For more information about how to stop a server,
see Stop a server in a group. For more information about shutting down the BizTalk Server Interchange Application,
see Shut down the BizTalk Server Interchange Application. For more information about how to restart servers,
see Start a server in a group.

Related Topics

Changing the BizTalk Messaging Management database
Shut down the BizTalk Server Interchange Application

Start a server in a group



Stop a server in a group



Refresh the administration console

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and expand the items in the console tree until
you locate the item that you want to refresh. You might need to expand server groups, Queues, Receive Functions, and
Servers to find the item you want to refresh.

2. Click the item you want to want to refresh.

3. On the Action menu, click Refresh.
[# Notes

e In BizTalk Server Administration, you can refresh the status of the following items:
e The Microsoft BizTalk Server 2000 node

e Server groups
e Servers
e Queues

e Receive functions

® You can perform this procedure on any item in the console tree. When you refresh the administration console at the root, all
items in the administration console are refreshed. When you refresh a server group, only the items in that group are
refreshed.

e There is no automatic refresh cycle for the administration console. Perform this procedure to view the current status of
server groups, servers, receive functions, the number of items in a queue, and so on.

Related Topics

Groups and Servers
Receive Functions

Using Queues



Start the BizTalk Messaging Service

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. Verify that Services (Local) is selected.
3. In the details pane, click BizTalk Messaging Service.

4. On the Action menu, click Start.



Add, Delete, and Configure a Server Group

You can perform the following procedures to add, delete, and configure a server group:

e Add a server group

e Configure general properties for a server group

e Configure connection properties for a server group
e Configure tracking properties for a server group

e Configure the parser order for a server group

e Delete a server group



Add a server group

1. In BizTalk Server Administration, click Microsoft BizTalk Server 2000.

2. On the Action menu, point to New and click Group.
The New Group dialog box appears.

3. In the Group name box, type the name of the new server group.

4. In the Tracking database area:
e In the Tracking database name box, type the name of the Tracking database for this server group.

e In the Tracking SQL Server name box, type the name of the server on which the Tracking database for this server
group is stored.

o In the User name and Password boxes, type the Microsoft SQL Server logon user name and password that are used
to connect to the server on which the Tracking database is stored.

User name is a required field. Password is an optional field. Leave this field blank if a password is not required to
connect to the server.

5. In the Shared Queue database area:
o In the Shared Queue database name box, type the name of the Shared Queue database for this server group.

e In the Shared Queue SQL Server name box, type the name of the server on which the Shared Queue database for
this server group is stored.

e |n the User name and Password boxes, type the SQL Server logon user name and password that are used to connect
to the server on which the Shared Queue database is stored.

User name is a required field. Password is an optional field. Leave this field blank if a password is not required to
connect to the server.

6. Click OK.
¢ Important

e Do not use any of the following characters in the name of the server group: "' @ #$ % *» & * () + =[] {}|\\"'< >,. 2. For
more information about invalid characters, see WMI Overview.

¥ Note

e This procedure creates a server group. To configure the server group with additional settings,
see Configure general properties for a server group.

Related Topics

Add, Delete, and Configure Servers in a Group
Configure general properties for a server group

Groups and Servers

Managing the BizTalk Messaging Management Database
Shared Queue Database

Tracking Database

WMI Overview



Configure general properties for a server group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and then click the server group you want to
configure.

2. On the Action menu, click Properties.
The BizTalk Server Group Properties dialog box appears.

3. In the SMTP host box, type the Simple Mail Transfer Protocol (SMTP) host name that this server group uses.

This field is optional. Use this configuration if you use BizTalk Server to send documents to a trading partner or to an
internal application by using SMTP .

4. In the Reliable messaging reply-to URL box, type the URL this server group uses to receive reliable messaging delivery
receipts by using one of the following supported protocols: File, Message Queuing, HTTP, HTTP/S, or SMTP.

For the following transport Use this prefix

File file://

Message Queuing queue://Direct=0S:<servername >\<queuename>
Hyper Text Transport Protocol (http) http://

Hyper Text Transport Protocol Secure (https)|https://

SMTP mailto:

If you specify Message Queuing, you must use a format name. In addition, "queue://" must precede the format name. For
more information about format names, see Available Receive Functions.

5. In the Messaging Management object cache refresh interval (seconds) list, click the number of seconds between
cache updates for the server group.

By default, the server updates this cache every 50 seconds.

6. In the Proxy server area, select the Use a proxy server check box if you want to configure BizTalk Server to connect to the
Internet through a proxy server.

Enter the address and port of the proxy server that you want to use.

7. Click OK.

8. Perform the following steps only if you made any changes in the Proxy server area.

e Stop each server in the group for which you configured the general properties. For more information about stopping
a server, see Stop a server in a group.

e Start each server in the group for which you configured the general properties. For more information about starting a
server, see Start a server in a group.

¢ Important

o The SMTP host field is optional. However, you must configure this field if you plan to use SMTP as a transport service in
BizTalk Messaging Manager. For example, you cannot choose SMTP as primary or backup transport in BizTalk Messaging
Manager unless you have the SMTP host configured here.

[# Notes

o Reliable messaging in BizTalk Server is BizTalk Framework 2.0 compliant. For more information about reliable messaging
and BizTalk Framework 2.0, go to the Microsoft Web site (microsoft.com/biztalk/) and search for "BizTalk Framework 2.0".

e When you configure the Reliable messaging reply-to URL, use an active server page (ASP) or message queue with a
receive function monitoring it. If you do not want to configure your own ASP page initially, use the ReceiveStandard.asp file
shipped with BizTalk Server. You can find this sample ASP page in \Program Files\Microsoft BizTalk Server\SDK\Messaging
Samples\Receive Scripts. This page is designed to take posts and submit them to BizTalk Server. For more information
about implementing a secure site, go to the MSDN Online Library Web site (www.msdn.microsoft.com/library/default.asp)


http://microsoft.com/biztalk/
http://www.msdn.microsoft.com/library/default.asp

and search for the article "Implementing a Secure Site with ASP".

e If you specify the URL to include localhost in the Reliable messaging reply-to URL box, the receive function will not work
properly. Do not specify localhost in this field.

e The response to an HTTP post is expected to be text. If the response requires binary data, encode the binary data using MIME
or UUEncode.

Related Topics

Administration Cache
Available Receive Functions
Start a server in a group

Stop a server in a group



Configure connection properties for a server group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and then click the server group that you want to
configure.

2. On the Action menu, click Properties.
The BizTalk Server Group Properties dialog box appears.

3. Click the Connection tab.

4. In the Tracking database area:
o In the Tracking database name box, type the name of the Tracking database that you want this server group to use.

o In the Tracking SQL Server name box, type the name of the Microsoft SQL Server that stores the Tracking database
that you want this server group to use.

o In the User name and Password boxes, type the Microsoft SQL Server logon user name and password that are used
to connect to the server on which the Tracking database is stored.

5. In the Shared Queue database area:

o In the Shared Queue database name box, type the name of the Shared Queue database that you want this server
group to use.

o In the Shared Queue SQL Server name box, type the name of the Microsoft SQL Server that stores the Shared
Queue database that you want this server group to use.

® In the User name and Password boxes, type the SQL Server logon user name and password that are used to connect
to the server on which the Shared Queue database is stored.

6. Click OK.
¥ Note

o If you change information in the Tracking database or Shared Queue database areas, you must complete the following
steps:

1. Stop all servers in the Microsoft BizTalk Server 2000 node. For more information about how to stop servers,
see Stop a server in a group.

2. Shut down the BizTalk Server Interchange Application. For more information about how to shut down the BizTalk
Server Interchange Application, see Shut down the BizTalk Server Interchange Application.

3. Restart all servers in the Microsoft BizTalk Server 2000 node. For more information about how to restart servers,
see Start a server in a group.

e [f you change any values in the Tracking database area, you must update the connection string in the Connection.vb file
with the new Tracking database information. You can find Connection.vb in the \Program Files\Microsoft BizTalk
Server\BizTalkTracking\VBScripts folder. The Initial Catalog property in the connection string contains the name of the
Tracking database. Update this property to update the Tracking database name. The connection string in the Connection.vb
fileis:

Const g ConnectionString = "Provider=SQLOLEDB.1;
Persist Security Info=False;User ID=dta ui login;
Password=;Initial Catalog=<databasename>;

Data Source=<servername>;Connect Timeout=15"

Related Topics



Available Receive Functions

Groups and Servers

Shut down the BizTalk Server Interchange Application
Start a server in a group

Stop a server in a group



Configure tracking properties for a server group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and then click the server group that you want to
configure.

2. On the Action menu, click Properties.
The BizTalk Server Group Properties dialog box appears.

3. Click the Tracking tab.

4. Select the Enable document tracking check box and any of the following options that you want to use:

o Select the Log incoming interchange check box to log incoming interchanges.
e Select the Log outgoing interchange check box to log outgoing interchanges.

e Select the Log the original MIME-encoded message check box to log MIME-encoded messages.
5. Click OK.
¥ Caution

® You can disable tracking by clearing the Enable document tracking check box. However, you will lose important BizTalk
Server 2000 functionality if you disable document tracking. For more information about tracking,
see Understanding Tracking Settings For a Server Group.

¥ Note

o |f the Enable document tracking check box is not selected, the Log incoming interchange, Log outgoing
interchange, and Log the original MIME-encoded message check boxes are unavailable.

Related Topics

Groups and Servers

Understanding Tracking Settings for a Server Group



Configure the parser order for a server group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and then click the server group for which you
want to configure the parser order.

2. On the Action menu, click Properties.
The BizTalk Server Group Properties dialog box appears.
3. Click the Parsers tab.

The parsers are listed in the Arrange the server call sequence box in the following order:

o BizTalk.ParserXML.1
e BizTalk.ParserEdifact.1
e BizTalk.ParserX12.1

e BizTalk.ParserFFile.1
You can improve BizTalk Server performance by moving the most commonly used parsers closer to the top of the list.

1. In the Arrange the server call sequence box, click the parser that you want to move and click either the up or down arrow
to move the selected parser higher or lower in the server call sequence.

2. When the parsers are arranged in the order you want, click OK.
¥ Note

o The Refresh button picks up new parsers registered in the local registry. If you want a new parser to appear in the Arrange
the server call sequence box, you must click the Refresh button on the server on which the parser is registered.

Related Topic

Using the IBizTalkParserComponent Interface



Delete a server group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and then expand the server group that you want
to delete.

2. Click a server in the server group that you want to delete.

3. On the Action menu, click Stop.
Repeat steps 2-3 for each server in the group until you have stopped all servers in the group.

4. Click the server group.

5. On the Action menu, click Delete.
The User Action Confirmation dialog box appears.
6. Click Yes.
[ Notes

® You cannot delete a server group that contains one or more running servers. To stop the servers and delete the server
group, you must have Windows 2000 Administrator privileges for all the servers in the group.

e The Tracking and Shared Queue databases associated with the server group remain in Microsoft SQL Server even after you
delete the group. To remove the Tracking and Shared Queue databases, you must manually delete them. For more
information about how to delete these databases, see Remove the Tracking and Shared Queue databases.

Related Topics

Groups and Servers
Remove the Tracking and Shared Queue databases

Stop a server in a group



Add, Delete, and Configure Servers in a Group

The following procedures are used to add, delete, and configure servers in a group:

® Add a server to a group
e Delete a server from a group
e Configure a server in a group

e Change the BizTalk Messaging Management database for a server



Add a server to a group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, and then click the server group to which you
want to add a server.

2. On the Action menu, point to New, and then click Server.
The Add a BizTalk Server dialog box appears.

3. In the BizTalk Server name box, type the name of an existing server on which you have a complete installation of BizTalk
Server 2000.

4. Click OK.
¥ Note

e To view the global properties for the server group to which you added the server by right-click the group, and click
Properties.

Related Topics

Groups and Servers
Run Servers in a Group

Understanding server properties



Delete a server from a group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group that contains the server
that you want to delete, and then click the server.

2. On the Action menu, click Stop.
The server finishes processing all current interchanges and documents.

3. On the Action menu, click Delete.
The User Action Confirmation dialog box appears.

4. Click Yes.
[# Note

e You cannot delete a server from a server group if a receive function(s) points to it to process documents. You can edit the
receive function(s) to point to other servers, or you can delete the receive function(s) if it no longer can be used.

Related Topics

Free interchanges from a server
Groups and Servers
Manage Receive Functions for a Server Group

Run Servers in a Group



Configure a server in a group

1

. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group that contains the server
you want to configure, and then click the server.

2. On the Action menu, click Stop.

You cannot change server configuration settings while the server is running.

3. On the Action menu, click Properties.

The <Computername> Properties dialog box appears.

4. In the Maximum number of receive function threads allowed box, type a number in the range from 1 through 128.
The default value is 4. For more information about how to configure this option, see Understanding server properties.

5. If you want the server to process items in the Work queue, select the Participate in work-item processing check box.
When this check box is selected, the server processes documents in the Work queue. Clear this check box if you do not want
the server to process documents in the Work queue. For more information about how to configure this option,
see Understanding server properties.

6. In the Maximum number of worker threads per processor allowed box, type a number in the range from 1 through
128.

The default value is 4. For more information about how to configure this option, see Understanding server properties.

7. In the Time between BizTalk Server Scheduler calls (milliseconds) box, type a number in the range from 1 through
4,294,967,295.

The default value is 200. For more information about how to configure this option, see Understanding server properties.

8. Click OK.

9. Right-click the server you configured and click Start.

¥ Note

o |[f the Participate in work-item processing check box is not selected, the Maximum number of worker threads per

processor allowed and Time between BizTalk Server Scheduler calls (milliseconds) check boxes are unavailable.

Related Topics

Groups and Servers

Run

Servers in a Group

Understanding server properties



Change the BizTalk Messaging Management database for a
server

10.

11.

12.

13.

14.

15.

16.

17.

. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group that contains the server

for which you want to change the BizTalk Messaging Management database, and then click the server.

. On the Action menu, click Stop.

. On the Action menu, click Delete.

The User Action Confirmation dialog box appears.

Click Yes.

. Close BizTalk Server Administration.

On the Start menu, point to Programs, point to Accessories, and then click Windows Explorer.

. Browse to \Program Files\Microsoft BizTalk Server\Setup.

Click BTSsetupDB.exe.

. On the File menu, click Open.

The Microsoft BizTalk Server 2000 Database Setup Wizard opens.

On the Welcome to the Microsoft BizTalk Server 2000 Database Setup Wizard page, click Next.

On the Configure a BizTalk Messaging Management Database page, click Create a new BizTalk Messaging
Management database.

_Or_

Click Select an existing database.

In the Server name box, click the name of the server where the new or existing BizTalk Messaging Management database is
located.

In the User name and Password boxes, type a valid user name and password to access the SQL server, if required.

In the Database box, type the name of the new or existing BizTalk Messaging Management database.

Click Next.

On the Configure a BizTalk Server Group page, click Create a new BizTalk Server group. In the Group name box, type
the name of the new group, and then click Next.

—Or—

Click Select an existing BizTalk Server group. In the Group name list, click the name of the existing group, and then click
Next.

You can only select an existing BizTalk Server group if you selected an existing database in step 11.
If necessary, click Create a new Tracking database and click Next.
—Or—

Click Select an existing database. In the Server name list, click a server. In the User name and Password boxes, type a
valid Microsoft SQL Server user name and password, if required. In the Database box, type the name of the database. Click
Next.



18.

19.

20.

21.

22.

23.

If necessary, click Create a new Shared Queue database, and then click Next.
_Or_

Click Select an existing database. In the Server name list, click a server. In the User name and Password boxes, type a
valid SQL Server user name and password, if required. In the Database box, type the name of the database. Click Next.

On the Verify BizTalk Server Group page, verify the information you entered, and then click Next.
On the Completing the Microsoft BizTalk Server 2000 Database Setup Wizard page, click Finish.
Open BizTalk Server Administration.

Expand Microsoft BizTalk Server 2000, expand the server group that contains the server for which you just changed the
BizTalk Messaging Management database, and then click the server.

On the Action menu, click Start.

¢ Important

e Use this procedure to associate a server with a different BizTalk Messaging Management database. For more information

about moving servers between BizTalk Messaging Management databases,
see Moving servers between BizTalk Messaging Management databases. For more information about changing the BizTalk
Messaging Management database for server groups, see Changing the BizTalk Messaging Management database.

Related Topics

Changing the BizTalk Messaging Management database

Managing BizTalk Server Databases

Moving servers between BizTalk Messaging Management databases



Run Servers in a Group

The following procedures are used to run servers in a group:

e Startaserverina group
e Stop a server in a group

e Free interchanges from a server



Start a server in a group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group that contains the server
that you want to start, and then click the server.

2. On the Action menu, click Start.
[ Notes

e Starting a server in a server group means starting the BizTalk Messaging Service on the server. After the BizTalk Messaging
Service is running, the server can receive, transmit, process, and track documents that are queued to the Microsoft SQL
Server databases.

e The Start option is available only if the server is stopped. If the server is running, the command is unavailable.

Related Topics

Add, Delete, and Configure Servers in a Group
Administration Cache
Groups and Servers

Stop a server in a group



Stop a server in a group

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group that contains the server
that you want to stop, and then click the server.

2. On the Action menu, click Stop.
[ Notes

e Stopping a server in a server group means stopping the BizTalk Messaging Service on the server. After the BizTalk
Messaging Service is stopped, the server cannot receive, transmit, process, or track documents that are queued to the
Microsoft SQL Server databases.

o [f you want to redistribute interchanges associated with a server that you have stopped, see Free interchanges from a server.
Related Topics

Add, Delete, and Configure Servers in a Group
Administration Cache
Free interchanges from a server

Groups and Servers



Free interchanges from a server

This procedure is used to free interchanges from a server so that the interchanges can be redistributed to other servers in the
group if the original server is stopped or taken offline.

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group that contains the server
on which you want to free interchanges, and then click the server.

2. On the Action menu, click Stop.

3. On the Action menu, point to All Tasks, and then click Free Interchanges.

Related Topics

Add, Delete, and Configure Servers in a Group
Groups and Servers

Stop a server in a group



Manage Queues

The following procedures are covered in this topic:

Move documents to the Suspended queue
View error descriptions

View interchanges

View documents

Resubmit documents

Delete documents



Move documents to the Suspended queue

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the group that contains the document
that you want to move, and then expand Queues.

2. Expand the queue that contains the document that you want to move, and then click the document.

3. On the Action menu, point to All Tasks, and then click Move to Suspended Queue.

Related Topics

Suspended queue

Using Queues



View error descriptions

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the group that contains the document
that you want to view, expand Queues, and then click Suspended Queue.

2. In the details pane, click the document that you want to view.

3. On the Action menu, click View Error Description.

Related Topics

Suspended queue
Using Queues
View documents

View interchanges



View interchanges

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the group that contains the interchange
that you want to view, expand Queues, and then click Suspended Queue.

2. In the details pane, click the interchange that you want to view.

3. On the Action menu, click View Interchange.
The Document Content dialog box appears.
¥ Notes
e If you try to view a large interchange, the data might be truncated. You can view up to 4 MB of data in the Document

Content dialog box.

e |[f BizTalk Server could not parse the interchange, you might see binary data in the Document Content dialog box. For
more information about parser errors, see Parsing errors.

e View Interchange is an available menu option for the following Suspended queue states:

e Custom Component

Parsing

Encoding

Signing

Encrypting

e Transmitting
e View Interchange and View Document never appear on the Action menu at the same time.

Related Topics

An interchange or document appears as binary data in the Suspended queue
Suspended queue

Using Queues

View documents

View error descriptions



View documents

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the group that contains the document
that you want to view, expand Queues, and then click Suspended Queue.

2. In the details pane, click the document that you want to view.

3. On the Action meny, click View Document.
The Document Content dialog box appears.
¥ Notes
e If you try to view a large document, the data might be truncated. You can view up to 4 MB of data in the Document

Content dialog box.

e View Document is an available menu option for the following Suspended queue states:

e Document Validation
e Channel Selection

e Mapping

e Correlating

e Serializing
e View Interchange and View Document never appear on the Action menu at the same time.

Related Topics

An interchange or document appears as binary data in the Suspended queue
Suspended queue

Using Queues

View error descriptions

View interchanges



Resubmit documents

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the group that contains the document
that you want to resubmit, expand Queues, and then click Suspended Queue.

2. In the details pane, click the document that you want to resubmit.

3. On the Action menu, point to All Tasks, and then click Resubmit.
¥ Notes

e This procedure, Resubmit documents, can also be used to retransmit documents.

e Not all documents in the Suspended queue can be resubmitted. In some situations, you must delete the document and
submit it again from the original application or organization. For more information about documents in the Suspended
queue, see Suspended queue.

Related Topics

Suspended queue

Using Queues



Delete documents

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the group that contains the document
that you want to delete, expand Queues, and then click Suspended Queue.

2. In the details pane, click the document that you want to delete.

3. On the Action menu, click Delete.
The User Action Confirmation dialog box appears.

4. Click Yes.

Related Topics

Suspended queue

Using Queues



Manage Databases for a Server Group

The following procedures are used to manage databases for a server group:

e Shut down the BizTalk Server Interchange Application
e Remove the Tracking and Shared Queue databases
e Manually restore the Tracking database

e Manually restore the Shared Queue database



Shut down the BizTalk Server Interchange Application

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. Expand Component Services, expand Computers, expand My Computer, and then expand COM+ Applications.
3. Click BizTalk Server Interchange Application.

4. On the Action menu, click Shut down.
¥ Note

® You can shut down the BizTalk Server Interchange Application from a remote server. If you do this, expand the
<remotecomputername> instead of My Computer in step 1.

Related Topics

Administration Cache

Configure connection properties for a server group
Configure tracking properties for a server group
Groups and Servers

Open Component Services

Tracking Database



Remove the Tracking and Shared Queue databases

1. On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Enterprise Manager.

2. Expand Microsoft SQL Servers, expand SQL Server Group, and then expand the individual server that contains the
databases that you want to delete.

3. Expand the Databases folder, and then click the database that you want to delete.

4. On the Action menu, click Delete.
The Delete Database dialog box appears.
5. Click Yes.

[# Note

o The default name for the Tracking database is InterchangeDTA. The default name for the Shared Queue database is
InterchangeSQ.

Related Topics

Groups and Servers
Shared Queue Database
Stop a server in a group

Tracking Database



Manually restore the Tracking database

1.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Enterprise Manager.

Expand Microsoft SQL Servers, expand SQL Server Group, and then expand the server on which you want to restore the
database.

. Click Databases.

On the Action menu, click New Database.
The Database Properties dialog box appears.

On the General tab, in the Name box, type a name for the Tracking database, and then click OK.

. On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Query Analyzer.

The Connect to SQL Server dialog box appears.

. Click OK.

If you have Microsoft SQL Server 7.0 installed, in the Query window, in the DB list, click the name of the new Tracking
database.

—Or—
If you have Microsoft SQL Server 2000 installed, on the Objects tab, click the name of the new Tracking database.

Click the Load SQL Script (& button.

Browse to \Program Files\Microsoft BizTalk Server\Setup.

Click BTS_Tracking_Schema.sql, and then click Open.

Click the Execute Query button.

Click the Load SQL Script button.

Verify that you are in the folder \Program Files\Microsoft BizTalk Server\Setup.
Click BTS_Reporting.sql, and then click Open.

Click the Execute Query button.

Click the Load SQL Script button.

Verify that you are in the folder \Program Files\Microsoft BizTalk Server\Setup.
Click BTS_Tracking_Logic.sql, and then click Open.

Click the Execute Query button.

Click the Load SQL Script button.

Verify that you are in the folder \Program Files\Microsoft BizTalk Server\Setup.
Click BTS_WorkflowEvents.sql, and then click Open.

Click the Execute Query button.



25. Click the Load SQL Script button.

26. Verify that you are in the folder \Program Files\Microsoft BizTalk Server\Setup.
27. Click BTS_WorkflowSchema.sql, and then click Open.

28. Click the Execute Query button.

29. Close SQL Query Analyzer and SQL Server Enterprise Manager.
* Caution

e When you manually restore the Tracking database, you lose all data. If you need to keep this data, back up the data before
you restore the Tracking database.

¥ Note
e Use this procedure if the Tracking database becomes corrupted or damaged.
Related Topic

Manually restore the Shared Queue database



Manually restore the Shared Queue database

1. On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Enterprise Manager.

2. Expand Microsoft SQL Servers, expand SQL Server Group, and then expand the server on which you want to restore the
database.

3. Click Databases.

4. On the Action menu, click New Database.
The Database Properties dialog box appears.

5. On the General tab, in the Name box, type a name for the Shared Queue database and then click OK.

6. On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Query Analyzer.
The Connect to SQL Server dialog box appears.

7. Click OK.

8. If you have Microsoft SQL Server 7.0 installed, in the Query window, in the DB list, click the name of the new Shared Queue
database.

_Or_
If you have Microsoft SQL Server 2000 installed, on the Objects tab, click the name of the new Shared Queue database.

9. Click the Load SQL Script && button.
10. Browse to \Program Files\Microsoft BizTalk Server\Setup.
11. Click BTS_Core_Schema.sql, and then click Open.
12. Click the Execute Query button.
13. Click the Load SQL Script button.
14. Verify that you are in the folder \Program Files\Microsoft BizTalk Server\Setup.
15. Click BTS_Core_Logic.sql, and then click Open.
16. Click the Execute Query button.

17. Close SQL Query Analyzer and SQL Server Enterprise Manager.
* Caution

® When you manually restore the Shared Queue database, you lose all data. If you need to keep this data, back up the data
before you restore the Shared Queue database.

¥ Note
o Use this procedure if the Shared Queue database becomes corrupted or damaged.
Related Topic

Manually restore the Tracking database



Manage Receive Functions for a Server Group

The following procedures are used to manage receive functions for a server group:

e Add a File receive function

e Configure a File receive function: General tab

e Configure a File receive function: Services tab

e Add a Message Queuing receive function

e Configure a Message Queuing receive function: General tab

e Configure a Message Queuing receive function: Services tab

e Configure advanced properties for File or Message Queuing receive functions

e Delete a receive function



Add a File receive function

1.

10.

In BizTalk Server Administration, expand Microsoft BizTalk Server 2000 and expand the server group to which you want
to add the File receive function.

. Click Receive Functions.

. On the Action menu, point to New, and then click File Receive Function.

The Add a File Receive Function dialog box appears.

. In the Name box, type the name of the File receive function.

In the Comment box, add a brief description (optional).

. In the Server on which the receive function will run list, click the name of a server in the group.

In the File types to poll for box, type the extension of the files that BizTalk Server receives.
The file type extension must be written in the following syntax:
*.ext

For example: * xml

. In the Polling location box, type either the logical path or the universal naming convention (UNC) path to the directory this

receive function uses as the file receiving location.

. In the Preprocessor list, click the name of the custom preprocessor.

Leave this blank if you are not using a custom preprocessor.

In the User name and Password boxes, type a valid user name and password to connect to the file receive location
(optional).

This is required only when the receive location is protected and a valid user name and password are required to connect to
the server.

11. To customize the receive function for non-self-routing documents, or to specify openness or pass-through options, click
Advanced.
For more information about advanced options,
see Configure advanced properties for File and Message Queuing receive functions.
¥ Notes
e This procedure creates a File receive function with the default settings. To configure the File receive function with additional
settings, see Configure a File receive function: General tab.
e If you want to poll for more than one file type, use any standard wildcard format.
For example: ** or *x?|
e If you configure one or more File receive functions to monitor the same directory, use three-letter file extensions. If you use
file extensions of more than three letters, verify that the first three letters are unique.
For example: *xml, *.1xml, *.12xml
o File receive functions cannot process read only files.
o Verify that each receive function that you create has a unique name. You cannot assign identical names to receive functions.
Related Topics

Available Receive Functions



Configure advanced properties for File and Message Queuing receive functions
Configure a File receive function: General tab

Configure a File receive function: Services tab

Custom Preprocessors

Receive Functions



Configure a File receive function: General tab

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group for which you want to
configure a File receive function, and then expand Receive Functions.

2. Click the File receive function you want to configure.

3. On the Action menu, click Properties.
The Properties dialog box appears.

4. In the Comment box, add a brief description (optional).

5. In the Security area, in the User name and Password boxes, type a valid user name and password to connect to this
receive function.

This is required only when the receive location is protected and a valid user name and password are required to connect to
the server.

6. If you want to temporarily shut down the functionality of this receive function, select the Disable receive function check
box, and then click Yes to confirm your choice.

¥ Note
e File receive functions cannot process read only files.
Related Topics

Configure advanced properties for File and Message Queuing receive functions

Configure a File receive function: Services tab



Configure a File receive function: Services tab

1.

9.

In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group for which you want to
configure a File receive function, and then expand Receive Functions.

Click the File receive function that you want to configure.

. On the Action menu, click Properties.

The Properties dialog box appears.

. Click the Services tab.

In the Server on which the receive function will run list, click the server name.

. In the Polling location box, type either the logical path or the universal naming convention (UNC) path to the directory this

receive function uses as the file receive location.

In the File types to poll for box, type the extension of the files that BizTalk Server receives.
The file type extension must be written in the following syntax:
*.ext

For example: *.doc

. In the Preprocessor list, click the name of the custom preprocessor.

Leave this blank if you are not using a custom preprocessor.

Click OK.

[# Note

e If you want to receive multiple file types, use any standard wildcard format.

For example: *.*

o If you configure one or more File receive functions to monitor the same directory, use three-letter file extensions. If you use

file extensions of more than three letters, verify that the first three letters are unique.

For example: *xml, *.1xml, *.12xml

e File receive functions cannot process read only files.

Related Topics

Available Receive Functions

Configure advanced properties for File and Message Queuing receive functions

Custom Preprocessors



Add a Message Queuing receive function

1.

10.

In BizTalk Server Administration, expand Microsoft BizTalk Server 2000 and expand the server group for which you want
to add a Message Queuing receive function.

. Click Receive Functions.

. On the Action menu, point to New, and then click Message Queuing Receive Function.

The Add a Message Queuing Receive Function dialog box appears.

. In the Name box, type the name of the Message Queuing receive function.

In the Comment box, add a brief description (optional).

. In the Server on which the receive function will run list, click the name of a server in the group.

In the Polling location box, type the server and Message Queuing names that this receive function uses as the receive
location.

For example:
Direct=0S:<servername>\<queuename>

Select the processing server on which the queue resides. Transactional messaging is only supported by local queues.

. In the Preprocessor list, click the custom preprocessor.

Leave this blank if you are not using a custom preprocessor.

. In the User name and Password boxes, type a valid user name and password to connect to Message Queuing.

This is required only when the receive location is not on the server processing interchanges and documents.

To customize the receive function for non-self-routing documents, or to specify openness or pass-through options, click
Advanced.

For more information about advanced options,
see Configure advanced properties for File and Message Queuing receive functions.

¢ Important

e Do not prefix the <servername>\<queuename> with "queue:;//" in the Polling location box. This is different from the

general properties for a server group for which you use "queue;//". For more information about Message Queuing syntax,
see Available Receive Functions. For more information about properties for a server group,
see Configure general properties for a server group.

[# Notes

® For more information about custom preprocessing, see Custom Preprocessors.

e A Message Queuing receive function will not work unless the user name and password supplied to BizTalk Server is running

has read permission on the queue.

e To ensure reliability, you must use transactional queues. If you use nontransactional queues, messages might be lost. For

o Verify that each receive function that you create has a unique name. You cannot assign identical names to receive functions.

more information about transactional queues, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and search on the keywords "Message Queuing".

Related Topics

Available Receive Functions
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Configure advanced properties for File and Message Queuing receive functions
Configure a Message Queuing receive function: General tab
Custom Preprocessors

Receive Functions



Configure a Message Queuing receive function: General tab

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group for which you want to
configure a Message Queuing receive function, and then expand Receive Functions.

2. Click the Message Queuing receive function that you want to configure.

3. On the Action menu, click Properties.
The Properties dialog box appears.

4. In the Comment box, add a brief description (optional).

5. In the Security area, in the User name and Password boxes, type a valid user name and password to connect to the
Message Queue.
This is required only when the receive location is not on the processing server.

6. If you want to temporarily shut down the functionality of this receive function, select the Disable receive function check
box, and then click Yes to confirm your choice.

Related Topics

Configure a Message Queuing receive function: Services tab

Receive Functions



Configure a Message Queuing receive function: Services tab

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group for which you want to
configure a Message Queuing receive function, and then expand Receive Functions.

2. Click the Message Queuing receive function that you want to configure.

3. On the Action menu, click Properties.
The Properties dialog box appears.
4. Click the Services tab.
5. In the Server on which the receive function will run list, click the server name.
6. In the Polling location box, type the server and Message Queuing names that this receive function uses as the receive
location.
For example:
Direct=0S:<servername>\<queuename>
7. In the Preprocessor list, click the custom preprocessor.
Leave this option blank if you are not using a custom preprocessor.
8. Click OK.
¢ Important

e Do not prefix the <servername>\<queuename> with "queue://" in the Polling location box. This is different from the
general properties for a server group for which you use "queue://". For more information about Message Queuing syntax,
see Available Receive Functions. For more information about server group properties,
see Configure general properties for a server group.

[# Note

e For more information about custom preprocessing, see Custom Preprocessors.

Related Topics

Available Receive Functions
Configure general properties for a server group

Custom Preprocessors



Configure advanced properties for File or Message Queuing
receive functions

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group for which you want to
configure a receive function, expand Receive Functions, and then click the receive function that you want to configure.
2. On the Action menu, click Properties.
The Properties dialog box appears.

3. Click the Advanced tab.

4. In the Openness list, you can select:

e Not open. Click this option when the source and destination are both explicitly declared in the receive function or in
the document instance, and BizTalk Server does not have to parse the document for this information.

e Open Destination. Click this option when the destination information is not explicitly declared in the messaging port.
The destination is dynamically specified in the document instance or a submission parameter.

e Open Source. Click this option when the source information is not explicitly declared in the channel. The source is
dynamically specified in the document instance or a submission parameter.

5. If you want to bypass all processing, such as decoding, decryption, signature verification, parsing and so on, and only
transport an interchange, select the Submit with a pass-through flag check box.

You must select a channel if you select the Submit with a pass-through flag check box.
6. In the Envelope name list, click the name of an envelope definition.
Choose an envelope if you plan to receive flat files. Otherwise, leave this blank.

7. In the Channel name list, click the name of a channel.
8. In the Document definition name list, click the name of a document definition.

9. In the Source and destination area, in the Source selected area, click Browse.
The Select Source dialog box appears.

10. In the Organization qualifier list, click the type of source organization qualifier.
11. In the Organization identifier value list, click the source-organization identifier value and click OK.

12. In the Source and destination area, in the Destination selected area, click Browse.
The Select Destination dialog box appears.
13. In the Organization qualifier list, click the type of destination organization qualifier.
If you send documents to a distribution list, in the Organization qualifier list, you must choose GROUP.

14. In the Organization identifier value list, click the destination-organization identifier value, and then click OK.

15. Click OK.
¢ Important

e Before you can assign any of the objects in the following list as advanced properties of a receive function, you must create
them. These objects are either created in BizTalk Messaging Manager or they are created programmatically and stored in
the BizTalk Messaging Management database.

e Envelopes



e Channels

e Document definitions

e Source qualifiers

e Source-organization identifier values
e Destination qualifiers

e Destination-organization identifier values
[ Notes

o If you click Open Source or Open Destination in the Openness list, the Submit with a pass-through flag check box is
unavailable.

e |f you want to send a document to a distribution list, you must select GROUP in the Organization qualifier list in the
Select Destination dialog box.

o All the advanced receive-function properties are optional and can be left blank. For more information about submitting
documents, see Routing or Understanding Receive Functions and Document Routing.

o |f the Submit with a pass-through flag check box is enabled, only the Channel list is available.

® A pass-through submission bypasses the parsing, decryption, and decoding functions of BizTalk Server 2000. For more
information about submitting documents with the pass-through flag set,
see Understanding Receive Function Advanced Properties. For more information about submitting, see Submitting.

Related Topics

Receive Functions

Routing

Submitting

Understanding Receive Function Advanced Properties

Understanding Receive Functions and Document Routing



Delete a receive function

1. In BizTalk Server Administration, expand Microsoft BizTalk Server 2000, expand the server group in which you want to
delete a receive function, and then expand Receive Functions.

2. Click the receive function that you want to delete.

3. On the Action menu, click Delete.
The User Action Confirmation dialog box appears.

4. Click Yes.

Related Topic

Receive Functions



Manage Event Viewer

You can use the Event Viewer included in BizTalk Server Administration to help you troubleshoot server and document processing
problems. The Event Viewer appears in the console tree of BizTalk Server Administration. All application-related errors for BizTalk
Server 2000 are labeled BizTalk Server errors. All XLANG schedule-related errors are labeled XLANG Scheduler errors.

The following procedures are used to manage the Event Viewer:

e Configure Event Viewer for BizTalk Server errors

e View application-related errors in Event Viewer



Configure Event Viewer for BizTalk Server errors

1. In BizTalk Server Administration, expand Event Viewer.
2. Click Application.

3. On the Action menu, click Properties.
The Application Properties dialog box appears.

4. Click the Filter tab.

5. In the Event source list, click one of the following:

e BizTalk Server. This option filters the event sources for error messages that are related to BizTalk Messaging
Services.

e XLANG Scheduler. This option filters the event sources for error messages that are related to BizTalk Orchestration
Services.

6. Click OK to close the Application Properties dialog box.



View application-related errors in Event Viewer

1. In BizTalk Server Administration, expand Event Viewer.

2. Click Application.
Application error messages are listed in the details pane.

3. Click a message in the details pane.

4. On the Action meny, click Properties.
¥ Note

e This procedure assumes you configured the Event Viewer to display only BizTalk Server and XLANG Scheduler errors. For
more information about how to display BizTalk Server and XLANG Scheduler errors,
see Configure Event Viewer for BizTalk Server errors.

Related Topic

Configure Event Viewer for BizTalk Server errors



Manage XLANG Applications and Databases

This section provides information about how to manage COM+ applications that host XLANG schedules. It also includes
information about managing the default XLANG Scheduler application and Orchestration Persistence database that is created
when you install BizTalk Server 2000.

BizTalk Server 2000 provides a COM+ application called the XLANG Persistence Helper, which is used by all COM+ applications
that host XLANG schedule instances. You should not change the configuration of the XLANG Persistence Helper in any way after
setup completes.

The following procedures are covered in this section:

e Manage the Default XLANG Scheduler Application and Database
o Manage Other COM+ Applications That Host XLANG Schedules

® Monitor Running XLANG Schedules
¥ Notes

e For more information about Microsoft SQL Server, on the Start menu, point to Programs, point to Microsoft SQL Server,
and then click Books Online.

e For Component Services Administration Help, on the Start menu, point to Settings, click Control Panel, double-click
Administrative Tools, and then double-click Component Services. In the console tree, right-click Component Services,
and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Running XLANG Schedules

Run XLANG Schedules
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Manage the Default XLANG Scheduler Application and
Database

The default XLANG Scheduler application and Orchestration Persistence database are created during the installation of BizTalk
Server 2000. On production systems or systems running Microsoft Terminal Server, you need to change the default settings for
this application and database. You can also create new COM+ applications to host XLANG schedule instances and new persistence
databases to store XLANG schedule state information.

For information about creating a new COM+ application to host XLANG schedule instances
see Create a COM+ application to host XLANG schedules.

For more information about security and performance issues related to changing the default settings for the default XLANG
Scheduler application, see Security for Applications that Host XLANG Schedule Instances.

The following procedures are covered in this section:

e Configure the default XLANG Scheduler application

e Change the application identity for the default XLANG Scheduler application
e Change the settings for the default Orchestration Persistence database

e Shut down all XLANG applications

e Restart all XLANG applications

e [ Notes

e For more information about Microsoft SQL Server, on the Start menu, point to Programs, point to Microsoft SQL Server,
and then click Books Online.

e For Component Services Administration Help, on the Start menu, point to Settings, click Control Panel, double-click
Administrative Tools, and then double-click Component Services. In the console tree, right-click Component Services,
and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Running XLANG Schedules

Run XLANG Schedules
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Configure the default XLANG Scheduler application

The default XLANG Scheduler application and default Orchestration Persistence database are created during the installation of
BizTalk Server 2000. On production systems or systems running Microsoft Terminal Server, you need to change the default
settings for this application and database. You can also create new COM+ applications to host XLANG schedule instances and new
persistence databases to store XLANG schedule state information.

For information about creating a new COM+ application to host XLANG schedule instances
see Create a COM+ application to host XLANG schedules.

For more information about security and performance issues related to changing the default settings for the default XLANG
Scheduler application, see Security for Applications that Host XLANG Schedule Instances.

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+
Applications.

3. Click XLANG Scheduler. On the Action menu, click Properties.

4. Itis highly recommended that you change the application identity of the default XLANG Scheduler application, particularly
on production systems or systems running Microsoft Terminal Server. For more information,
see Change the application identity for the default XLANG Scheduler application.

5. ltis highly recommended that you change the default database settings for the Orchestration Persistence database. For
more information, see Change the settings for the default Orchestration Persistence database.

[# Notes

e The data source name (DSN) and the COM+ application must be the same. For example, if the COM+ application hosting
the XLANG Scheduler Engine is called XLANG Scheduler, the DSN must also be called XLANG Scheduler.

e For Component Services Administration Help, on the Start menu, point to Settings, and then click Control Panel, double-
click Administrative Tools, and then double-click Component Services. In the console tree, right-click Component
Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Change the application identity for the default XLANG Scheduler application
Change the DSN settings for a COM+ application

Change the settings for the default Orchestration Persistence database
Create a new persistence database

Creating an Instantiating Application

Restart all XLANG applications

Running XLANG Schedules

Run XLANG Schedules

Shut down all XLANG applications
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Change the application identity for the default XLANG
Scheduler application

It is recommended that you change the default interactive user account for the default XLANG Scheduler application to a service
account.

For more information about security and performance issues related to changing the default settings for the default XLANG
Scheduler application, see Security for Applications that Host XLANG Schedule Instances.

1.

10.

On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+

Applications.

Click XLANG Scheduler. On the Action menu, click Properties.

. On the Advanced tab, in the Permission area, clear the Disable changes check box, and then click OK.

The following message appears: The applications were created by one or more external products. Are you certain the
changes you are about to make are supported by these products?

. Click Yes.

The XLANG Scheduler Properties dialog box closes.

. Click XLANG Scheduler. On the Action menu, click Properties.
. On the Identity tab, in the Account area, click This user.
. Type the information for the account that you want to use.

. Click OK.

The following message appears: The applications were created by one or more external products. Are you certain the
changes you are about to make are supported by these products?

Click Yes.

[# Notes

e For Component Services Administration Help, on the Start menu, point to Settings, and then click Control Panel, double-

click Administrative Tools, and then double-click Component Services. In the console tree, right-click Component
Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site

(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Change the settings for the default Orchestration Persistence database

Configure the default XLANG Scheduler application

Running XLANG Schedules

Run XLANG Schedules

Security for Applications that Host XLANG Schedule Instances
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Change the settings for the default Orchestration Persistence
database

When you install BizTalk Server 2000, the Orchestration Persistence database is set up and configured with default settings. You
can change these default settings to a configuration that is suitable for the system you are running.

1. On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Enterprise Manager.

2. Expand Microsoft SQL Servers, expand SQL Server Group, expand the server that contains the default database, and then
expand Databases.

3. Click the XLANG database. On the Action menu, click Properties.

4. There are six tabs on which you can set various database properties:

e General

e Data Files

e Transaction Log
o Filegroups

e Options

e Permissions
For more information about configuring databases in Microsoft SQL Server, see Microsoft SQL Server Books Online.
¢ Important
e This procedure assumes that you set up the default database with the name XLANG.

[# Notes

e The primary database and transaction log files are created by using the database name as the prefix. For example,
XLANGdb_Data.mdf and XLANGdb_Log.Idf. The primary file contains the system tables for the database.

e The maximum database size is determined by the amount of disk space available and the licensing limits for the version of
Microsoft SQL Server that you are using.

e The object name of the Default Orchestration database is XLANG. You can change this name during the installation process.

e For more information about SQL Server, on the Start menu, point to Programs, point to Microsoft SQL Server, and then
click Books Online.

Related Topics

Change the application identity for the default XLANG Scheduler application
Configure the default XLANG Scheduler application

Running XLANG Schedules

Run XLANG Schedules

Security for Applications that Host XLANG Schedule Instances



Shut down all XLANG applications

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click click
Component Services.

2. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+
Applications.

3. Click XLANG Scheduler. On the Action menu, click Properties.

4. On the XLANG tab, in the Controlled shutdown area, click All XLANG Applications.
¥ Caution

e You must follow this procedure to execute a controlled shutdown for all COM+ applications. Doing this saves the state for
all running XLANG schedules to the persistence database. For more information, see Persistence.

Do not right-click a COM+ application and click Shut down. One of the following might occur:
e [f running XLANG schedules are fully transactional, an uncontrolled shutdown causes any executing transactions to

abort.

e [f running XLANG schedules are not fully transactional, data that is in process in the schedule is lost.
¢ Important

® You cannot restart dehydrated XLANG schedules if the data source name (DSN) is not available or if it is incorrectly
configured. For more information about configuring a DSN for the default XLANG Scheduler application,
see Configure the default XLANG Scheduler application.

[# Notes

e For Component Services Administration Help, on the Start menu, point to Settings, and then click Control Panel, double-
click Administrative Tools, and then double-click Component Services. In the console tree, right-click Component
Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Configure the default XLANG Scheduler application
Restart all XLANG applications

Running XLANG Schedules

Run XLANG Schedules

Shut down a COM+ application that hosts XLANG schedules
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Restart all XLANG applications

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+
Applications.

3. Click XLANG Scheduler. On the Action menu, click Properties.

4. On the XLANG tab, in the Restart dehydrated XLANG applications area, click All XLANG Applications.
¢ Important

® You cannot restart dehydrated XLANG schedules if the data source name (DSN) is not available or if it is incorrectly
configured. For more information about configuring a DSN for the default XLANG Scheduler application,
see Configure the default XLANG Scheduler application.

e When you restart dehydrated applications, this process starts the rehydration of the dehydrated schedules asynchronously.
The rehydration process is not immediate. Use XLANG Event Monitor to determine when the rehydration process is
complete. For more information about the XLANG Event Monitor tool, see the Readme.htm file associated with the tool.
Both XLANG Event Monitor (XLANGMon.exe) and the readme installed by the Microsoft BizTalk Server 2000 Setup Wizard
are located in the following installation directory: \Program Files\Microsoft BizTalk Server\SDK\XLANG Tools.

[# Notes

e For Component Services Administration Help, on the Start menu, point to Settings, and then click Control Panel, double-
click Administrative Tools, and then double-click Component Services. In the console tree, right-click Component
Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Configure the default XLANG Scheduler application
Running XLANG Schedules

Run XLANG Schedules

Shut down a COM+ application that hosts XLANG schedules

Shut down all XLANG applications
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Manage Other COM+ Applications That Host XLANG Schedules

Most COM+ applications that host XLANG schedules must be created when the XLANG schedule is developed. You must take into
consideration security and performance needs for the applications and the schedules, and you might want to create specific
COM+ applications to run specific schedules. For more information, see Run XLANG Schedules and Running XLANG Schedules.

The following procedures are covered in this section:

e Create a new persistence database
e Change the application identity for a COM+ application
e Change the DSN settings for a COM+ application

e Shut down a COM+ application that hosts XLANG schedules

[# Notes
e For more information about Microsoft SQL Server, on the Start menu, point to Programs, point to Microsoft SQL Server,

and then click Books Online.

e For Component Services Administration Help, on the Start menu, point to Settings, and then click Control Panel, double-
click Administrative Tools, and then double-click Component Services. In the console tree, right-click Component
Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Running XLANG Schedules

Run XLANG Schedules
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Create a new persistence database

1. On the Start menu, point to Programs, point to Microsoft SQL Server, and then click Enterprise Manager.

2. Expand Microsoft SQL Servers, expand SQL Server Group, expand the server for which you want to add a new database,
and then expand Database.

3. Click Databases. On the Action menu, click New Database.

4. On the General tab, in the Name box, type a name for the new database, and then click OK.

This action creates a new database with the default values set. You can change the default values. For more information
about configuring databases in Microsoft SQL Server, see Microsoft SQL Server Books Online.

[# Notes

e The primary database and transaction log files are created by using the database name as the prefix. For example,
XLANGdb_Data.mdf and XLANGdb_Log.Idf. The primary file contains the system tables for the database.

e The maximum database size is determined by the amount of disk space available and the licensing limits for the version of
Microsoft SQL Server that you are using.

e For more information about SQL Server, on the Start menu, point to Programs, point to Microsoft SQL Server, and then
click Books Online.

Related Topics

Configure the default XLANG Scheduler application
Running XLANG Schedules
Run XLANG Schedules

Security for Applications that Host XLANG Schedule Instances



Change the application identity for a COM+ application

1. On the Start menu, point to Settings, click to Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+
Applications.

3. Click the COM+ application for which you want to change the identity, and on the Action menu, click Properties.

4. On the Advanced tab, in the Permission area, verify that the Disable changes check box is cleared, and then click OK.
The properties dialog box closes.

5. Right-click the COM+ application again, and then click Properties.
6. On the Identity tab, in the Account area, click This user.
7. Type the information for the account that you want to use.

8. Click OK.

The following message appears: The applications were created by one or more external products. Are you certain the
changes you are about to make are supported by these products?

9. Click Yes.
[# Notes

e For more information about security and performance issues the application identity settings for a COM+ application that
hosts XLANG schedules, see Security for Applications that Host XLANG Schedule Instances.

e For Component Services Administration Help, on the Start menu, point to Settings, click Control Panel, double-click
Administrative Tools, double-click Component Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Change the settings for the default Orchestration Persistence database
Configure the default XLANG Scheduler application

Running XLANG Schedules

Run XLANG Schedules

Security for Applications that Host XLANG Schedule Instances
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Change the DSN settings for a COM+ application

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+
Applications.

3. Click the COM+ application for which you want to change data source name (DSN) settings. On the Action menu, click
Properties.

4. On the XLANG tab, click Configure DSN.
The ODBC Data Source Administrator dialog box appears.

5. Change any settings that you want to change.
¥ Caution

e After you change DSN settings, on the XLANG tab, do not click Initialize Tables. This action will destroy any data already in
the existing database.

¢ Important

e The DSN and the COM+ application must use the same name. For example, if the COM+ application is called XLANG
Scheduler, the DSN must also be called XLANG Scheduler.

e For more information about configuring a DSN and using data sources (ODBC), click Help in the ODBC Data Source
Administrator dialog box.

[# Notes

e For Component Services Administration Help, on the Start menu, point to Settings, click Control Panel, double-click
Administrative Tools, double-click Component Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Running XLANG Schedules
Run XLANG Schedules

Security for Applications that Host XLANG Schedule Instances
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Shut down a COM+ application that hosts XLANG schedules

1. On the Start menu, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click
Component Services.

2. In the console tree, expand Component Services, expand Computers, expand My Computer, and then expand COM+
Applications.

3. Click the COM+ application that hosts XLANG schedules that you want to shut down. On the Action menu, click Properties.

4. On the XLANG tab, in the Controlled shutdown areg, click This XLANG Application.
¥ Caution

e You must follow this procedure to execute a controlled shutdown for all COM+ applications. Doing this saves the state for
all running XLANG schedules to the persistence database. For more information, see Persistence.

Do not right-click a COM+ application and click Shut down. One of the following might occur:
o [f running XLANG schedules are fully transactional, an uncontrolled shutdown triggers all On Failure and

Compensation error-handling processes.

e [f running XLANG schedules are not fully transactional, data that is in process in the schedule is lost.
¢ Important

® You cannot restart dehydrated XLANG schedules if the data source name (DSN) is not available or it is incorrectly
configured. For more information about configuring a DSN for a COM+ application that hosts XLANG schedules,
see Configure a COM+ application to host XLANG schedules.

[# Notes

e When you create a COM+ application to host XLANG schedules, the Restart dehydrated applications options is not
available. For more information about how to restart dehydrated applications, see Restart all XLANG applications.

e For Component Services Administration Help, on the Start menu, point to Settings, and then click Control Panel, double-
click Administrative Tools, and then double-click Component Services. In the console tree, right-click Component
Services, and then click Help.

e For more information about Component Services and COM+, go to the MSDN Online Library Web site
(msdn.microsoft.com/library/default.asp), and browse to Component Services in the Platform SDK.

Related Topics

Configure a COM+ application to host XLANG schedules
Restart all XLANG applications

Running XLANG Schedules

Run XLANG Schedules
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Monitor Running XLANG Schedules

You can monitor running XLANG schedules by using either XLANG Event Monitor or Windows 2000 Event Viewer.

o XLANG Event Monitor. When the XLANG Scheduler Engine executes XLANG schedules, it generates various kinds of
events, showing the progress of the schedule instances. You can use XLANG Event Monitor to monitor XLANG schedule
events, and see the progress of the schedule instances. You can monitor the default XLANG Scheduler application or you
can monitor the custom COM+ applications that you create to host XLANG schedules. XLANG Event Monitor can subscribe
to all events published by the host applications on any number of local or distributed computers. XLANG Event Monitor can
also store these events to a file for later analysis.

For specific information about using XLANG Event Monitor, see the Readme.htm file associated with the tool. Both XLANG
Event Monitor (XLANGMon.exe) and the readme installed by the Microsoft BizTalk Server 2000 Setup Wizard are located in
the following installation directory: \Program Files\Microsoft BizTalk Server\SDK\XLANG Tools.

e Windows 2000 Event Viewer. Windows 2000 Event Viewer publishes event messages related to XLANG schedules. For
more information about using Event Viewer to view error messages see the following references:

e For information about configuring Event Viewer to filter for XLANG schedule error messages,
see Configure Event Viewer for BizTalk Server errors.

e For general information about Event Viewer, in Windows 2000 Server Help, in the Event Viewer chapter, see "Using
Event Viewer".

The following topic is covered in this section:
® XLANG Schedule Error Messages
Related Topic

Configure Event Viewer for BizTalk Server errors



XLANG Schedule Error Messages

The error messages in the following list are returned when a running XLANG schedule generates the error. These messages can
be viewed in Windows 2000 Event Viewer.

Message na
me

\')

Description

ID_CAT_UNK
NOWN

SVC%0

ID_CAT_NA
MESVC

NameSvc%0

ID_CAT_ENG
INE

Engine%0

ID_CAT_SYS
MGR

SystemMgr%0

ID_CAT_GRP
MGR

GroupMgr%0

ID_CAT_WEFS
VCMGR

WFSvcMgr%0

ID_CAT_OBJ
ECTMODEL

WFObjectModel %0

ID_CAT_BIN
DING

WFBinding%0

ID_CAT_CO
M_LAST

<>%0

IDS_I_MTST

OCOM_LAU

NCH_FINISH
ED

An unauthorized client attempted to create a new instance of an XLANG schedule. The remainder of the moniker s
tring and the identity of the client are shown in the following message. The client's security identifier (SID) is inclu
ded as binary data: %1%0

ID_W_NOT_
USER

An unauthorized client attempted to gain access to an existing instance of an XLANG schedule. The remainder of t
he moniker string identifying the instance and the identity of the client are shown in the following message. The cl
ient's security identifier (SID) is included as binary data: %1%0

IDS_E_COM
SVCS_INTER
NAL_ERROR

O OO WX O 0O NMNMX OO0 =X O|lVUX O(oX ONX OoOooX Ol X Ol X OWX OMX O X O Cc —9O

The XLANG Scheduler Engine has detected an inconsistency in its internal state. Please contact Microsoft Product
Support Services to report this error: %1%0




IDS_COMSV |0|The XLANG Scheduler Engine has detected the absence of a critical resource and has caused the process that host
CS_RESOUR [x [ed it to end: %1%0
CE_ERROR |3

0

0

1
IDS_COMSV |0|COM+ internal error. Please contact Microsoft Product Support Services to report this error. Assertion failure: %1
CS_INTERN |x|%0
AL_ERROR_ [3
ASSERT 0

0

2
ID_E_USER_ |0|The system has called a scheduled component and that component has failed and generated an exception. This in
EXCEPTION |x [dicates a problem with the scheduled component. Notify the developer of this component that a failure has occurr

3 |ed and provide the following information: %1%2%0

0

0

3
ID_INITIALIZ |0|The XLANG Scheduler Engine was unable to initialize for transactions that are required to support transactional co
E_FOR_DTC |x [/mponents. Make sure that MS DTC is running: %1%0

3

0

0

4
ID_E_CANT_ |0 |The XLANG Scheduler Engine was unable to create a user component that is required by the running XLANG sche
CREATE_CO [x [dule. Detailed information is provided in the following message. %1%0
MPONENT |3

0

0

5
ID_E_PROGI |0|The XLANG Scheduler Engine was unable to convert the Programmatic ID in the following message to a COM clas
D_NOT_FOU|x |s ID: %1%0
ND 3

0

0

6
ID_E_CANT_ |0|The XLANG Scheduler Engine was unable to create an interceptor object for the interface ID shown in the followin
CREATE_INT [x |[g message. Probable causes for this are 1) the interface isn't registered properly; 2) no type library is provided for
ERCEPTOR |3 |the interface; or 3) the file that contains the interface type information can't be loaded. The port name associated

0 |with this interceptor is: %1%0

0

7
ID_E_INTF_N|0|The XLANG Scheduler Engine detected an inconsistency between the port implementation and the COM compone
OT_SUPPOR [x [nts to which it refers. A component listed in the port implementation has failed to support the expected interface.
TED 3|The class ID of the component and the IID that it failed to support are shown in the following message. The port n

0|ame associated with this component is: %1%0

0

8
ID_E_UNKN |0|The XLANG Scheduler Engine received a call to a method that was not specified in the port implementation for thi
OWN_METH [x [s XLANG schedule. The IID and method number are shown in the following message. The name of the port on whi
oD 3|ch the call arrived is: %1%0

0

0

9
ID_E_UNKN |0|The XLANG Scheduler Engine received a call through the IDispatch::Invoke() interface to a method that no longe
OWNLIDISP [x |r exists. The dispatch ID for the method is shown in the following message. The name of the port on which the call
ATCH_METH |3 |arrived is: %1%0
oD 0

0

A




which the error occurred is also provided.%1%0

ID_E_NAME |0|The XLANG Scheduler Engine received a call through IDispatch::Invoke() interface to a method that contains na
D_PARAMS |x [med arguments. Use positional arguments instead. The dispatch ID for the method is shown in the following mess

3 |age. The name of the port on which the call arrived is: %1%0

0

0

B
ID_E_BAD_| |0|The XLANG Scheduler Engine received a call through the IDispatch::Invoke() interface to a method with an incor
NVOKE_PAR |x |rect number of parameters. The IID and the dispatch ID for the method are shown in the following message. The n
AMS 3 lame of the port on which the call arrived is: %1%0

0

0

C
ID_E_BAD_R |0|The XLANG Scheduler Engine received an incorrect Out parameter through the IDispatch::Invoke() interface fro
ETURN_POI |x |m a method. The reference returned was either not valid (NULL or a bad pointer) or does not support the expecte
NTER 3|d interface. The expected dispatch ID is shown in the following message. The name of the message containing the

0 |bad port reference is: %1%0

0

D
ID_E_ACCES |0|The XLANG Scheduler Engine was not able to authorize the client's moniker resolution request. Access is denied.%
S_CHECK_FA|x |0
ILURE 3

0

0

E
ID_E_BAD_| |0|The IDispatch:invoke() interface call to a method failed. The dispatch ID for the method is shown in the followin
NVOKE X |g message. The name of the port on which the call was attempted is: %1%0

3

0

0

F
ID_E_INVOK |0|The invoked method, whose dispatch ID is shown in the following message, reported an error. The name of the po
ED_METHO |x |rt on which the call was attempted is: %1%0
D 3

0

1

0
ID_E_CANT_ |0|The component whose port name and COM CLSID are shown in the following message was unable to supply req
GET_TYPEIN [x |uired type information to the XLANG Scheduler Engine.%1%0
FO 3

0

1

1
ID_E_CANT_I|0|The XLANG Scheduler Engine was unable to deliver a method call to the object associated with the port name sho
NVOKE_MET|x [wn in the following message. The interface and method name that are invoked are also shown.%1%0
HOD 3

0

1

2
ID_E_CANT_ |0|The component whose port name and COM CLSID are shown in the following message was unable to supply req
GET_CLASSI [x |uired type information to the XLANG Scheduler Engine through the IProvideClassinfo::GetClassInfo interface.%
NFO 3[1%0

0

1

3
ID_E_SCRIPT|0 |A scripted decision rule in an XLANG schedule instance could not be executed. The error returned by the script en
_ERROR x |gine is shown in the following message. The script's source code and information about the schedule instance in

3

0

1

4




ID_E_SCRIPT
_ERROR_NO
INFO

A scripted decision rule in an XLANG schedule instance has failed. Detailed information regarding the error could
not be obtained due to an internal error. The error code is shown in the following message.%1%0

ID_E_SCRIPT
_BADCONV

A scripted decision rule in an XLANG schedule instance referred to a message field whose type was incompatible
with the VBScript Engine. The XLANG Scheduler Engine attempted to convert the field to a compatible type but wa
s unable to do so. The information in the following message shows the script rule, message, and field involved; as
well as the original field variant type and the type to which a conversion was attempted. The field's VARIANT data
structure is attached to this log entry as binary data.%1%0

ID_E_SCRIPT
_BADARRAY

A scripted decision rule in an XLANG schedule instance referred to a message field containing an array type that is
incompatible with the VB script engine. Only variant arrays are supported by Visual Basic Scripting. The informati
on in the following message shows the script rule, message, and field involved. The field's VARIANT data structure
is attached to this log entry as binary data.%1%0

ID_E_SCRIPT
_BADEXPR

A scripted decision rule in an XLANG schedule instance contained an expression that did not return a Boolean res
ult. The information in the following message shows the script rule and expression involved. The VARIANT data st
ructure returned by the expression is attached to this log entry as binary data.%1%0

ID_E_SCHED
ULE_NOT_R
UNNING

The XLANG Scheduler Engine received a call to an object associated with a port in a XLANG schedule instance that
is not running. The name of the port on which the call arrived is: %1%0

ID_E_INTER
NAL_EXCEPT
ION

A COM+ internal exception occurred. Contact Microsoft Product Support Services to report this error, and provide
them with the information in the following message.%1%2 %0

ID_E_BAD_D
ATAFLOW_

NOMESSAG
E

There is a problem with the data-flow specification. A message that is indicated as a source of data does not curre
ntly exist while this XLANG schedule is running. Detailed information is provided in the following message.%1%0

ID_E_BAD_A
RGUMENTV
ALUE

One of the fields that is used as a parameter for a COM method call has a bad value type in it. This is most likely c
aused by incorrect or missing data flow. Detailed information is provided in the following message.%1%0

ID_E_DEEP_
VARIANT_N
ESTING

One of the fields that is used as a parameter for a COM method call has more than one nesting level of VARIANTS
. The IID and the method's dispatch ID are shown in the following message. The name of the port on which the call
arrived is: %1%0

ID_E_BAD_M
APPORTVAL
UE

m -2 O WX Ol 0WwWXoOoO N 0wWwWXOmw—_0O0WwWXOoO|>P_0WXOUWOV—_LOWXO—-_0OWXOoON_,OoOWwWXooh—0OWwXo|u -0 wX o

A field carrying a mapped port is not valid. Detailed information is provided in the following message.%1%0




ID_E_BAD_C |0|An incorrect number of parameters are being passed into a call. Detailed information is provided in the following
ALLPARAM |x [message.%1%0
NUMBER |3

0

1

F
ID_E_EXECU |0 |The XLANG schedule cannot be executed as a top-level schedule. Context parameters must be passed to it. Detaile
TINGCALLE |x |d information is provided in the following message.%1%0
DSCHEDULE |3

0

2

0
ID_E_CANT_ |0|The component whose port name and COM CLSID are shown in the following message was unable to return succ
GET_SUPPO (x |ess from an interface which it claimed to support to the XLANG Scheduler Engine via ISupportErrorinfo:interfaceS
RTERRORIN |3 |upportsErrorinfo.%1%0
FO 0

2

1
ID_E_PERSIS |0|The state of the schedule instance could not be saved to the database. Detailed information is provided in the follo
T_FAILURE |x |wing message.%1%0

3

0

2

2
ID_E_TRANS |0|The system failed to commit a transactional context. Detailed information is provided in the following message.%
ACTION_CO [x [1%0
MMIT_FAILU|3
RE 0

2

3
ID_E_TRANS |0|The system aborted a transactional context. Detailed information is provided in the following message.%1%0
ACTION_AB |[x
ORTED 3

0

2

4
ID_E_TRANS |0|The system failed to abort a transactional context. The state of this transaction is not known. Detailed information i
ACTION_AB [x |s provided in the following message.%1%0
ORT_FAILUR|3
E 0

2

5
ID_E_PENDI |0|The rehydration application encountered an error and is shutting down. Some of the rehydration requests will fail
NGREHYDR |[x [due to this shutdown. Restart the XLANG Scheduler Engine service. Detailed information is provided in the followi
ATIONERRO |3 |ng message.%1%0
R 0

2

6
ID_E_REHYD |0|One or more XLANG schedules could not rehydrated because of a system error. There might be problems reading
RATIONONS|x |the database or problems with the data that was read. Detailed information is provided in the following message.
TARTUPERR |3 (%1%0
OR 0

2

7
ID_E_REHYD |0 |An error was encountered while rehydrating an XLANG schedule. There might be a problem reading the database,
RATIONERR |x |or there might be a problem with the information stored. It is probable that the XLANG schedule was not dehydra
OR 3 |ted properly. Detailed information is provided in the following message.%1%0

0

2

8




ID_E_FOUN
DINITIALIZE
DTHREAD

The XLANG Scheduler Engine service encountered a critical thread-management error while processing an XLAN
G schedule. The schedule might fail to continue processing. Contact your technical support.%1%0

ID_E_CALLO
NCOMPLETE
DSCHEDULE

The XLANG Scheduler Engine service received a call on a completed XLANG schedule instance. The schedule insta
nce has already been removed from memory. The IID for the interface is shown in the following message.%1%0

IDS_MSG_TI
MEBOMB_E
XPIRED

Thank you for evaluating Microsoft BizTalk Server 2000. The period for this evaluation version has ended. Please c
ontact Microsoft or your software reseller to obtain a licensed version of Microsoft BizTalk Server 2000.%0

ID_E_FIELDP
ORTPERSIST
ENCEERROR

An error was encountered while attempting to persist an XLANG schedule instance. Detailed information is provid
ed in the following message.%1%0

ID_E_FIELDP
ORTREHYDR
ATIONERRO
R

An error was encountered while attempting to restore a particular sub-component of an XLANG schedule instanc
e from the database. Detailed information is provided in the following message.%1%0

ID_E_SCHED
ULEDONE

The XLANG Scheduler Engine encountered an error while marking the XLANG schedule instance as done. Either th
e database could not be updated or another error was encountered in the final stage. Detailed information is provi
ded in the following message.%1%0

ID_E_COMP
ONENT_INC
OMPATIBLE_
TXN

The XLANG Scheduler Engine encountered an error while attempting to instantiate a component. Either the comp
onent was previously enrolled in a different transaction, or the component was previously not enrolled in a transa
ction and the current instantiation requires a transaction. Detailed information is provided in the following messa
ge.%1%0

ID_E_SUSPE
ND_FAILURE

The XLANG schedule instance could not be suspended. Detailed information is provided in the following message.
%1%0

ID_E_INITNE
W

The XLANG Scheduler Engine received an error when doing IPersistStreamlnit:InitNew. The class ID of the com
ponent and the error code are shown in the following message. The port name associated with this component is:
%1%0

ID_E_POSSIB
LEBYOTISSU
E

P WO WX OWWOWXOINMWOWXO WO WXOoOOWOoOWXOoOghMNOWXOoOMNMMOWXO(mNOWXOI>PNOWXOIOUNOWX O

The component you requested could not be created. One possible reason for this is that you have configured the
BYOT component inside a COM+ application on this machine. This setting is incompatible with the XLANG Sched
uler service. The port name associated with this component is: %1%0




ID_E_FIELDP |0|The field value provided was not valid. Detailed information is provided in the following message.%1%0
ROCESSING [x
ERROR 3

0

3

5
ID_E_NO_OB|0|The XLANG schedule could not be instantiated. Detailed information is provided in the following message.%1%0
JECT X

3

0

3

6
ID_E_START |0|One or more of the XLANG Group Managers failed to startup with the following error: %1%0
UP_FAILED |x

3

0

3

7
ID_E_NON_S|0|An XLANG schedule instance has a rule comparing fields for data types that are not permitted. Detailed informatio
CRIPT_BADE [x [n is provided in the following message.%1%0
XPR 3

0

3

8
E_BTW_PER |0[The Record set cannot return this row, because the end-of-file (EOF) has been reached.%1%0
SIST_REACH |x
EDEOF 3

0

3

9
ID_E_BAD_D |0|There is a problem with the data-flow specification. A field indicated as a source of data is empty. This may be bec
ATAFLOW_E [x |ause it could not be persisted earlier. Detailed information is provided in the following message.%1%0
MPTYFIELD |3

0

4

0
ID_E_CANT_ |0|The XLANG Scheduler engine was unable to create or open the XLANG dead-letter queue for its host COM+ appli
OPEN_DEAD x |cation. The name of the failing COM+ application is: %1%0
LETTER_QUE|3
UE 0

4

1
ID_E_CANT_ |0|The XLANG Scheduler engine was unable to transfer an invalid message to the XLANG dead-letter queue for its h
XFER_TO_DE|x |ost COM+ application. The name of the failing COM+ application is: %1%0
ADLETTER_ (3
QUEUE 0

4

2
ID_E_CANT_ |0|The XLANG Scheduler engine was unable to load a required module. This may have been due to compilation/sem
LOADMODUIx |antic errors with the module. Detailed information is available in the following message: %1%0
LE 3

0

4

3
ID_E_USER_ |0|A value that was received from the client has caused an exception to be raised. This can be caused by incorrectly al
DATA_EXCE |x |locating memory for the data, by a reference counting mismatch, or other data corruption. The most likely source
PTION 3 |of the problem is in the client code. Detailed information is available in the following message: %1%2%0

0

4

4




E_BTW_INTE
RNAL_ERRO
R

An internal error has occurred. %1%0

E_EXPORT_F
AILED

The XLANG schedule could not be processed.%0

E_BTW_UNK
NOWN_SHA
PE

The compiler does not understand the shape. This shape is an unknown shape.%0

E_BTW_INC
OMPLETE_F
LOW

The flow is incomplete because a connector is missing.%0

E_BTW_INC
OMPLETE_F
LOW_LEFT

The flow is incomplete. The shape must have a flow connected to the left connector.%0

E_BTW_INC
OMPLETE_F
LOW_RIGHT

The flow is incomplete. The shape must have a flow connected to the right connector.%0

E_BTW_INC

OMPLETE_F
LOW_LATER
AL

The flow is incomplete. Shape not attached to anything on the side.%0

E_BTW_INC
OMPLETE_F
LOW_TOP

The flow is incomplete. The shape must have a flow connected to the top connector.%0

E_BTW_INC
OMPLETE_F
LOW_BOTT
oM

The flow is incomplete. The shape must have a flow connected from the bottom connector.%0

E_BTW_INC

OMPLETE_F
LOW_ANYLI
NE

The flow is incomplete. Not connected to any shape.%0




E_BTW_MIR
RORLIST_IN
CONSISTEN
T

Mirror shapes are not found in the On Failure or Compensation pages. Retry after replacing the shape with a new
one.%0

E_BTW_BEGI
N_INSIDE_T
RANSACTIO
N

The Begin shape must not be enclosed within a transaction.%0

E_BTW_END
_MULTIPLE_
LOOP

Only one End shape may be used in the loop branch.%0

E_BTW_END
_IN_TRANSA
CTION

The End shape cannot be used in the context.%0

E_BTW_SYN
CACTION_N
O_PAIR

Binding to COM port requires actions to appear in pairs.%0

E_BTW_INC
OMPLETE_F
LOW_BINDI
NG

No binding for this action or port.%0

E_BTW_FIEL
D_TYPE_NO
T_SUPPORT
ED

Type (variant type=%1) is not supported.%0

E_BTW_ROL
E_NOT_SUP
PORTED

Contracts (XLANG Schedules with Roles) cannot be compiled.%0

E_BTW_EMP
TY_TRANSA
CTION

The transaction contains no valid shapes.%0

E_BTW_TRA
NSACTION_
NOT_PERMI
TTED

oo bhMX O OCOOOO DX OOUMUO DX OOMMOPMMX O wWOPMAX OOWOMMX OO BMMX OONMVMVO DX OO, O b X OlmoOo O M X O

Transaction shapes are not permitted when the XLANG schedule is treated as a COM+ component. Remove the t
ransaction or edit the properties of the Begin shape to change the transaction model.%0




E_BTW_TRA
NSACTION_
BOUNDARIE
S_CROSSED

You cannot connect a flow from outside a transaction to a shape within a transaction without first connecting the f
low to the transaction. Draw your flow to the top connection point of a transaction to connect it to the transaction.
Then, click the transaction to highlight it. Draw another flow from the transaction connection point to the first sha
pe within the transaction. To draw a flow that leaves the transaction, you must first connect the flow to the connec
tion point at the bottom of the transaction. Then, click the transaction to highlight it. Draw another flow from the b
ottom connection point to the next shape in the business process.%0

E_BTW_TRA

NSACTION_
TERMINATE

D_PREMATU
RELY

At least one path within the transaction should flow out of the transaction.%0

E_BTW_NO_
RULES_FOR
_SWITCH

Decision shapes must contain at least one rule.%0

E_BTW_CAN
NOT_WAIT_
ON_ALL_SW
ITCH_BRAN
CHES

Cannot wait on "all" branches from the decision.%0

E_.BTW_NO_
BRANCH_FO
UND

The join cannot find the corresponding fork or decision.%0

E_BTW_JOIN
_MISMATCH

Only a single join may be used with a given fork or decision.%0

E_BTW_JOIN
_SHARED

The same join cannot be used for flows coming from different forks or decisions.%0

E_BTW_CAN
NOT_WAIT_
ON_SOME_
SWITCH_BR
ANCHES

Not all paths from the decision come to the join.%0

E_BTW_CAN

NOT_WAIT_

ANY_ON_FO
RK_BRANCH
ES

Cannot wait "Or". The branches contain process forms that may never finish resulting in hung schedules.%0

E_BTW_DAT
AFLOW_DIS
ALLOWED_
ON_BTM_P
ORT

oOoNodX oupobX OO X OWPOPAX OMI>POPMAXOPOMAXOOPOMMX OONO DX O(fWOO X OMDMDOO M X O

This port cannot be used in multiple receive actions or within a single receive action in a loop.%0




E_BTW_MES
SAGE_TECH_
NOT_FOUN
D

The message is not bound to any port.%0

E_BTW_MES
SAGE_TYPE_
MISMATCH

Message was used with conflicting types "%1" and "%2".%0

E_BTW_MIS
SING_TECH
NOLOGY

The list of available methods for this communication flow has changed. Re-run the Method Communication Wizar
d to select a different method and update this communication flow.%0

E_BTW_MIS
SING_PORT_
DATAFLOW

The settings for this port indicate that it is created externally to the XLANG Scheduler Engine. You must designate
the source of this port reference by drawing a connection from the appropriate message field.%0

E_BTW_CIRC
ULAR_DATA
FLOW

There appears to be a circular path in the data-flow path for this XLANG schedule.%0

E_BTW_LOO
P_NORULE

A rule has not been defined.%0

E_BTW_LOO
P_BODY_EXI
TS_TRANSA
CTION

The body of the loop cannot exit the enclosing transaction.%0

E_BTW_LOO
P_BODY_EN
D_MISSING

The end of the body of the loop is not found.%0

E_BTW_ABO
RT_NOT_IN_
TXN

Abort shapes must be associated with an enclosing transaction.%0

E_BTW_ABO
RT_CONTEX
T_INVALID_
SCOPE

- m =2 hMX OlOMm-=2 X OMNg-PIPX O|g-PPXOoOOg-_P+XO|Pp_b_X OO -~bdpX OON-=2 DX O =2 =2bdhX O/O- = h~X O

Abort shapes can refer to current or parent contexts only.%0




E_BTW_END
_MULTIPLE_
ABORT

Multiple End shapes are not allowed on the On Failure page.%0

E_BTW_CO
MPILER_FAI
LED

Compile failed on "%1".%0

E_BTW_PAR
SE_FAILED

Parse failed. %0

E_BTW_FIXU
P_FAILED

Fixup failed.%0

E_BTW_VALI
DATION_FAI
LED

Validation failed.%0

E_BTW_NOD
E_FAILURE

at node "%1" (%2!d!,%3!d!).%0

E_BTW_STA
CK_TOO_MA
NY_ITEMS

Too many items were found on the stack.%0

E_BTW_STA
CK_UNEXPE
CTED_NODE

An unexpected node was found.%0

E_BTW_XML
QUERY_RET
URNED_ZER
O_NODES

The XML Query returned zero nodes.%0

E_BTW_XML
QUERY_RET
URNED_MU
LTIPLE_NOD
ES

0O OoOuUT X ONOOuULX OO0 UL X O(LMooOouUT X OO OUX OWOOUIX OIMOOUT X O OCOOULTX O 0OOOWLVLIX OmMm—=pM~X O

The XML Query returned multiple nodes.%1%0




E_BTW_XML
QUERY_MIS
SING_ATTRI
BUTE

Required attribute "%1" is missing its value.%0

E_BTW_LOA
D_MODULE _
FAILED

Failed to load module "%1".%0

E_BTW_XML
_LOAD_FAIL
ED

The XML-DOM returned an error at "%1!d!, %2!d!".%0

E_BTW_ERR
OR_LOADIN
G_PACKAGE

0x%1!X! error occurred while trying to load the following URL: "%2".%0

E_BTW_NA
MED_LIST_H
AS_DUPLICA
TE_ENTRIES

The list has duplicate entries with the name "%1".%0

E_BTW_REQ
UIRED_ELEM
ENT_MISSIN
G

Required element "%1" is missing.%0

E_BTW_ELE
MENT_MISSI
NG_VALUE

The element value is missing.%0

E_BTW_REFE
RENCE_RES
OLVE_FAILE
D

Unable to resolve "%1" with location value "%2".%0

E_BTW_CON
TEXTREF_IN
VALID_REFE
RENCE

Returning to or "releasing" from an independent (non-enclosing) context is not permitted.%0

E_BTW_CON
TEXTREF_SE
LF_REFEREN
CE

N = U1 X O ONN -2 U1 X OO0 =2 U X OO U X OMOOUIX O gOoOoOoOuX ONoOoul X O moOoOoOuUuI X O OO0CUI X OO OWULIX O

Return or Release referring to a context from within that context is not permitted.%0




E_BTW_ASY
NC_ACTION
_COM_NOT_
ALLOWED

An asynchronous action must refer to a non-COM port.%0

E_BTW_CON
NECTION_P
ORT_HAS_T
ECH_BINDIN
G

The port "%1" used in a connection cannot have technology binding.%0

E_BTW_CON
NECTION_P

ORT_REUSE

D

The port "%1" used in a connection has been used before in the XLANG schedule.%0

E_BTW_TRA
NSACTIONS
_NESTED

When transactions are nested, the outer transaction must be long-running.%0

E_BTW_TRA

NSACTIONS
_NESTED_RE
TRY

When transactions are nested, the outer transaction cannot have retry count.%0

E_BTW_MES
SAGE_HAS_
NO_DECL

Message "%1" has no associated declaration.%0

E_BTW_MES
SAGE_HAS_
UNSATISFIE
D_DATA_DE
PENDENCIE
S

Message "%1" has unsatisfied data dependencies on "%2". The dependencies are either not getting created in the
flow or are potentially expected on a port in which the "No instantiation" option has been selected.%0

E_BTW_POR
T_HAS_NO_
BINDING

Port "%1" has no associated binding.%0

E_BTW_POR
T_HAS_UNS
ATISFIED_D

ATA_DEPEN
DENCIES

Port "%1" has unsatisfied data dependencies on messages “%2". The dependencies are either not being created in
the flow or are potentially expected on a port in which the "No instantiation" option has been selected.%0

E_BTW_RUL
E_HAS_NO_
BINDING
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Rule "%1" has no associated binding.%0




E_BTW_SCH
EDULE_SUS
PENDED

The XLANG schedule has been suspended.%0

E_BTW_SCH
EDULE_STO
PPED

The XLANG schedule has been stopped.%0

E_BTW_PER
SIST_FAILED

The state of the XLANG schedule instance could not be saved to the database.%0

E_BTW_SUS
PEND_FAILE
D

The XLANG schedule could not be suspended.%0

E_XLANG_S
HUTTINGDO
WN

The XLANG Application is shutting down.%0

E_BTW_MIS
SING_MESS
AGE_BINDIN
G_ON_PORT

The action uses port "%1" whose binding does not define the binding for message "%2".%0

E_BTW_MIS
SING_INCO
MING_PORT
REF

The message used by this receive action contains a field (%1) that is connected to a port reference (%2) but the da
taflow connections do not indicate that the port reference should be received.%0

E_BTW_SOU
RCE_PORT_
HAS_NOINV
OCATION

The send action refers to port "%1", in which the "No instantiation" option has been selected.%0

E_BTW_MIS
SING_OUTG
OING_PORT
REF

The message used by this source action contains a field (%1) that is connected to a port reference (%2) but the dat
aflow connections do not indicate that the port reference should be sent.%0

E_BTW_TAS
K_LIMIT
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The task has "%1!d!" actions. The current limit is "%2!d!".%0




E_BTW_SYN
C_DIFFEREN
T_PORTS

Synchronous action pair refers to different ports: "%1" and "%2".%0

E_.BTW_SYN
C_SAME_ME
SSAGE

Synchronous action pair refers to the same message: "%1".%0

E_BTW_SYN

C_ONLY_CO
M_ALLOWE

D

Synchronous action pair must refer to COM port only.%0

E_.BTW_SYN
C_SECOND_
MESSAGE_

MUST_BE_O
UT_FOR_FIR
ST_MESSAG
E
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In a synchronous action pair the message in the second action must be the out message for the message in the fir
st action.%0

E_BTW_INV
ALID_DELAY
_TIME

The delay time (%1!d!) is not valid. The delay time cannot be a negative number.%0

E_BTW_CAL
L_MESSAGE
_SCHEMA_N
AME_MISM
ATCH

The message specification name "%1" for the message "%2" in the calling XLANG schedule does not match the sp
ecification name "%3" in the called XLANG schedule.%0

E_BTW_CAL
L_MESSAGE
_SCHEMA_R
EPRESENTA
TION_MISM
ATCH

The message specification representation for message "%1" in the calling XLANG schedule does not match the sp
ecification representation in the called XLANG schedule.%0

E_BTW_ASSI
GNMENT_P
ORT_HAS_T
ECH_BINDIN
G

Port "%1" used in an assignment in a cut form cannot have technology binding.%0

E_BTW_PAR
TITION_LIMI
T
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The partition has "%1!d!" process(es). The current limit is "%2!d!".%0




E_BTW_MES
SAGE_USED
_IN_PARALL
EL

Parallel actions or processes use the same message "%1".%0

E_BTW_POR
T_USED_IN_
PARALLEL

Parallel actions or processes use the same port "%1".%0

E_BTW_INV
ALID_RETRY
_COUNT

The retry count "%1!d!" is not valid. The retry count cannot be negative.%0

E_BTW_INV
ALID_BACK
OFF_VALUE

The back-off value "%1!d!" is not valid. The back-off value cannot be negative.%0

E_BTW_INV
ALID_TIMEO
UT_VALUE

The timeout value "%1!d!" is not valid. The timeout value cannot be negative.%0

E_BTW_FIEL
D_RESERVE
D_NAME

%1 is a reserved field name.%0

E_BTW_ELE
MENT_TYPE
_NOT_DEFIN
ED

The element type "%1" is not defined.%0

E_BTW_ELE
MENT_TYPE
_INCOMPLE
TE

The element type definition is incomplete. Provide either subelements or dt:type.%0

E_BTW_MUL
TIPLE_PORT
S

Distinct ports "%1" and "%2" are used on the same field.%0

E_XLANG_IN
VALID_COM
PARE_TYPE

Comparison of this data type is not permitted.%0




E_BTW_FIEL
D_NOT_MAT
CHING_SCH
EMA_ELEME
NT

FieldBinding for "%1" does not have a matching element in the schema at position "%2!d!".%0

E_BTW_FIEL
D_HAS_AMB
IGUOUS_DA
TAFLOW

A message field cannot have both a data flow from another message field and a reference to a port. One of the da
ta flows must be removed.%0

E_BTW_POR
T_TARGET_I
NVALID

The type of this field is inappropriate for use as a port reference. Ports bound to a COM component can be comm
unicated as object references or strings. Ports bound to Message Queuing may only be transferred as strings. Inte
rnal ports can be communicated only as object references.%0

E_BTW_FIEL
D_TARGET_I
NVALID

The target field "%1", which is of variant type "%2", cannot get data from source field “%3", which is of variant typ
e "%4" %0

E_BTW_INITI
ALIZED_MES
SAGEFIELD_I
NVALID_OV
ERWRITE

The data in field "%1" of an initialized message "%2" cannot be overwritten with data from other message or port
in the binding specification.%0

E_BTW_DAT
AFLOW_INC
OMPLETE

A source action accepting [in] parameters must have the corresponding fields populated by data flow (that is, “fro
m").%0

E_BTW_DAT
AFLOW_FR
OM_SYSTE
M_FIELD

Port cannot be initialized from a system field.%0

E_BTW_DAT
AFLOW_FR
OM_CONST
ANT_FIELD

Port cannot be initialized from a constant message field.%0

E_BTW_MIS
SING_SCRIP
T_EXPRESSI
ON

No script expression was supplied for the rule.%0

E_BTW_BAD
_SCRIPT_EX
PRESSION
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%1 %2 at character position %3!d! in "%4"%0




E_BTW_MAP
_INVALID_BI
NDING

The binding for message "%1" must contain a reference for mapped port "%2".%0

E_BTW_MES
SAGE_BINDI
NG_SCHEM

A_MISMATC
H

There is a mismatch between the binding and schema for the message "%1".%0

E_BTW_MES
SAGEDECL_|
NIT_DATA_U
NAVAILABLE

Unable to obtain initialization data for field "%1".%0

E_BTW_LATE
NCY_INVALI
D_VALUE

The Latency property value must be a non-negative integer that is less than the maximum long integer "%1!d!".%
0

E_BTW_POR
T_LATENCY_
ON_INTERN
AL

Cannot specify latency on an internal port.%0

E_BTW_MES
SAGE_TECH
NOLOGY_MI
SMATCH

There is a mismatch between the port "%1" technology "%2" and the message "%3" technology "%4".%0

E_BTW_FIEL
D_TECHNOL
OGY_MISM
ATCH

There is a mismatch between the message "%1" technology "%2" and the field "%3" technology "%4".%0

E_BTW_CO
M_PORT_N
OT_CREATA
BLE

If a COM port can be invoked, it must have a CLSID, a ProgID, or a moniker.%0

E_BTW_AUT
ORETURN_C
OM_PORT_
MUST_BE_U
SED_INSIDE
_CONTEXT

The port "%1", which is configured to abort a transaction if a method returns a failure HRESULT, can only be used
inside a transaction.%0

E_BTW_CO

M_PORT_GE
NERAL_ACC
ESS_FAILUR
E
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A COM port can be invoked. Please refer to the Windows 2000 documentation.%1%0




E_BTW_CO
M_PARAME
TERS_LIMIT

The method has "%1!d!" parameter(s). The current limit is "%2!d!".%0

E_BTW_CO
M_NO_MAT
CHING_RET
URN

The COM method has no matching Return.%0

E_BTW_CO
M_NO_MAT
CHING_MET
HOD

The COM Return has no matching method.%0

E_BTW_INV
ALID_SLOT_
NUMBER

The slot number "%1!d!" is not valid. Slot numbers cannot be less than the following value: SLOT_NONE(-1).%0

E_BTW_INV
ALID_INVOK
E_KIND

The invokeKind value "%1!d!" is not valid. Acceptable values are: 1,2,3,4 and 8.%0

E_BTW_PRO
XY_DISCON
NECTED

The proxy has been disconnected.%0

E_BTW_CO
M_DISPATC
H_SLOT_SPE
CIFIED

A slot number cannot be specified for the dispatch interface.%0

E_BTW_CO
M_SPECIFY_
DISPID_OR_
SLOT

Valid values for dispid or slot must be specified.%0

E_BTW_CO
M_INVALID_
BYREF_FOR_
RETURN_ME
SSAGES

Byref should be "1" since "%1" is a <com:return> message.%0

E_BTW_CO
M_INVALID_
NESTED_VA
RIANTS
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More than one level of nesting for variants is not permitted.%0




E_BTW_CO
M_FIELD_IN
DEX_MUST_
BE_NON_NE
GATIVE

The index "%1!d!" for the field is not valid. The index must be a non-negative integer.%0

E_BTW_CO
M_FIELD_IN
DEX_REPEAT
ED

The index "%1!d!" for the field has been used before on another field in the message.%0

E_BTW_CO

M_FIELD_IN
DEX_NOT_C
ONTIGUOU
S

For synchronous action pair messages "%1" and "%2", the index "%3!d!" for a field is not valid. The field indices fo
r these messages must form a contiguous block of non-negative numbers that start with zero.%0

E_BTW_MS
MQ_NO_M
QRT_DLL

The Message Queue DLL, MQRT.DLL, cannot be loaded.%0

E_BTW_MS
MQ_CREATE
CHANNEL

MQBinder: CreateChannel failed for: %1.%0

E_BTW_MS

MQ_NOT_C
ONFIGERED
_PROPERLY

The Message Queuing Service is not configured properly. A queue object could not be opened %1.%0

E_BTW_MS
MQ_NO_CE
RTIFICATE_A
VAILABLE

The Message Queuing Service is not able to obtain a certificate.%1%0

E_BTW_MS
MQ_NO_WE
LLKNOWN_
QUEUE_NA
ME

A message cannot be sent to a known queue because the queue is not named in the XLANG schedule. You must p
rovide a queue name in the XLANG schedule.%1%0

E_BTW_MS
MQ_INVALI
D_FIELD_TY
PE

The field type specified for message "%1" field "%2" is not valid.%0

E_BTW_MS
MQ_PORT_
NOT_BOUN
D

The Message Queuing port is not bound.%1%0




E_BTW_MS

MQ_QUEUE
_NOT_TRAN
SACTIONAL

The queue does not have the correct transactional properties.%1%0

E_BTW_MS
MQ_OPEN_
ACCESSDEN
IED

A Message Queuing access denied error occurred when opening the queue. Compare the accessRole specified for
the queue in the XLANG schedule with the rights associated to the current user.%1%0

E_BTW_MS
MQ_OPEN_
GENERALFAI
LURE

A Message Queuing failure occurred when opening the queue. Refer to the Message Queuing Service documentat
ion in Windows 2000 to look up the error code and diagnose as appropriate.%1%0

E_BTW_MS
MQ_PORT_
NOT_CREAT
ABLE

A port that is implemented by using a message queue must have a queue name.%0

E_BTW_MS
MQ_GENER
AL_QUEUE_
ACCESS_FAI
LURE

A Message Queuing failure occurred when accessing the queue. Refer to the Message Queuing Service document
ation in Windows 2000 to look up the error code and diagnose as appropriate.%1%0

E_BTW_MS
MQ_INVALI
D_MESSAGE
_VT_TYPE

The Message Queuing message is of unknown format.%1%0

E_BTW_MS
MQ_MESSA
GE_UNKNO
WN_MESSA
GETYPE

The Message Queuing message is of unknown message type. The message type could not be obtained from the
message.%1%0

E_BTW_MS
MQ_MESSA
GE_UNAUTH
ENTICATED

The Message Queuing message is not authenticated but the port only accepts authenticated messages.%1%0

E_BTW_MS
MQ_MESSA
GE_INCORR
ECT_AUTHE
NTICATE_LE
VEL

The Message Queuing message is not authenticated at the requested level.%1%0

E_BTW_MS
MQ_MESSA
GE_INVALID
_MESSAGE
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The Message Queuing message has a message body that is not valid.%1%0




E_BTW_MS
MQ_MESSA
GE_NOT_SE
ND

The Message Queuing message could not be sent.%1%0

E_BTW_MS
MQ_MESSA
GE_SCHEMA
VALIDATION
_FAILED

The Message Queuing message was not successfully validated against the schema that was provided. Check the s
chema and the schema path.%1%0

E_BTW_MS
MQ_COULD
_NOT_CREA
TE_MQMESS
AGE

The message instance could not be converted to a Message Queuing message %1%0

E_BTW_MS
MQ_NO_TR
USTRELATIO
NSHIP_FOR_
USER

The trust relationship for the provided user could not be established.%1%0

E_BTW_MS
MQ_MESSA
GE_EMPY_M
ESSAGE

The Message Queuing message has an empty message body.%1%0

E_BTW_MS
MQ_MESSA
GE_ONLY_O
NE_EMPTY_
XPATH_ALL
OWED

The Message Queuing message can have only one field with an empty node path (XPath).%0

E_BTW_MS
MQ_MESSA
GE_ONE_EM
PTY_XPATH_
NEEDED

The Message Queuing message must have one field with an empty node path (XPath).%0

E_BTW_MS
MQ_MESSA
GE_INVALID
_MESSAGEB
oDy

The Message Queuing message has a message body that is not valid.%1%0

E_BTW_MS
MQ_MESSA
GE_INVALID
_MESSAGES
TRING

The Message Queuing message has an invalid string for the message body.%1%0

E_BTW_MS
MQ_MESSA
GE_UNKNO
WN_MESSA
GE

The Message Queuing message is an invalid or unknown message and was moved to the dead-letter queue.%1%
0




E_BTW_MS
MQ_MESSA
GE_TYPE_CO
NFLICTING_
SCHEMA

The Message Queuing messages "%1" and "%2", which are of type "%3" on port "%4", have conflicting specificatio
n representations. This could be because the name, type, or XPath query does not match for one of the fields in th
e two representations.%0

E_BTW_MS
MQ_DOCU
MENT_FIELD
_TYPE_NOT_
STRING

A Message Queuing message's field "%1", that has an empty node path (XPath), must be a string data type.%0

E_BTW_MS
MQ_DOCU
MENT_FIELD
_CANNOT_C
ONVERT_TO
_STRING

A Message Queuing message's field could not be converted to a string.%1%0

E_BTW_MS
MQ_DOCU
MENT_FIELD
_CONVERTI
ON_FAILUR
E

The Message Queuing message's field could not be converted.%1%0

E_BTW_CAN
T_DISPOSE_
MESSAGE

The XLANG schedule instance was bound to a queue that received a message that is not valid. The XLANG Schedu
ler Engine was unable to transfer this message to the dead-letter queue, so the schedule instance has been termin
ated.%0

Related Topic

Configure Event Viewer for BizTalk Server errors




Concepts

This section provides detailed conceptual information that is essential to understanding BizTalk Server Administration. It covers
administrative tasks such as creating server groups, defining receive functions, and creating databases to manage, view, and log
document activity in Microsoft BizTalk Server 2000.

The following concepts are covered in this section:

e WMI Overview

e BizTalk Server Administration Environment
e Administration Cache

e Managing BizTalk Server Databases

e Groups and Servers

e Handling Server Errors

® Receive Functions

e Using Queues

e Administration Privileges



WMI Overview

Windows Management Instrumentation (WMI) is a data-management layer that is included in Microsoft Windows 2000.
Microsoft BizTalk Server 2000 uses the WMI layer to encapsulate administrative functions. When you use BizTalk Server
Administration to change group, server, and queue settings, the new values are stored in the BizTalk Messaging Management
database through the BizTalk Server WMI provider. In BizTalk Server 2000, this WMI provider uses a Microsoft SQL Server
database to store administrative objects. WMI supports a uniform scripting application programming interface (API) that gives
applications and scripts access to the WMI provider on a local computer or a remote computer.

[# Notes

e WMI has a restriction on syntax and valid characters for a WMI object path. The following is a list of invalid characters. " ! @
#$%M&*()+=11{}\\""<>,.?

Do not use any of these characters when you create a server group name.

e All timestamps are created by using the local time on Microsoft SQL Server. However, the WMI provider refers to all
timestamps in coordinated universal time (UTC). The administration console then converts the timestamps back to local
time for display.

e To access the WMI database layer programmatically, you can use the InterchangeProvSchema.mof file found in the
\Program Files\Microsoft BizTalk Server\Setup folder. This file contains the WMI classes corresponding to the
Administration objects. For more information about WMI Application Programming, go to the MSDN Online Library Web
site (msdn.microsoft.com/library/default.asp), and search for "WMI Application Programming".


http://msdn.microsoft.com/library/default.asp

BizTalk Server Administration Environment

The following topics are covered in this section:

e BizTalk Server Administration User Interface

e BizTalk Server Administration Shortcut Keys



BizTalk Server Administration User Interface

BizTalk Server Administration—also called the administration console—is a Microsoft Management Console (MMC) snap-in that
provides a visual representation of the BizTalk Server components that a system administrator can manage. The left side of the
administration console is called the console tree and consists of folders and subfolders that represent different items, such as
server groups. The right side of the administration console is called the details pane and contains information about the item that
is selected in the console tree.

Graphically, Microsoft BizTalk Server 2000 is displayed as a subitem of the Console Root on the left side of the administration
console. Each server group configured in BizTalk Server is displayed in a separate subfolder and consists of the queues and
receive functions for that group, as well as the names of servers in the group. Expand any item in the console tree to display
additional details about the item in the details pane of the administration console. You can right-click any item to configure it, or
to create new items.

Related Topic

Open BizTalk Server Administration



BizTalk Server Administration Shortcut Keys

You can use shortcut keys to accomplish tasks in BizTalk Server Administration. The following table is a quick reference to the
Microsoft Management Console shortcut keys.

¥ Note

e Functionality that is not included in this list can be obtained by using the numeric keypad to move the mouse pointer with
MouseKeys. For more information about MouseKeys in Windows 2000 Server and Advanced Server Help, see "Using the
keyboard to move the mouse pointer". For more information about MouseKeys in Windows 2000 Professional Help, see
"Move the mouse pointer by using MouseKeys".

Press To
F5 Refresh BizTalk Server Administration.

This shortcut key refreshes the current item highlighted in the console tree.

ALT+F4 Close BizTalk Server Administration.

ALT+MINUS SIGN|Display the window menu for the active console window.
SHIFT+F10 Display the Action menu for the selected item.

ALT+A Display the Action menu for the selected item.

ALT+V Display the View menu.

F1 View online Help for the selected item.

ALT+ENTER Display the properties dialog box, if any, for the selected item.
Related Topic

Open BizTalk Server Administration



Administration Cache

When you start BizTalk Server, all items, such as server groups, server group properties, receive functions, connections to the
Shared Queue and Tracking databases, and so on, in BizTalk Server Administration are stored in the administration cache. All
items in the cache are refreshed every 50 seconds except for the server database connections and server properties. This means
that if you change the general properties for a server group, such as the SMTP host or the reliable messaging reply-to URL, the
changes are picked up within 50 seconds. However if you change any server properties, such as the Maximum number of
worker threads per processor allowed, you must stop and restart the server on which you changed the configuration so the
change to be stored in the cache. Or, if you change a connection to the BizTalk Messaging Management, Tracking, or Shared
Queue databases, you must stop and restart the servers in the group and shut down the BizTalk Server Interchange Application.

Related Topics

Configure general properties for a server group
Shut down the BizTalk Server Interchange Application
Start a server in a group

Stop a server in a group



Managing BizTalk Server Databases

The three databases associated with BizTalk Messaging Services are:

e BizTalk Messaging Management database
e Tracking database

o Shared Queue database

The BizTalk Messaging Management database stores information for all server configurations, including group and server
settings, and receive functions. The configuration of these administration objects is handled through BizTalk Server
Administration or programmatically. The BizTalk Messaging Management database also stores all messaging configuration
information for channels, messaging ports, and other messaging objects. Although messaging configuration information is stored
in this database, the configuration of the objects is handled either by using BizTalk Messaging Manager or programmatically by
using the BizTalk Messaging Configuration object model. For more information about configuring channels, messaging ports, and
so on, see Using BizTalk Messaging Manager or Object Model Reference.

The Tracking database keeps a log of all interchanges, documents, and receipts that are processed by BizTalk Server. For more
information about the Tracking database, see Tracking Database. To configure tracking settings,

see Configure tracking properties for a server group. To track specific fields or document-instance data,

see Set Channel Properties.

The Shared Queue database holds documents while they are being processed or waiting to be processed. Documents are later
removed after they have been processed. For more information about the Shared Queue database, see Shared Queue Database.

The following topics are covered in this section:

e Managing the BizTalk Messaging Management Database

® Managing BizTalk Server Group Databases



Managing the BizTalk Messaging Management Database

For most business implementations, there is one central BizTalk Messaging Management database that is used to configure
multiple server groups, servers, channels, messaging ports, and so on. One exception to this guideline is businesses that are third-
party vendors. Third-party vendors might need a separate BizTalk Messaging Management database for every customer based on
each customer's particular business needs. However, in all other cases, it is strongly recommended that you use a central BizTalk
Messaging Management database for all your BizTalk server groups.

From time to time, it might be necessary to remove servers from the central BizTalk Messaging Management database. For
example, the server on which your BizTalk Messaging Management database resides might need maintenance. In this case, you
must point all server groups to a replicated BizTalk Messaging Management database to keep your BizTalk Server enterprise
running. It also might be necessary to move servers between one or more BizTalk Messaging Management databases. For
example, if you are a third-party vendor with three customers, A, B, and C. The business from Customer A decreased while the
business from Customers B and C increased. You can move the servers that were associated with Customer A's BizTalk Messaging
Management database to the databases associated with Customers B and C.

The following topics are covered in this section:

e Changing the BizTalk Messaging Management database
® Removing servers from the BizTalk Messaging Management database
® Moving servers between BizTalk Messaging Management databases

e Moving remote servers between BizTalk Messaging Management databases



Changing the BizTalk Messaging Management database

There are two ways to configure the BizTalk Messaging Management database:

e Use the configuration options available during installation.

e Use BizTalk Server Administration to change the server in the Microsoft BizTalk Server 2000 node.

If you want to centrally manage all your BizTalk servers from a single server, during installation configure all servers to point to a
central BizTalk Messaging Management database. If you do this, anytime you open BizTalk Server Administration on any one of
those BizTalk servers, the servers listed in the Microsoft BizTalk Server 2000 node point to the same BizTalk Messaging
Management database and can be centrally managed. Once a collection of server groups point to a central BizTalk Messaging
Management database, you typically do not need to change to a different BizTalk Messaging Management database. An exception
to this is when you need to bring that database offline for maintenance. In this situation, use BizTalk Server Administration to
point all server groups in the Microsoft BizTalk Server 2000 node to a replication of the original central database. Do not
temporarily point server groups to a different central BizTalk Messaging Management database that has other server groups
associated with it. If you do, it might be difficult to return to your original BizTalk Messaging Management database configuration.

Related Topics

BizTalk Server Groups
Change the BizTalk Messaging Management database for a server
Configure the BizTalk Messaging Management database

Moving Servers between BizTalk Messaging Management databases



Removing servers from the BizTalk Messaging Management
database

If you remove all BizTalk servers from your central BizTalk Messaging Management database, the contents of the database remain
intact. Likewise, if you have more than one central BizTalk Messaging Management database in your system and you remove all
BizTalk Servers from a central BizTalk Messaging Management database, the contents of the database remain intact. You can add
new BizTalk Servers to the central BizTalk Messaging Management database by running the BizTalk Server 2000 Database Setup
Wizard and selecting an existing database on the Configure a BizTalk Messaging Management database page. For more
information about adding or changing the BizTalk Messaging Management database for a server,

see Change the BizTalk Messaging Management database for a server.

Related Topic

Change the BizTalk Messaging Management database for a server



Moving servers between BizTalk Messaging Management
databases

If you are planning to temporarily move a BizTalk Server from one central BizTalk Messaging Management database to another,
at least one other BizTalk Server must remain in place in one of the server groups within the original central database. This
enables you to easily restore the BizTalk Server to the original central database. Otherwise, to add a new BizTalk Server to the
central database, you must run the BizTalk Server Database Setup Wizard and select an existing database on the Configure a
BizTalk Messaging Management database page. For more information about adding or changing the BizTalk Messaging
Management database for a server, see Change the BizTalk Messaging Management database for a server.

Related Topics

Change the BizTalk Messaging Management database for a server

Groups and Servers



Moving remote servers between BizTalk Messaging
Management databases

If you try to add a remote server to a BizTalk Messaging Management database, and that server was originally in a different
central BizTalk Messaging Management database, the following error message appears in the Windows Event Log:

A new instance of the WMI class "MicrosoftBizTalkServer_Server" cannot be created in the BizTalk Server WMI provider. The
<servername> server may already belong to a different BizTalk Server installation.

This error means that an attempt was made to add a remote server that was originally in a different central database. If this
procedure was performed within BizTalk Server Administration, the administration console tries to determine if the remote server
also belongs to a group in the remote central database. The administration console queries the remote server's Windows
Management Instrumentation (WMI) provider to make this determination. If the server does belong to a server group in the other
central database, an error message from the administration console appears and explains that you cannot add a remote server
that already belongs to a group in a different central database.

Related Topics

Error when moving a remote server to a different BizTalk Messaging Management Database

WMI Overview



Managing BizTalk Server Group Databases

Each server group uses two databases, the Shared Queue database and the Tracking database. The Shared Queue database holds
all documents and interchanges that are submitted to BizTalk Server 2000 for processing and transmission. The Tracking
database tracks and stores incoming and outgoing interchanges for auditing, reconciliation, and dispute-resolution purposes.

To help you organize the logical configuration of your servers and groups, it is important to create unique names for the Shared
Queue and Tracking databases that are associated with each server group. For example, if you have two server groups, one called
Group1 and one called Group?, label the databases for the first group SharedQueuel and Tracking1, and label the databases for
the second group SharedQueue?2 and Tracking?2.

¥ Note

o The BizTalk Messaging Management database is a different database than the Shared Queue and Tracking databases. This
database is used to store information about the configuration of multiple groups and servers, as well as to store information
about the configuration of BizTalk Messaging Services. It does not handle document and interchange transmissions or track

document and interchange activities.
The following topics are covered in this section:

e Shared Queue Database

e Tracking Database



Shared Queue Database

e All servers in a server group share a single Shared Queue database. All documents and interchanges that are submitted to
the servers in a group are stored in the Shared Queue database until they are processed by BizTalk Server.

e The Shared Queue database is graphically represented in BizTalk Server Administration as a series of queues that provide
information about the progress of an interchange or document in BizTalk Server. Interchanges and documents are in one of
the following queues while they are processed by BizTalk Server.

e Work queue. A list of interchanges and documents that are currently being processed by BizTalk Server.

e Scheduled queue. A list of interchanges and documents that have been processed by BizTalk Server and are
waiting for transmission according to the service window. For more information about the service window,
see ServiceWindowInfo property.

e Retry queue. A list of interchanges and documents that are being resubmitted, as well as reliable messages that are
awaiting receipts.

e Suspended queue. A list of interchanges and documents that failed processing for a variety of reasons, including
parsing errors, serialization errors, or transmission errors, or that lack a correct channel configuration.

Related Topics

Configure connection properties for a server group
Groups and Servers

ServiceWindowInfo

Manage Queues

Using Queues



Tracking Database

All servers in a server group share a single Tracking database that stores all information related to interchange and document
activity in BizTalk Server. The Tracking database is used to track the status of an interchange or document as it moves through the
server. For example, if you want to verify whether an order was sent to a trading partner, you can query the Tracking database.
This database can also be used to verify that interchanges and documents are successfully sent or received by BizTalk Server, or it
can provide information for reports such as transmission times or receipt responses.

Defining document tracking and logging parameters for the Tracking database

In BizTalk Server Administration, you can select whether interchanges and documents are tracked. For more information about
how to configure tracking settings for a server group, see Configure tracking properties for a server group. If you enable tracking,
the following options are available:

e Log incoming interchange. With this setting, you can specify that documents received by a BizTalk server are stored in
the Tracking database. Incoming documents stored provide an activity record for dispute resolution. This is selected by
default.

e Log outgoing interchange. With this setting, you can specify that documents sent by BizTalk Server are stored in the
Tracking database. This is selected by default.

e Log the original MIME-encoded message. With this setting, you can specify that MIME-encoded documents are stored
in the Tracking database in their original message format before they are decoded. This is not selected by default.

Related Topics

Configure connection properties for a server group
Configure tracking properties for a server group
Start a server in a group

Stop a server in a group

Using BizTalk Document Tracking



Groups and Servers

In a data-exchange environment that supports the processing of a large number of documents, multiple servers and databases
might be required. Businesses must have a way to centralize and manage document exchange.

Microsoft BizTalk Server 2000 centralizes document exchange by assembling servers into groups and managing and configuring
these server groups by using BizTalk Server Administration.

The following topics are covered in this section:

e BizTalk Server Groups
e Relationship between Groups and Servers
e Group Status States

e BizTalk Servers



BizTalk Server Groups

A server group is the key organizing principle in BizTalk Server Administration. Server groups are collections of individual servers
that are centrally managed, configured, and monitored.

Servers in a BizTalk server group have in common:

e A Shared Queue database that persists all documents until they are successfully processed.
e A Tracking database that is used to log document and interchange activity and to run reports.

e Receive functions.

e All components that the server requires when processing documents and interchanges, such as transport components,
application integration components (AlCs), and so on.

A central BizTalk Messaging Management database manages multiple groups and servers. Thus, they share the same
configuration information. This configuration information specifies the document-processing logic for the servers. Specify the
same BizTalk Messaging Management database for each server installation so that you can remotely administer each server and
group from the administration console. Also, if you are setting up multiple server groups for scalability and improved
performance, use only one central BizTalk Messaging Management database. Otherwise, these servers cannot share the same
BizTalk Messaging Management conf